For Windows, Mac OS X, Mac OS, and Red Hat Linux F i I e IVI ake r®

Server 55

Administrator’s Guide

™

©1994-1995, 1997, 1999, 2001 FileMaker, Inc. All Rights Reserved.

FileMaker, Inc.

5201 Patrick Henry Drive

Santa Clara, California 95054

www.filemaker.com

FileMaker is atrademark of FileMaker, Inc., registered in the U.S. and other countries, and the file folder logo is a trademark of
FileMaker, Inc. All other trademarks are the property of their respective owners.

Red Hat is aregistered trademark of Red Hat, Inc. in the U.S. and other countries.

All persons and companies listed in the examples are purely fictitious and any resemblance to existing persons and companiesis
purely coincidental.

Mention of third party companiesand productsisfor informational purposes only and does not constitute an endorsement. FileMaker

assumes no responsibility with regard to the selection, performance, or use of these products. All understandings, agreements or
warranties, if any, take place directly between the vendor and prospective users.



This page intentionally left blank.



Contents

Preface
Using the FileMaker Server documentation
About this guide
Using FileMaker Server Help (Windows and Mac OS)
Starting FileMaker Server Help
About the Help topic window
Finding atopic using the Help Contents

Finding atopic using the Help Index (Windows and
Mac 0S8.6t09.1)

Finding atopic using specific words (Windows and
Mac 0S8.6t09.1)

Finding a topic using specific words (Mac OS X)
Finding information about specific itemsin FileMaker Server
Getting help for FileMaker Server in Red Hat Linux
Getting help while administering FileMaker Server remotely

Chapter 1

Welcome to FileMaker Server 5.5
Registration and customer support

Introducing FileMaker Server

How does FileMaker Server work?

What'sin the FileMaker Server package

What's new or improved in FileMaker Server 5.5
Before you begin

Chapter 2
Installing FileMaker Server in Windows
What you need
Windows system requirements
Networking requirements
Installing FileMaker Server

vii
viii
viii
viii
viii

Xi
Xi
Xii
Xii

11
1-2
1-3
1-3
1-3

2-1
2-1
2-1
2-2

Where files are stored on your hard disk
Uninstalling FileMaker Server (Windows)

Chapter 3
Installing FileMaker Server in Mac OS 8.6 t0 9.1
What you need
Mac OS 8.6 to 9.1 system requirements
Networking requirements
Installing FileMaker Server
Where files are stored on your hard disk

Chapter 4
Installing FileMaker Server in Mac OS X
What you need
Mac OS X system requirements
Networking requirements
Installing FileMaker Server
Where files are stored on your hard disk

Chapter 5
Installing FileMaker Server in Red Hat Linux
What you need
Red Hat Linux system requirements
Networking requirements
Installing and registering FileMaker Server
Wherefiles are stored on your hard disk
Uninstalling FileMaker Server

Chapter 6
Configuring FileMaker Server (Windows and Mac OS)

Using the configuration assistants (Windows)

2-3
2-5

31
31
31

3-2

4-1
41
41

4-2

5-1

5-1
5-1
5-2
5-3



iv  FileMaker Server Administrator’s Guide

Opening the Properties dialog box (Windows)
Opening the Preferences dialog box (Mac OS 8.6 t0 9.1)
Opening the Preferences dialog (Mac OS X)
Setting the number of guests
Allowing disconnection of idle guests

Setting atime to disconnect idle guests

Setting the pre-disconnect message
Authenticating guest log on (Windows)
Setting the maximum number of files
Changing the amount of memory used by FileMaker Server
Adjusting memory (Mac OS 8.6 t0 9.1)

Changing the amount of memory used

FileMaker Server, virtual memory, and physical
memory requirements

Setting how often the cache is flushed
Allowing single user files to be hosted
Allowing software updates to be downloaded automatically

Opening runtime solutions automatically (Windows and
Mac OS X)

About FileMaker Devel oper

Opening runtime solutions automatically (Mac OS 8.6 t0 9.1)
About FileMaker Devel oper

Enabling remote administration

Specifying a custom host name

Maximizing performance (Mac OS 8.6 t0 9.1)

Choosing network protocols

Setting the preferred | P address

Recording usage statistics and setting size limits

Setting asize limit for the Application Log (Windows NT)

Setting a size limit for the Application Log (Windows 2000)

Setting asize limit for the event log (Mac OS)

Using FileMaker Server with a directory service
Registering FileMaker Server with adirectory service
Specifying the authentication method (Windows)

6-4

6-7
6-7
6-7
6-7

6-8

6-9

6-9

6-9
6-10
6-11
6-11
6-12
6-12
6-14
6-14
6-15
6-15
6-15
6-16

Specifying the authentication method (Mac OS)

Publishing your contact information to your
directory service

Changing the port number
Restoring FileMaker Server default settings
Protecting files with a password

How FileMaker Server behaves during system sleep
(Windows 2000 and Mac OS)

Chapter 7

6-16

6-16
6-17
6-17
6-17

6-17

Administering FileMaker Server (Windows and Mac OS)

Starting FileMaker Server (Windows NT)
Starting FileMaker Server (Windows 2000)
Stopping FileMaker Server (WindowsNT)
Stopping FileMaker Server (Windows 2000)
Starting FileMaker Server (Mac OS 8.6 t0 9.1)
Making an alias
Quitting FileMaker Server (Mac OS8.6t09.1)
Starting FileMaker Server (Mac OS X)
Making an alias for FileMaker Server Config
Starting the FileMaker Server application (Mac OS X)
Quitting FileMaker Server (Mac OS X)
Quitting the FileMaker Server Config application
Stopping the FileMaker Server application (Mac OS X)
Using remote administration

Automatically downloading the Server Administration
plug-in to aremote computer

Opening the Remote Administration window
Listing hosted files and current guests
Viewing usage statistics for FileMaker Server
Hosting FileMaker Pro 5.x files

Closing hosted files

Disconnecting guests

7-1
7-1
7-2
7-2
7-3
7-3
7-3
7-3
7-4
7-4
7-4
7-4
7-4
7-4

7-6
7-6
77
77
7-8

7-10



Viewing detailed information about hosted files
and guests

Sending messages to guests
Sending messagesto all guests

Determining if you have exclusive access to hosted
databases

Using local administration
(Mac 0S8.6t09.1)

Opening the local administration window
(Mac 0S8.6t09.1)

Listing hosted files and guests (Mac OS 8.6 t0 9.1)
Viewing usage statistics (Mac OS 8.6 t0 9.1)
Hosting FileMaker Pro 5.x files (Mac OS 8.6 t0 9.1)
Closing hosted files (Mac OS 8.6 t0 9.1)
Disconnecting guests (Mac OS 8.6 t0 9.1)
Sending messages to guests (Mac OS 8.6 t0 9.1)
Monitoring server performance (Windows)
Monitoring performance (Windows NT)
Monitoring performance (Windows 2000)
Using reported events to track activities
Viewing activitiesin the Event Viewer (Windows NT)

Viewing activitiesin the Event Viewer
(Windows 2000)

Keeping event data current (Windows)
Viewing activitiesin the event log (Mac OS)
Recal culating the Today function in hosted databases

Chapter 8

7-11
7-11
7-12

7-12

7-12

7-12
7-13
7-14
7-14
7-15
7-16
7-16
7-17
7-17
7-18
7-18
7-19

7-19
7-20
7-20
7-20

Scheduling administrative tasks (Windows and Mac OS)

Scheduling tasks to run automatically (Windows)

Scheduling tasks to run automatically (Mac OS 8.6 t0 9.1)
Scheduling database backups (Mac OS 8.6 t0 9.1)
Running a script (Mac OS 8.6 t0 9.1)

Sending messages to guests of hosted databases
(Mac 0S8.6t09.1)

8-1
8-1
8-2
8-2

8-3

Contents v

Scheduling tasks to run automatically (Mac OS X)
Scheduling database backups (Mac OS X)
Running a script (Mac OS X)

Sending messages to guests of hosted databases
(Mac OS X)

Viewing scheduled tasks in the Schedules list (Windows)

Administering scheduled tasks with the toolbar
(Windows)

Updating Last Run and Next Run information
(Windows)

Viewing scheduled tasks in the Schedules window (Mac OS)
Running scheduled tasks manually

Changing scheduled tasks

Duplicating scheduled tasks

Deleting scheduled tasks

Enabling and disabling scheduled tasks

Using the command line to automate tasks (Windows)

Example: Backing up hosted databases on the
command line (Windows)

Using a script to automate tasks (Mac OS)
Making sure you don’t run out of disk space during backups

Chapter 9
Using FileMaker Server in Red Hat Linux
Getting onscreen help with command and preference syntax
Administering FileMaker Server
Starting and stopping FileMaker Server automatically
Configuring FileMaker Server
Editing the configuration file
Applying configuration changes
Reloading the configuration file to apply runtime
preference changes

Restarting FileMaker Server to apply configuration
changes
Restoring preference defaults

8-3
8-3
8-4

8-4
8-4

8-4

8-5
8-5
8-6
8-6
8-7
8-7
8-7
8-8

8-9

8-10
8-10

9-5



vi FileMaker Server Administrator’s Guide

Setting the number of guests
Disconnecting idle guests
Setting the maximum number of files
Changing the amount of memory used by FileMaker Server
Setting how often the cacheis flushed
Allowing single user files to be hosted
Allowing software updates to be downloaded automatically
Enabling Auto Update in FileMaker Server
Storing plug-in files on the server computer
Specifying the location of hosted files

Specifying a user account name and group name for
FileMaker Server

Enabling remote administration in FileMaker Server

Using the fmspasswd utility to encrypt passwords

Specifying a custom host name

Specifying the preferred | P address

Opening runtime solutions automatically

Using reported events and statistics to track activities
Setting asize limit and the location of the event log
Creating a statisticslog

Using FileMaker Server with a directory service
Enabling directory service registration

Publishing your contact information to your
directory service

Chapter 10

Manually installing the Server Administration

plug-in on a remote computer

About the Server Administration plug-in

Manually installing the plug-in on aremote computer
(Windows NT and Windows 2000)

Manually installing the plug-in on a remote computer
(Windows 95 or Windows 98)

Enabling the Server Administration plug-in using
FileMaker Pro (Windows)

9-6
9-7
9-7
9-7

9-8
9-8

9-9

9-9
9-10
9-11
9-11
9-12
9-12
9-13
9-13
9-14
9-14
9-15

9-16

10-1

10-1

10-2

10-2

Manually installing the Server Administration plug-in on a
remote computer (Mac OS)

Enabling the Server Administration plug-in using
FileMaker Pro (Mac OS)

Appendix A

Technical specifications and optimization
Limitsfor files and usage

Hardware and network considerations

Software considerations

Appendix B
Performance and usage tips

Performance tips
Usagetips

Appendix C
Event log messages and troubleshooting
FileMaker Server event log messages
Troubleshooting
Problemsinstalling or starting FileMaker Server
Network problems
Problems on guest computers
Problems administering remotely

Problems using command line options (Windows and
Red Hat Linux)

Appendix D
About the Techinfo database

Searching the Techinfo database
Sample Techinfo article
Information on the Web

Index

10-2

10-3

A-1

A-2

B-1
B-2

C-1
C-5
C-5

C-6
C-7

C-7



Preface
Using the FileMaker Server documentation

The documentation for the FileMaker® Server software provides
information, illustrations, and step-by-step instructions to help you
learn the most about FileMaker Server—a powerful application that
enhances database sharing across a network.

The FileMaker Server documentation includes:
= this book, the FileMaker Server Administrator’s Guide

= FileMaker Server Help, a comprehensive online help system for
the Windows and Mac OS versions

= Context-sensitive Help for dialog box options (Windows), Balloon
Help for menu items (Mac OS 8.6 t0 9.1), and Help Tags for dialog
options (Mac OS X)

= Auto Update Guide.pdf, adocument (on the FileM aker Server CD)
for database devel opers who want to set up Auto Update in their
databases

= Commentsinthe Red Hat Linux configuration file (fmserver.conf)
and aRed Hat Linux quick reference pdf file

About this guide

The FileMaker Server Administrator’s Guide is written for
administrators of the Windows NT, Windows 2000, Mac OS, and
Red Hat Linux operating systems.

Information about using FileMaker Server in Red Hat Linux is
contained in chapter 5, “Installing FileMaker Server in Red Hat
Linux” and chapter 9, “Using FileMaker Server in Red Hat Linux.”
The rest of the guide contains information about using FileM aker
Server in Windows and in the Mac OS.

In many instances, information and instructions are the same for
Windows and the Mac OS. In these sections and topics, any
platform-specific information, such as the name of acommand, is
followed by the name of the platform in parentheses. For example:

In the Properties (Windows) or Preferences (Mac OS) dialog
box, click the Administration tab, and choose one of the following
options.

A note about the platform indicators

Information marked (Windows) applies to both WindowsNT and
Windows 2000. Information marked for one of these operating
system versions alone indicates the information is version-specific.

Information marked (Mac OS) appliesto both Mac OS8.6t09.1 and
Mac OS X. Information marked for one of these operating system
versions alone indicates the information is version-specific.

Where instructions are significantly different, you see separate
sections or topics for each operating system. Windows NT
information appears first, followed by information for
Windows 2000, then information for Mac OS 8.6 to 9.1, then
Mac OS X.

A note about the illustrations

Illustrations throughout the book are mixed, depicting situations for
al platforms except Red Hat Linux. Windows NT 4.0, Windows
2000, Mac 0S8.6109.1, and Mac OS X systemswere used for these
illustrations. What you see on your screen may vary from the
instructions in this book depending on the platform and operating
system of your computer.
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Using FileMaker Server Help (Windows
and Mac 0OS)

FileMaker Server onscreen Help is available when you are working
in the FileMaker Server Console (Windows) or when you are
working with the FileMaker Server application (Mac OS 8.6 t0 9.1)
or FM Server Config application (Mac OS X).

If you are administering FileMaker Server remotely (from another
computer on your network), you can use the Help accessed through
the Remote Administration window. For more information, see
“Getting help while administering FileMaker Server remotely” on

page Xii.

Starting FileMaker Server Help

Whenever you open FileMaker Server Help, you start the Windows
Help application (Windows), the FileM aker Help Viewer application
(Mac 0S8.61t09.1), or Help Viewer (Mac OS X). These help
applications run independently of FileMaker Server.

To start FileMaker Server Help when you' re working in the
FileMaker Server Console (Windows) or FileMaker Server
application (Mac OS), do one of the following:

= Windows: PressF1, click EZ on the toolbar, or choose Action
menu > Help.

The topic you see is dependent on whether FileMaker Server or
Schedules is selected in the Console Tree (left pane of the
FileMaker Server Console). The Help topic displayed is specific to
the area of FileMaker Server you are working with.

= Mac OS 8.6 to 9.1: Choose FileMaker Server Help from the Help
menu, press the Help key, or press 88-2.

The topic you see is dependent on the window or dialog box that is
open. The Help topic displayed is specific to the area of
FileMaker Server you are working with.

= Mac OS X: Choose FileMaker Server Config Help from the Help
menu, press the Help key, or press 88-?.

About the Help topic window

To navigate to other topicsin FileMaker Server Help, you click
buttons and underlined text in the Help topic window.

Click to return to the last topic viewed  Click to print the topic

Click to see the Help Contents, Index, Click to move to the

or to search Help for specific text previous or next topic
| —
O =—————FileMaker S¢rver:Procedjre=———— 0I5

= elp Topies | 6 Back |[ & print [ EFET = et |

Keyword: || J

Title of the current tOpiC —tUsing remote administration to disconnect guests
Oyetview  Seealso

Click to see a— =
i o To disconnect a [guest from a hosted database: =]
SUbJeCt OV.eNIe\_N 1 Inthe Remote Adminisiration window, select the quest to disconnect J
for this topic Click And select To
C||Ck toseea ||St Buesh The guest's name r[r)\acom”ngc':ge selected guest
: orm all databases
Of rEIatEd tOpICS Guests The database file under Disconnect the guest rom the
. . <guestname > the guest’s name in the selected database
Click dotted underlined Ter
textto dISplay a Files <filename > The gusst's name under  Disconnect the selected guest
AT the database in the list from a particular database
glossary definition

™~

Click Disconnect Guest.

Tou see the Disconnect Guest dialog box with the name of the guestto be
disconnected inthe title bar.

Enter text for the options in the dialog box, or accept the default settings. For

Click solid underlined

w

text to d|sp|ay more information about the options, click hers
i 4 4 Click OK.
Informatlon_ abOUI The selected quest sees a natification dialog box with your message requesting that ||
thIS Step the guest disconnect from the server. If the guest doesn't disconnect, the message |
repeats approximately one minute before the guest is setto be disconnected Z
A Help topic

Finding a topic using the Help Contents

Windows: In the FileMaker Server Console, choose Action menu >
Help, then click Help Topics.

Mac OS 8.6 t0 9.1: In FileMaker Server, choose Help menu >
Contents and Index.

If aFileMaker Server Help topicisdisplayed, click Help Topics in the
Help topic window, then click Contents (if necessary) to display the
Help Contents.



Mac OS X: In FileMaker Server, choose Help menu > FileMaker
Server Config Help.

Help Topics: FileMaker Server Help 2lx|

Contents | Index | Find |

Click & topic, and then olick Display. Or click anather tab, such as Index

[ @ Statting and Stopping FileMaker Server -
@ Configuring FileM aker Server
@ Adrministering Filebaker Server

7] About task scheduling
[7] Scheduling tasks o run automaticaly fwindows]

[2] Scheduling tasks to 1un automaticall [Mac 05 86t 91)
[2] Scheduiing tasks to run automatically [Mac 05 )

[2] wiewing scheduled tasks in the Schedules list fwindows]

[2] administering scheduled tasks with the toolbar [Windows)
[7] Updating Last Run and Mext Fun information (Windows)

[2] wiewing scheduled tasks in the Schedules window (Mac DS]
[2] Sorting and resizing columns (Mac 05 8.5t 9.1]

[21 Running scheduled tasks manualy =
= —

4

Coe | P | Cancel |

Help Contents in FileMaker Server Help (Windows)

When you open the FileMaker Server Help Contents, you see alistof
Help subjects, like the table of contentsin a book.

Windows and Mac OS 8.6 to 9.1: Double-click a book icon to
display alist of topicsfor each subject. Then double-click atopic to
display the Help topic window.

Mac OS X: Click abook icon to display alist of topicsfor each
subject. Then click atopic to display the Help topic window.

Finding a topic using the Help Index (Windows and

Mac 0S8.6t09.1)

FileMaker Server Help includes an al phabetical list of index
entries—significant words and phrases—to help you find the topics

containing the information you want. Each index entry is associated
with one or more topics.

Using the FileMaker Server documentation ix

To use the Help Index:

1. Windows: In the FileMaker Server Console, choose Action
menu > Help, click Help Topics, then click Index (if necessary).

Mac OS 8.6 t0 9.1: In FileMaker Server, choose Help menu >
Contents and Index, then click Index (if necessary).

2. Inthe Index window, type all or part of an index entry you want
to find.

1. Type the first few letters of the word you're Tooking for.

I network

The Help Index displays alist of entries beginning with the
charactersyou typed. Under someindex entriesisalist of more than
one Help topic.

0 =—————==Topics:FileMaker Server Help =—"——=HB

Contents Y Indexc Find

1. Type the first few letters of the word you're looking for

To browse the index, type the —{-fretvar
first few letters of the entry
you're looking for or scroll
through the alphabetical list

2. Select an index entry and then click " Display

< Hetworking tab =
About the Networking tab
Choosing network protocsls
Setting the preferred IP address
= networks
Choosing netwaork protocols
FileMaker Server Event Log messages —
Hardware and network considerations
Limits for files and usage
Network problems
Setting the preferred IP address
Software considerations —
1 datists d

[ Closs Wi ndow When Displaying Topics

Help Index (Mac 0S 8.6t09.1)

3. Double-click an entry to display alist of topic choices (Windows)
or the topic itself.
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Finding a topic using specific words (Windows and
Mac 0S8.6t09.1)

Y ou can specify your own significant word or combination of words
to search for within al of the Help topics. FileMaker Server Help
will display alist of all topics containing theword(s) you specify and
the total number of topics found. To narrow the search, you can
specify a combination of words. For example, you can search for all
topics containing both the word “ performance” and the word
“statistics.”

To find atopic based on a specific word or group of words:

1. Windows: In the FileMaker Server Console, choose Action
menu > Help, click Help Topics, then click the Find tab.

Thefirst time you click Find in FileMaker Server Help, the Find
Setup Wizard dialog box appears. Follow theinstructionsit provides
to set up FileMaker Server Help for finding words. This setup
procedure needs to be done only once.

Mac OS 8.6 t0 9.1: In FileMaker Server, choose Help menu >
Contents and Index, then click the Find tab.

2. In the Find window, type the words that you want to search for.
3. To narrow the search, do one of the following:

Windows: Type more than one word in the text box. Then click
Options, select All the words you typed in any order, select Immediately
after each keystroke to begin the search, then click OK. Y ou can also
select multiple words to search for by Ctrl-clicking them in the
matching word list.

Click to find a Help Topics: FileMaker Server Help [2] %]
specific word Contents | Index Find |
1 Typa the word(s) you wantto find
Type the word or words ——{ece =izd =] Cleer
you want to search for 2 Selectsome matching words o narrowyour search gptons
Select one or more ——| Find Siiler
matching words to E
make the list of topics —
more specific =l|EieE |
. 3 Click a topic. then click Display
Double-click the —— DuFM\;Ma ET e
topic you want to see HoanaFican
FileMaker Server EventLog messages
Keeping event data current (Windows)
Performancs tips [
This shows the total ———1& Topics Found | [Allwords, Begin, Auto, Pause ]
number of topics found
Deply | Eit | Cenel |

Finding words in FileMaker Server Help (Windows)

Mac 0OS 8.6t0 9.1: Click More Choices and type asecond word in the
new row below the first word. Then click Search. Y ou can add
multiple rows and choose different parameters from the pop-up
menus for each word.

Type the word you want to search for

[0 =————Topics:FileMaker Server Help =———H B

Choose options from the fontents Y ndex

Find

pop_up menus tO Specify 1.Irma topics that... ] @

search parameters || Cae 1% (e vora =) [oanhe |

and %) (the wora =) [size |

Click to add another - eraees
word to the search

2. Selest a topic and then click “Display & Topics Found

SE|ECt a tOPiC T {T] About server sctivity tracking
from the list Keeping event data current (indows)

Performance tips
FileMaker Server Event Log messages

About FileMaker Server confiquration
About the Files tab

[ Close indow When Displaying Topics Display

%

Finding specific words in FileMaker Server Help
(Mac0S861t09.1)

4. Select atopic in the topic list, then click Display.



FileMaker Server Help shows each occurrence of the word or words
you searched for in the Help topic window.

Finding a topic using specific words (Mac OS X)
To find atopic based on a question or phrase:

1. In FileMaker Server, choose Help menu > FileMaker Server Config
Help.

2. Inthe Ask box, type a question or phrase that you want to search
for and click Ask.

Apple Help Viewer displays alist of topics containing the word or
phrase you searched for.

3. Click atopic title.

Type the question or words you want to search for Click Ask
8eoe FileMaker Server Help
I(a(he size I € ask Y
. .
Answers
Page 1 of 3 about "cache size” in FileMaker Server Help
Performance tps ssses
About FileMaker Server configuration ~ sssss
FileMaker Server event log messages ~ seses
Keeping event data current (Windows) ~ ssses
About server activity trackng  ~~ seses
Setting how often the cache is flushed
Setting a size for the event lag (Mac_0S)
et n Log (Windows NT)
Satting a size limit for the Application Log (Windows 2000)
If you don't see the results you want, try different words or search all Help. Mext
D) @
S~ I~

Finding a topic in FileMaker Server Help (Mac OS X)

Using the FileMaker Server documentation  xi

Finding information about specific items in
FileMaker Server

Asyou're working in FileMaker Server, you can find information
about a dialog box that’s open or certain items your mouseis
pointing to, depending on the platform you're using.

Windows: For context-sensitive Help, do one of the following:

= Select FileMaker Server or Schedules in the Console Tree (Ieft side
of the FileMaker Server Console) and choose Action menu > Help.
You can also press F1, or click @ on the toolbar.

= Right-click FileMaker Server or Schedules in the Console Tree and
choose Help.

= |n the upper-right corner of adialog box, click [Z, then click an
item in the dialog box to find out about it.

= Rest the pointer over a menu name or toolbar item and read its
description in a pop-up window.

= Rest the pointer over amenu command and read its description in
the lower left corner of the console.

Mac OS 8.6 to 9.1: For context-sensitive Help, do one of the
following:

= Some windows and dialog boxes have context-sensitive Help. To
access it, open a dialog box and press the Help key, choose Help
menu > FileMaker Server Help, or press 88 -?. The Help topic for that
dialog box opens. If aHelp topic does not appear or the

FileMaker Server Help command is dimmed in the Help menu,
context-sensitive Help isnot avail able for the open window or dialog
box.

= Choose Help menu > Show Balloons and then point to a menu, or
select amenu and drag to display a description of each menu item.

= Choose Help menu > Show Balloons, select a pop-up menuin a
dialog box, and drag to display a description of each item in thelist.
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Mac OS X: For context-sensitive Help, do the following:

= Point to an option in adialog box. After afew seconds a
description of the item appears.

Getting help for FileMaker Server in
Red Hat Linux

If you're using FileMaker Server in Red Hat Linux, for online help
see the comments in the configuration file, fmserver.conf. The
QuickRef.pdf file also contains information about configuring and
administering FileMaker Server in Red Hat Linux.

Getting help while administering

FileMaker Server remotely

The onscreen Help for FileMaker Server isinstalled on the server
computer, so you can’t access it when you are administering or
monitoring FileMaker Server activity from another computer.

To get help for remote administration tasks while working in the
Remote Administration window, click [2] in the Remote
Administration window.

Click here to get help

Remote Administration

Froducts
P Patrick Murphy 38 0:00
¥ Sophie Tang 402 402
Froducts
Tours

Falder: 2 Filss: 8 Gussts: 3
[ Open File... Il Disconne: ot Guast.. Il Send Mesage . |

Get Details. . Send Message to All..
FiteMaker Server

To close the Help window and return to the Remote Administration
window, click Done.



Chapter 1
Welcome to FileMaker Server 5.5

Welcome to the FileMaker Server 5.5 application from FileM aker,
Inc. for Windows NT, Windows 2000, Mac OS 8.6 t0 9.1,
Mac OS X, and Red Hat Linux.

FileMaker Server gives you enhanced database hosting capabilities
on your network when used with the FileMaker Pro 5.x database
management application.

Registration and customer support

Please take the time to complete and mail the registration card for
your product or register online:

= Windows: In the FileMaker Server Console, choose View menu >
FileMaker on the Web

= Mac OS8.6109.1: Start FileMaker Server and choose Help
menu > FileMaker on the Web

= Mac OS X: Start FileMaker Server Config and choose Help
menu > FileMaker on the Web

= Red Hat Linux: Point your browser to www.filemaker.com/
register

For information about technical support and customer service, see:
www.filemaker.com (North American customers)
www.filemaker.com/intl (customers outside North America)

or choose:

Windows: View menu > FileMaker on the Web
Mac OS: Help menu > FileMaker on the Web

At the web site, you will find the FileMaker, Inc. Service Directory,
which details the service options available to North American
customers, aswell aslinksto FileMaker, Inc. international sites,
answers to frequently asked questions, and access to extensive
software libraries used by the technical support staff. If you do not
have access to the Web, please refer to the Technical Support and
Customer Service sheet included in the software box. North
American customers can also call 1-800-965-9090 to learn about the
service options available.

Introducing FileMaker Server

Y ou’'ve always been able to share database filesin FileMaker Pro
using a peer-to-peer sharing scheme with the Multi-User command.
Y ou can aso use the FileMaker Server application as a dedicated
host to open FileMaker Pro 5.x files and make them available to
FileMaker Pro guests on your network, allowing better performance
among more guests. FileMaker Server acts only as a host, and uses
advanced client/server technology to take care of much of the
background work associated with managing files, thereby enhancing
performance for FileMaker Pro guests accessing those files.

FileMaker Server can host up to 125 database files and support up to
250 simultaneously connected FileMaker Pro guests. (AppleTak
support is limited to 124 simultaneous guests.)

FileMaker Server includes aremote administration capability.
Remote administration letsyou easily monitor and administer hosted
databases and guests and track statistical information from a
computer running FileMaker Pro 5.x.
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Important Avoid installing FileMaker Server on acomputer that isa
user’ s primary workstation or network file server. FileMaker Server
should be run on adedicated computer reserved for use as adatabase
server.

When FileMaker Server ishosting many guests or alarge number of
database files, it uses a high level of processor, hard disk, and
network capacity. Other processor-intensive applications (for
example, Web-server or disk-backup software) or heavy network
traffic on the same computer will cause FileMaker Server to run
more slowly and degrade the performance of FileMaker Pro on guest
computers.

Inaddition, file sharing should beturned off on the computer running
FileMaker Server.

Note This guide assumes you’re familiar with general database
concepts as well as the basics of FileMaker Pro. If you're not, refer
to thetutorial in the FileMaker Pro 5.5 Getting Started Guide or to
the FileMaker Pro 5 User’ s Guide (especialy thefirst two chapters)
for more information.

Howv does FileMaker Server work?

The FileMaker Server application isatool to use with
FileMaker Pro 5.x in anetwork environment to:

= enhance database guest performance

= increase the number of FileMaker Pro guestswho can connect to a
file hosted by FileMaker Server

= increase the number of files that can be hosted by
FileMaker Server

= host files using more than one network protocol simultaneously

Y ou can use the remote administration capability of
FileMaker Server to administer the server software from a different
computer on your network. When administering remotely, you can:

= open—or host—aFileMaker Pro databasefile, making it available
to FileMaker Pro guests on the network

= view information about the files being hosted, like the number of
guests accessing each database

= send messages to connected guests

= close ahosted FileMaker Pro file, making it unavailable to
FileMaker Pro guests

= disconnect aselected FileMaker Pro guest from aparticular hosted
fileor al hosted files

Some of these administrative tasksrequire that you install the Server
Administration plug-in for FileMaker Server on your remote
computer. For more information about installing the plug-in, see
chapter 10, “Installing the Server Administration plug-in on aremote
computer.”

For more information about administering remotely, see chapter 7,
“Administering FileMaker Server (Windows and Mac OS).”

When you start FileMaker Server, it automatically opens and hosts
all multi-user FileMaker Pro 5.x files located in the same folder (or
the first level of subfolders) as the FileMaker Server application.

This common folder architecture lets you easily set up the database
filesthat you always want FileMaker Server to host on the network.

Keep in mind the following points about the different uses of
FileMaker Server and FileMaker Pro:

= Use FileMaker Server to open and host FileMaker Pro files that
you want to make available to FileMaker Pro guests on your
network.

= Asadedicated host, FileMaker Server only hosts the files.
FileMaker Server can’t access or modify theinformation in the files.



= UseFileMaker Pro to create database files or modify the structure
of existing files (for example, to password-protect each hosted
FileMaker Pro file or to access field definitions).

The Web Companion feature of FileMaker Pro can be used to
publish files hosted by FileMaker Server on the Internet or on a
company’ sintranet. For moreinformation about web publishing, see
the documentation for FileMaker Developer, FileMaker Pro, or
FileMaker Pro Unlimited.

What's in the FileMaker Server package
The FileMaker Server package includes:

Package component Description

FileMaker Server CD The Setup application (Windows), the Start Here
Mac OS Classic application, the Start Here Mac
OS X application, the FileMaker Server rpm file
(Red Hat Linux), aswell asall thefilesyou needto

use FileMaker Server

FileMaker Server
Administrator’s Guide

Installation instructions and information about
how to use FileMaker Server (this guide)

FileMaker registration Information to register your copy of
card FileMaker Server

What’s new or improved in
FileMaker Server 5.5

The new and improved features of FileMaker Server include:

= Support for Windows 2000, Mac OS X, and Red Hat Linux,
making FileMaker Server available on abroader range of computers
and operating systems

= Ability to register FileMaker Server with aLightweight Directory
Access Protocol (LDAP) compliant directory service such as
Microsoft Active Directory, Netscape Directory, or OpenLDAP

Welcome to FileMaker Server 5.5 1-3

= Ability to automatically download software updates (for example,
plug-ins) from the server computer to guest computers

Windows

= Windows 2000: Ability to access Windows Services, Event
Viewer, and System Monitor from within the FileMaker Server
Console

= Ability to require guests to be members of the same domain as
FileMaker Server before being granted access to hosted databases

Mac OS X

= A native Mac OS X application that takes advantage of Mac OS X
features such as preemptive multitasking, protected memory, and
dynamic memory allocation

Before you begin

For instructions on installing FileMaker Server, see the following
chapters.

Platform Chapter

Windows Chapter 2
Mac OS8.6t09.1 Chapter 3
Mac OS X Chapter 4
Red Hat Linux Chapter 5
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Chapter 2
Installing FileMaker Server in Windows

This chapter provides step-by-step instructions for installing
FileMaker Server and associated files on a computer running
Windows NT 4.0 or Windows 2000.

What you need

To use FileMaker Server, you need the following equipment and
software.

Windows system requirements

To use FileMaker Server on Intel-Pentium and compatible systems,
you need:

= an Intel compatible PC with a Pentium processor

= at least 64 MB of installed RAM (Windows NT 4.0) or 128 MB of
installed RAM (Windows 2000)

= one of the following operating system software configurations:

= Windows NT Server 4.0 or Windows NT Workstation 4.0 (10
or fewer users only) and Windows NT Service Pack 3, 4, 5, or 6.
See the End User License Agreement that came with the
Windows NT operating system for more information concerning
the allowed number of connections.

= Windows 2000 Server or Windows 2000 Professional (10 or
fewer users only)

= Microsoft Management Console (MMC) 1.1 (installed by the
FileMaker Server Installer if it's not already installed on your
computer). Windows NT: MMC requires Internet Explorer 4.01.

= aweb browser for accessing FileMaker on the Web information from
the View menu

= FileMaker Pro 5.x for running the remote administration
capability and for creating and converting databases to be hosted by
FileMaker Server 5.5. FileMaker Server 5.5 supports only
FileMaker Pro 5.x databases.

= alogin account with administrative privileges for installing
FileMaker Server

= aCD or DVD drive

= ahard disk with at least 4 MB of free disk space for the
FileMaker Server files. Be sure to allow additional space for the
database files you intend to host, which should be located on the
same disk as the FileMaker Server application.

Important Up to 20 MB of free disk space may be required during
the installation process.

Networking requirements

To share files among users on a network, you need to have the
following additional software and hardware installed on the host
computer running FileMaker Server:

= aWindows NT or Windows 2000 compatible network card. If you
want to specify apreferred | P addressfor FileMaker Server, asecond
network card is required. For more information, see “ Setting the
preferred | P address’ on page 6-12.

= the software driver for your network card

= NWLink IPX/SPX Compatible Transport and/or TCP/IP network
protocol for Windows NT or Windows 2000
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Guests can use the following network protocols to access database
files hosted by FileMaker Server:

Network Mac OS 8.6
protocol Windows guest t0 9.1 guest Mac OS X guest
IPX/SPX  NWLink IPX/SPX IPX isnot IPX isnot supported
Compatible Transport supported
(Windows NT client)
Microsoft IPX/SPX
Compatible Transport
(Windows 95 or
Windows 98 client)
TCP/IP TCP/IP Apple Open TCP/IPisintegrated

Transport 1.1.1  with Mac OS X

Important FileMaker Server uses a proprietary networking scheme
and operatesindependently of your network operating system (NOS)
access privileges. Multi-user FileMaker Pro databases will be
available to FileMaker Pro guests regardless of NOS privileges. To
restrict access to FileMaker databases, use the access privileges
available in FileMaker Pro 5.x. For more information, see
“Protecting files with a password” on page 6-17. Database files
should be shared using networking available in FileMaker Pro. Do
not share FileMaker Pro files using Windows file sharing.

Installing FileMaker Server

Usethe Setup programtoinstall FileMaker Server on your hard disk.
Thisinstallation procedure describes how to install the:
= FileMaker Server application and supporting files

= FileMaker Server examplefiles

By default, the Setup program creates a folder named Program
Files\FileMaker\FileMaker Server 5.5 folder on your hard disk, then
installs FileM aker Server and examplefilesin it. However, you can
choose a different location during installation.

Toinstall FileMaker Server on your hard disk:
1. Exit al other applications and turn off virus protection utilities.
2. Insert the FileMaker Server CD into your CD or DVD drive.

3. Double-click the Read Me icon to read important information
about thisrelease of FileMaker Server. Then close the Read Mefile.

4. Double-click setup.exe.
Y ou see the Welcome screen of the FileMaker Server Setup Wizard.
5. Click Next.

6. Read the license agreement. |f you agree to these terms, select |
accept the terms in the License Agreement, then click Next.

7. Personalize this copy of FileMaker Server by typing your name,
organization name, and indicate who can access FileMaker Server
from this computer (only you or anyone who uses the computer).
Then click Next.

8. Choose Complete in the Setup Type screen to install
FileMaker Server and the example files, then click Next.

Note If you don’t have enough disk space on the server computer, you
see the Out of Disk Space dialog box. Quit the installation, remove
filesfrom the installation volume to free some space, and try again.

9. Select an option for FileMaker Server start-up, then click Next.

Select If you want FileMaker Server to start

Whenever Windows starts.

Note After ingtdlation, you must start the FileMaker Server
servicemanualy thefirst time. For moreinformation, see* Starting
FileMaker Server (WindowsNT)” on page 7-1 or “ Starting
FileMaker Server (Windows 2000)” on page 7-1. Theregfter,
FileMaker Server will start when you restart the computer.

Automatic

Manual After youturnonthe FileMaker Server serviceinthe Services
control panel (Windows NT) or Services console (Windows
2000). For moreinformation, see“ Starting FileMaker Server
(Windows NT)” on page 7-1 or “ Starting FileMaker Server
(Windows 2000)" on page 7-1.




10. Type your installation code, then click Next.

Tip Your installation code is a seventeen digit number located on a
multi-part sticker on the installation code sheet with the
FileMaker Server CD.

11. If the Microsoft Management Console (MM C) softwareis not
installed on your server computer, the Setup Wizard will prompt you
toinstall it now. Theinstallation of MMC can take several minutes
and you can’t cancel this installation once it has begun. If you want
to install MMC and continue the installation of FileMaker Server,
click Next.

12. Click Install to begin FileMaker Server file installation.

The Setup Wizard installs FileMaker Server 5.5 and the example
files.

13. Click Finish to close the Setup Wizard. Remember to turn virus
protection utilities back on.

It'simportant to register your copy of FileMaker Server with
FileMaker, Inc., so you have full access to customer and technical
support. For more information, see “Registration and customer
support” on page 1-1.

For information about starting the application, see“ Starting
FileMaker Server (Windows NT)” on page 7-1 or “ Starting
FileMaker Server (Windows 2000)” on page 7-1.

Note To enable administration functions on aremote computer
(open files, closefiles, and so on), you must install the Server
Administration plug-in on each remote computer you plan to usefor
remote administration. For more information, see “ Automatically
downloading the Server Administration plug-in to aremote
computer” on page 7-6.
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Where files are stored on your hard disk

The following table describes the FileMaker Server files that are
installed on your hard disk.

Default location File Description

The FileMaker
Server service

hard_drive:\ fmserver.exe
Program Files\
FileMaker \

FileMaker Server 5.5

FileMaker Server
message resource
(required by Event
Viewer)

fmsmesg.dil

FileMaker Server
Console (MMC
saved console)

fmsconsl.msc

FileMaker Server
debug symbol file
(required by the Dr.
Watson debugger)

fmserver.dbg

FileMaker Server
properties
component (MMC
snap-in)
FileMaker Server
Task Scheduler
component (MMC
snap-in)
Performance
Monitor support

fmsprop.dil

fmsschd.dll

fmsmemadll

FileMaker Server
component required
by the Performance
Monitor

fmsperf.dil

fmshelp.hlp FileMaker Server

onscreen Help
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Default location File Description Default location File Description
fmshelp.cnt FileMaker Server Server Administration.bin Remote
onscreen Help Server Administration.txt administration
Contents plug-in filesfor
fmshelp.gid Support files for Mac0S8.6109.1
FileMaker Server hard_drive:\ AutoUpdatePlugin.fp5 A FileMaker Pro
onscreen Help Program Files\ database that
fmshelp.fts Support files for E::% ig \Server 55 illustrates how to set
FileMaker Server ' up AutoUpdate
onscreen Help AutoUpdate Examples\
AutoUpdatePlugin
readme.doc Tn?(pgglaifoma' ning hard_drive:\ fmpctrnm.h Used for manual
information about Program Files\ I?Zl?/lier Server
this release of FileMaker\ "
FileMaker Server FileMaker Server 5.5\ Performance
: Perfctrs Monitor support
Go_FileMaker.html HTML document for
FileMaker on the fmpsperf.ini
Wweb hard_drive\ Registration files Used for registering
fms_logo.gif Graphic file of Program Files\ FileMaker Server
FileMaker Server FileMaker \
logo for the FileMaker Server 5.5\
FileMaker on the Registration
Web document system_root\ mmc.exe Microsoft
hard_drive:\ Sample batch files Sample template System32 Management
Program Files\ scripts to use for Console application
FileMaker \ running backups on (installed for
FileMaker Server 5.5\ the command line Windows NT
Examples systems only)

hard_drive\

Program Files\
FileMaker \
FileMaker Server 5.5\
AutoUpdate

fmpsadm.fmx Remote

fmpsadm.fmx.txt administration
plug-in filesfor
Windows

Server Administration X.bin  Remote

Server Administration X.txt  administration

plug-in filesfor
Mac OS X
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Note The FileMaker Server Instaler installs MMC files on the
server computer, if MMC isnot aready installed. In thissituation, a
few MMC-related files are installed in the System32 and Help
folders on your server computer in addition to the fileslisted in the
table.

Uninstalling FileMaker Server (Windows)

Before removing FileMaker Server from your computer, be sure to
first stop the FileMaker Server service.

To remove FileMaker Server from your computer:
1. Start Windows.
2. Stop FileMaker Server.

For more information, see* Stopping FileMaker Server
(Windows NT)” or “Stopping FileMaker Server (Windows 2000)”
on page 7-2.

3. Click the Start button > Settings > Control Panel.

4. Double-click the Add/Remove Programs icon.

Y ou see the Add/Remove Programs Properties dial og box.

5. Select FileMaker Server 5.5, then click the Add/Remove button.
Y ou see the FileMaker Server 5.5 Setup Wizard.

6. Click Next.

7. Select Remove, click Next, then click Remove again.

The Uninstaller removes the FileMaker Server files from the hard
disk. After al the files are removed, afinal dialog box tellsyou
FileMaker Server was removed successfully.

8. Click Finish and then OK to close the Add/Remove Programs
Properties dialog box.
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Chapter 3
Installing FileMaker Server in Mac OS 8.6 to 9.1

This chapter provides step-by-step instructions for installing the
FileMaker Server application and associated files on a computer
running Mac OS 8.6 t0 9.1.

What you need

To use FileMaker Server, you need the following equipment and
software.

Mac OS 8.6 to 9.1 system requirements
To use FileMaker Server, you need:

= any Apple Power Macintosh or compatible computer, running
Mac 0S8.6t09.1. FileMaker Server runsin native mode on a Power
Macintosh.

= FileMaker Pro 5.x for running the remote administration capability
and for creating and converting databases to be hosted by
FileMaker Server 5.5. FileMaker Server 5.5 supports only
FileMaker Pro 5.x databases.

= aweb browser for accessing FileMaker on the Web information from
the Help menu

= aCD or DVD drive

= 32 MB of available system memory (RAM). For information about
running FileMaker Server with virtual memory turned on, see
“FileMaker Server, virtual memory, and physical

memory requirements’ on page 6-7.

= aninternal or external hard disk drive with at least 4 MB of free
disk spacetoinstall the FileMaker Server application and related
files. Be sure to alow additional space for the database files you
intend to host, which should be located on the same disk as the
FileMaker Server application.

Networking requirements

To share files among users on a network, you can use AppleTak or
TCP/IP networking. TCP/IP is recommended for best performance.
Apple Open Transport 2.0.1 is required on the computer running
FileMaker Server.

Guests can use the following network protocols to access database
files hosted by FileMaker Server:

Network
protocol Mac 0S 8.6 t0 9.1 guest Mac OS X guest Windows guest
AppleTalk Apple LocaTak AppleTalkisn't AppleTakisn't
(provided by your supported in supported in
system) or Apple Mac OS X Windows
EtherTalk (Phasel or II)
TCP/IP Apple Open Transport ~ TCP/IPis Microsoft
111 integrated with ~ TCP/IP-32
Mac OS X

Installing FileMaker Server

Usethelnstaller toinstall the complete FileMaker Server packageon
your hard disk. The Installer creates afolder caled
FileMaker Server 5.5.

Toinstall FileMaker Server on your hard disk:

1. Quit all other applications, especialy virus protection software,
and disable file sharing.

2. Insert the FileMaker Server CD into your CD or DVD drive.

Y ou seethe CD window on your screen. If you seeonly thediscicon,
double-click theicon to open its window.
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3. Double-click the Installer icon named Start Here Mac OS Classic.

Start Here Mac 05 Classic

4. Read the license agreement. If you agree to these terms, click
Accept.

Y ou see the FileMaker Server Installer dialog box.

Start Here Mac 0§ Classic———HIH
Easy Install 3
Click the Install button to install
+ FileMaker Server 5.5
+ FileMaker Server Examples
+ Read Me
— Install Location
The folder “FileMaker St 55" will b ited on the
. e folder "FileMaker Server 5.5 will be created on the
Folder and disk where s “Har Disk”
FileMaker Server is et Locsions (Hard Disk z instan_|
installed Z

Select a different folder or disk

5. Toinstall the application onto a different disk or into a specific
folder, click the Install Location pop-up menu and choose Select
Folder. In the dialog box that appears, choose a destination disk and
folder, then click Select.

6. Click Install.

7. Type your name, company name (optional), and your installation
code.

Tip Your installation code is a seventeen digit number located on a
multi-part sticker on the installation code sheet with the
FileMaker Server CD.

8. Click OK.

If the hard disk you chose has enough space, the Installer begins
installing files.

9. Click Quitto leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before
installing, turn them back on now.

It'simportant to register your copy of FileMaker Server with
FileMaker, Inc., so you have full access to customer and technical
support. For more information, see “Registration and customer
support” on page 1-1.

For information about starting the application, see “ Starting
FileMaker Server (Mac OS 8.6 t0 9.1)" on page 7-3.

Note To administer FileMaker Server from aremote computer
(open files, closefiles, and so on), you must install the Server
Administration plug-in on each remote computer you plan to use for
remote administration. For more information, see “ Automatically
downloading the Server Administration plug-in to aremote
computer” on page 7-6.

Where files are stored on your hard disk

The following table shows the location and contents of the installed
items.

FileMaker Server

5.5 folder File Description

FileMaker Server The FileMaker Server

application

Read Me A text file containing
important information
about this release of

FileMaker Server

FileMaker on the Web Andiasfor

Go_FileMaker.html
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FileMaker Server

Installing FileMaker Server in Mac 0S 8.6 t0 9.1 3-3

5.5 folder File Description 5.5 folder File Description
AppleScript FileMaker Server Apple A FileMaker Pro FMI Go_FileMaker.html HTML document source
Examples:Apple Events database that gives an filefor FileMaker onthe
Events Information introduction to the Web

Apple events supported FMS_Logo.gif Graphic file of

by FileMaker Server, so
you can control it using
AppleScript or similar
applications. See the
documentation that
came with AppleScript
or other applicationsfor
details on how to send
eventsto

FileMaker Server.

FileMaker Server logo
for the FileMaker on the
Web document

AutoUpdate fmpsadm.fmx Remote administration
fmpsadm.fmx.txt plug-in filesfor
Windows
Server Administration X.bin  Remote administration
Server Administration X.txt  plug-in files for
Mac OS X
Server Administration.bin Remote administration
Server Administration.txt plug-infilesfor Mac OS
8.6109.1
AutoUpdate AutoUpdatePlugin.fp5 A FileMaker Pro
Examples: database that illustrates
AutoUpdatePlugin how to set up
AutoUpdate
FileMaker Help FileMaker Help Viewer An application that
displays
FileMaker Server Help
FileMaker Server Help Onscreeen Help for
FileMaker Server
AppleScript Apple Script files Sample template scripts
Examples to use with FileMaker

Server
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Chapter 4
Installing FileMaker Server in Mac OS X

This chapter provides step-by-step instructions for installing the
FileMaker Server application and associated files on your computer
running Mac OS X.

What you need

To use FileMaker Server, you need the following equipment and
software.

Mac OS X system requirements

To use FileMaker Server, you need:

= any Apple G3 or G4 or compatible computer (CPU upgrade cards
are not supported)

= Mac OS X (the Mac OS X “Public Beta” release is not supported)

= FileMaker Pro 5.x for creating and converting databases to be
hosted by FileMaker Server 5.5. FileMaker Server 5.5 supportsonly
FileMaker Pro 5.x databases.

= alogin account with administrative privileges for installing
FileMaker Server

= aweb browser for accessing FileMaker on the Web information from
the Help menu

= aCD or DVD drive
= 128 MB of available system memory (RAM)

= aninternal or external hard disk drive with at least 7.8 MB of free
disk spacetoinstall the FileMaker Server application and related
files. Be sure to alow additional space for the database files you
intend to host, which should be located on the same disk as the
FileMaker Server application.

Networking requirements

To share files among users on a network, you must use TCP/IP
networking. Guests can use the following versions of TCP/IP to
access database files hosted by FileMaker Server:

Network
protocol Mac 0S 8.61t09.1 guest Mac OS X guest ~ Windows guest
TCP/IP Apple Open Transport ~ TCP/IPis Microsoft
111 integrated with TCP/IP-32
Mac OS X

Installing FileMaker Server

Usethe Installer to install FileMaker Server on your hard disk. The
Installer creates afolder called FileMaker Server 5.5.

Toinstall FileMaker Server on your hard disk:

1. Quit all other applications, especially virus protection software,
and disable file sharing.

Note FileMaker, Inc. recommends that you be logged in as the root
user during installation.

2. Insert the FileMaker Server CD into your CD or DVD drive.

Y ou seethe CD window on your screen. If you seeonly the discicon,
double-click the icon to open its window.

3. Double-click the Installer icon named Start Here Mac OS X.

Start Here Mac OS5 X

4. Read the license agreement. If you agree to these terms, click
Accept.
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Y ou see the FileMaker Server Installer dialog box.

686 Start Here Mac 0S X
Easy Install = (Read Me... )
Click the Install button to install
= FileMaker Server 5.5
s FileMaker Server Examples
= Read Me
— Install Location
Folder and disk where ‘7;:") The folder “FileMaker Server 5.5 will be created on the -l
- B i dizk "Mz 05 X"
FileMaker Server is — = P
: Install Locat: 'y
installed install Loeation: | Mac

i 4

Select a different folder or disk

5. Toinstall the application onto a different disk or into a specific
folder, click the Install Location pop-up menu and choose Select
Folder. In the dialog box that appears, choose a destination disk and
folder, then click Select.

6. Click Install.

7. Type your name, company name (optional), and your installation
code.

Tip Your installation code is a seventeen digit number located on a
multi-part sticker on the installation code sheet with the
FileMaker Server CD.

8. Click OK.

If the hard disk you chose has enough space, the Installer begins
installing files.

9. Click Quit to leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before
installing, turn them back on now.

It'simportant to register your copy of FileMaker Server with
FileMaker, Inc., so you have full access to customer and technical
support. For more information, see “Registration and customer
support” on page 1-1.

For information about starting the application, see “ Starting

FileMaker Server (Mac OS X)” on page 7-3.

Note To enable administration functions on remote computers (open
files, closefiles, and so on), you must install the Server
Administration plug-in on each remote computer you plan to use for
remote administration. For more information, see “ Automatically
downloading the Server Administration plug-in to aremote
computer” on page 7-6.

Where files are stored on your hard disk
The following table shows the location and contents of the installed

items.

FileMaker Server
5.5 folder

File

Description

FileMaker Server Config

The FileMaker Server
configuration
application and the
server gpplication

Read Me.txt

A text file containing
important information
about this release of
FileMaker Server

FileMaker on the Web

Andiasfor
Go_FileMaker.html

AppleScript
Examples

Read Me.txt

Seethe Read Me.txt file
in the AppleScript
Examples folder for
more information

AutoUpdate

fmpsadm.fmx
fmpsadm.fmx.txt

Remote administration
plug-in filesfor
Windows

Server Administration X.bin
Server Administration X.txt

Remote administration
plug-in filesfor
Mac OS X




FileMaker Server

5.5 folder File Description
Server Administration.bin Remote administration
Server Administration.txt plug-infilesfor Mac OS
86t09.1
AutoUpdate AutoUpdatePlugin.fp5 A FileMaker Pro
Examples: database that illustrates
AutoUpdatePlugin how to set up
AutoUpdate

FMI

Go_FileMaker.html

HTML document source
filefor FileMaker onthe
Web

FMS_Logo.gif

Graphic file of
FileMaker Server logo
for the FileMaker on the
Web document

Important Do not ater the contents of the FileMaker Server Package.

Doing so could permanently damage FileMaker Server.
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Chapter 5
Installing FileMaker Server in Red Hat Linux

This chapter provides step-by-step instructions for installing
FileMaker Server and associated files on a computer running the
Red Hat Linux operating system.

What you need

To use FileMaker Server, you need the following equipment and
software.

Red Hat Linux system requirements

= an Intel compatible PC with a Pentium or later processor
= gt least 64 MB of installed RAM

= Red Hat Linux 6.2 or 7.0 operating system

= ahard disk drive

= aCD or DVD drive

= FileMaker Pro 5.x for aWindowsor Mac OS computer for running
the remote administration capability and for creating and converting
filesto be hosted by FileMaker Server 5.5

= ahard disk with at least 4 MB free disk space for the FileMaker
Server files. Be sure to allow additional space for the database files
you intend to host, which should be located on the same disk asthe
FileMaker Server application.

Networking requirements

To share files among users on a network, you need to have the
following additional software and hardware installed on the host
computer running FileMaker Server:

= aRed Hat Linux compatible network card

= the kernel module for your network card

= TCP/IP network protocol for Red Hat Linux

Note If you have asecond network card, you can specify apreferred
|P address for FileMaker Server. For more information, see
“ Specifying the preferred | P address’ on page 9-12.

Installing and registering FileMaker Server

Y ou can use theterminal window or apseudo terminal (pts) toinstall
FileMaker Server 5.5.

Important Y ou must belogged in as the root user during installation
and when making changes to the FileMaker Server configuration
file. Logging in asroot gives you complete access to all system
resources. Be extremely careful when working astheroot user. Y ou
could accidentally issue acommand that could detrimentally affect
your operating system software.

Toingtall FileMaker Server:
1. Insert the FileMaker Server CD into your CD or DVD drive.

2. Switch to the root user by entering the following command at the
shell prompt:

$ su -1 root

For information about accessing the shell prompt, see your operating
system documentation.

3. Enter the root password.

The prompt changes to #, indicating that you are now logged in as
the root user.

4. Mount the installation CD by entering:
# mount /mt/cdrom
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5. Change to the CD directory by entering:
# cd /mt/cdrom

6. Enter the following command to install the FileMaker Server files
on your hard disk:

# rpm-Wh frserver-5.5-1.1386.rpm

7. Enter theregistration command followed by your installation code
and the location of the FileMaker Server binary on your server
computer. For example:

# fns _registration 1-1111-1111-1111-1111 /usr/bin/
fmserverd

Tip Your installation code is a seventeen digit number located on a
multi-part sticker on the installation code sheet with the FileMaker
Server CD.

Registering FileMaker Server in Red Hat Linux activates the
FileMaker Server daemon and lets you start the FileMaker Server
service.

8. Log out asthe root user by entering:
# | ogout

It'simportant to register your copy of FileMaker Server with
FileMaker, Inc., so you have full access to customer and technical
support. For more information, see “Registration and customer
support” on page 1-1.

For information about configuring and using FileMaker Server on
the server computer, see chapter 9, “Using FileMaker Server in Red
Hat Linux.” For information about using remote administration, see
“Enabling remote administration in FileMaker Server” on page 9-10
and chapter 10, “Manually installing the Server Administration
plug-in on aremote computer.”

Where files are stored on your hard disk

The following table describes the FileMaker Server filesand
directories that are installed on your hard disk.

File

Description

[etc/fmserver.conf

The FileMaker Server configuration
file

[etc/re.d/init.d/fmserverd

An auto-start and stop script for
FileMaker Server. For more
information, see“ Starting and stopping
FileMaker Server automatically” on
page 9-2.

Jusr/bin/fmspasswd

A utility for setting the remote
administration and directory service
passwords

Jusr/bin/fmserverd

The FileMaker Server daemon binary
file

Jusr/bin/fms_registration

A utility for activating the FileMaker
Server daemon (fmserverd), enabling it
to start the FileMaker Server service.
You run this utility only once
immediately after installation.

Jusr/doc/fmserver-5.5

The directory containing the FileMaker
Server 5.5 Readme file, FileMaker
Server Administrator’s Guide PDF,
quick reference PDF, Auto Update
developer documentation and sample
file, and license

Jusr/doc/fmserver-5.5/backup.sample

A sample backup script

Ivarlfmserver

The directory where you place
FileMaker Pro databases that you want
to host




File Description
Ivarlfmserver/AutoUpdate/ Remote administration plug-in filesfor
FMPSADM.FMX Windows

var/fmserver/AutoUpdate/

FMPSADM.FMX .txt

Ivarlfmserver/AutoUpdate/Server
Administration X.bin

var/fmserver/AutoUpdate/Server
Administration X.txt

Remote administration plug-in filesfor
Mac OS X

Ivarlfmserver/AutoUpdate/Server
Administration.bin

var/fmserver/AutoUpdate/Server
Administration.txt

Remote administration plug-in filesfor
Mac 0S8.6t09.1

Ivar/log/fmserver

The directory containing log files
(events.log and stats.log) for FileMaker
Server. The stats.log file appearsin this
directory after you enable statistics
logging.

Uninstalling FileMaker Server

If you need to remove the FileMaker Server software from your
computer, you do not need to stop the FileM aker Server service. The
operating system’ sapplication removal command (rpm) can detect if
FileMaker Server isrunning and will warn guests and stop the
service before removing FileMaker Server from your computer.

The rpm command removes only those files installed by the
FileMaker Server installer. Therefore, hosted database files placed
on the server by the FileMaker Server administrator and log files
created by FileMaker Server are not removed when you uninstall

FileMaker Server.
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Note The FileMaker Server configuration file (fmserver.conf) is
backed up and saved during uninstall. Therefore, you will have
access to your customized settings if you choose to reinstall
FileMaker Server.

Toremoveal filesfrom your hard disk that were installed by the
FileMaker Server installer:

1. Switch to the root user by entering the following command at the
shell prompt:

$ su -1 root

2. Enter the root password.

3. Enter the following command to remove FileMaker Server:
# rpm-e fnserver

4. Log out as the root user by entering:

# | ogout
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Chapter 6
Configuring FileMaker Server (Windows and Mac OS)

Configuration settings allow you to customize FileMaker Server for
optimal performance.

Windows: Use the configuration assistants in the FileM aker Server

Console or the Properties dialog box to configure FileMaker Server.

Mac OS: Use the Preferences dialog box to configure
FileMaker Server.

Red Hat Linux: For information about configuring FileMaker Server
settingsin Red Hat Linux, seechapter 9, “Using FileMaker Serverin
Red Hat Linux.”

Thefollowing tablelistsall FileMaker Server configuration settings.

Configuration setting

= Set the maximum number of simultaneously connected guests
= Setidle disconnect time and customize the pre-disconnect message

= Require users to be logged on to the same Windows domain in which FileMaker
Server resides

= Set the maximum number of hosted files

= Allocate the amount of memory (RAM) FileMaker Server can use as database
cache

= Set how often database cache is flushed
= Allow single user files to be hosted and shared
= Allow plug-in updates to be downloaded automatically

= Enable runtime files created by FileMaker Developer to be opened automatically by
FileMaker Server

= Enable remote administration and specify a password

= Specify a custom server name that appears in the Hosts dialog box

Configuration setting

= Maximize performance (Mac OS 8.6 to 9.1)

= Specify the network protocol(s) FileMaker Server will use and choose a preferred
IP address

= Enable usage statistics to be recorded in a log and set a maximum size for the log
= Register FileMaker Server with a directory service

= Allow the FileMaker Server administrator’s contact information to be published to
the directory service

= Specify how to authenticate FileMaker Server to a directory server

= Change the LDAP port number

Note The memory requirements of FileMaker Server are directly
related to the number of guests and open files. If you select large
values for these, you should a so increase the amount of RAM
reserved for the database cache. See “ Changing the amount of
memory used by FileMaker Server” on page 6-5 or “Adjusting
memory (Mac OS 8.6 t0 9.1)” on page 6-6 for more details.

Using the configuration assistants
(Windows)

In Windows, FileMaker Server comes with configuration assistants
to help you set up server options. These assistants step you through
the configuration process, giving you helpful instructions along the
way. Y ou can use these assistantsto set up your initial configuration,
and then use the Properties dialog box as described in this chapter to
change settings, if needed.
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To access the assistants:
1. Click the Start button > Programs > FileMaker Server Console.
Y ou see the FileM aker Server Console.

Click FileMaker Server to access

the configuration assistants Click icons to start assistants

ﬂ{ S FileMaker 5 5
Console ervero.
Guests Admin./Networking
Set up guest-related Set up remate
properties B administration and
netwark protacols.
Database Hosting Directory Service Pane
‘ Set up database- 0 Register FileMaker
related properties Server with a
Directory Service
Server Monitoring Task Scheduler
Monitor FileMaker FV)  Create schedules to
Server. back up hosted
Aarahazes _';I
Kl 121 [l | >
I I

FileMaker Server Console (Windows 2000)

2. Click one of theiconsin the right panel to start an assistant.

Opening the Properties dialog box
(Windows)

1. Click the Start button > Programs > FileMaker Server Console.
Y ou see the FileMaker Server console.

2. Select FileMaker Server in the Console Treg, if it's not aready
selected.

3. Choose Action menu > Properties.

Y ou see the Properties dialog box, which has seven tabs: Guests,
Files, File Types, Administration, Networking, Logging, and Directory
Service.

FileMaker Server Properties 21|
Netwoking | Logging | Diectop Sevice |
Guests Fies | FileTypes | Adminisration

Guest connections

Masimum number of simultanzausly connected uests: | 25
o

Maximum idie time allowed:

1200 = {hhimm)

Messags to send before disconnecting

It appears that you hawe been idle for a while.
Please switch to another record to remain
connected

& Default

=
L

€ Custor:

Guest authentication

I~ Requite FileMaker Pro quests to log on to a Windows domain

0k | Concel | appl

Properties dialog box (Windows)

4. Click atab to set options for FileMaker Server configuration. For
configuration details, skip the next two sections and refer to the
remaining sections in this chapter.

Opening the Preferences dialog box
(Mac0S8.6t09.1)

1. Double-click the FileMaker Server icon to start the application. If
FileMaker Server is running, choose Application menu >

FileMaker Server in the upper-right corner of the desktop to bringit to
the foreground.

2. Choose Edit menu > Preferences.

Y ou see adialog box with six tabs: Guests, Files, Administration,
Networking, Logging, and Directory Service.



=————— PfPreferentes 07— ————————
{ Guests '\ [ Files / AdministratinnVNerwnrkingVanqianDirettnry Servite\
Maximum number of simultaneously connected guests: E
[ Disconnect Idle Guests
Maximum idle time allowed: @(hh:mm)
@ Default message: “It appears that you have been idle for a while. Please switch to another record
to remain connected
) Custom message:
=

Preferences dialog box (Mac 0S 8.6 t0 9.1)

3. Click atab to set options for FileMaker Server configuration. For
configuration details, skip the next section and refer to theremaining
sections in this chapter.

Opening the Preferences dialog
(Mac OS X)

1. Double-click the FileMaker Server Config icon to start the
application.

Tip If FileMaker Server isrunning, click the FileMaker Server Config
iconinthe Mac OS X Dock to bring it to the foreground.

2. Choose FMServer Config menu > Preferences.

Y ou see a dialog with seven tabs: Guests, Files, File Types,
Administration, Networking, Logging, and Directory Service.
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Preferences

rGuests ! Files | File Types T Administration T Networking T Logging T Directory Service 1

Maximum number of simultaneously connected guests: 25 E‘
r@Dismnne(( Idle Guests :
| Maximum idle time allowed: 12:00 E‘ (hh:mm) |
@ Default Message: It appears that you have been idle for a while. To remain |
| connected, please switch to another record.
() Custom Message:

P o prerm— o

Restore Settings Cancel 0K

Preferences dialog (Mac OS X)

3. Click atab to set options for FileMaker Server configuration. For
configuration details, refer to the remaining sectionsin this chapter.

Setting the number of guests

Y ou can specify the number of guests who are simultaneously
connected to FileMaker Server. Specifying alower number leaves
more memory available for FileMaker Server to operate.

See appendix B, “Performance and usagetips’ for more information
about memory optimization.

To set the number of FileMaker Pro guests:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Guests tab.

2. Enter anumber for the Maximum number of simultaneously
connected guests option.

The minimum number of guestsis 1 and the maximum is 250.
(AppleTak support islimited to 124 simultaneous guests.)
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For example, if you monitor guest usage over time and notice you
rarely have more than 22 guests active at one time, set this option to
allow 25 guests for best performance on your server.

3. Set any other options, then click OK.

If you increase the number of guests allowed, you must restart
FileMaker Server for the new setting to take effect.

Allowing disconnection of idle guests

FileMaker Server can disconnect guestswho have beenidlefor more
than a specified period of time. Y ou can:

= gpecify the amount of time before idle guests are disconnected

= usethe default disconnect message to warn gueststhat they will be
disconnected, or write a custom message

Note InFileMaker Pro 5.5, you can use apassword privilegeto keep
aguest connected to FileMaker Server when the guest isidle. In
some instances, such as when aguest is also serving as aweb
publishing host, the guest should maintain aconnectionto FileMaker
Server, so that users connecting to the database through a browser
will be able to access the database. For more information, see
FileMaker Pro 5.5 Help.

Setting a time to disconnect idle guests

FileMaker Server can disconnect guests after a specified amount of
idletime.

Tip To avoid being disconnected, guests should periodically show
some activity (for example, move to adifferent record, then click in
one of the fields) when working in databases hosted by

FileMaker Server.

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Guests tab.

2. Select Disconnect Idle Guests.

3. Click the up or down arrow to select the amount of idle time after
which inactive guests should be disconnected. The minimum setting
is 10 minutes and the maximum setting is 24 hours.

4. Set any other options, then click OK.

Setting the pre-disconnect message

Before an idle guest is disconnected from a hosted database,
FileMaker Server sends the guest a message to warn that
disconnection will occur soon. Y ou can send adefault message from
FileMaker Server or you can type your own message.

To customize the pre-disconnect message:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Guests tab, and select Disconnect Idle Guests.

2. Select Custom message, then type a message in the text box.

3. Set any other options, then click OK.

Authenticating guest log on (Windows)

If FileMaker Server isrunning on Windows and is a member of a
Windows NT 4.0 or Windows 2000 domain, you can require that
guests are members of the same domain as FileMaker Server before
they are granted access to a hosted database.

Note Guests attempting to access hosted databases on this server
must be using FileMaker Pro 5.5 to gain access to a database
protected by Windows authentication.

If guests are not already logged on to the same domain as FileM aker
Server when they attempt to open a protected database, they are
prompted for their user name and password for a Windows domain.

Records of al logon attempts are logged in the Windows Security
Log. For more information about the Security Log, see your
Windows documentation.



To require users to be logged on to the same domain in which
FileMaker Server resides:

1. Inthe Properties dialog box, click the Guests tab.
2. Select Require FileMaker Pro guests to log on to a Windows domain.
3. Set any other options, then click OK.

Setting the maximum number of files

Y ou can specify the maximum number of database files

FileMaker Server can open at one time. If you consistently monitor
database usage, you can set the maximum number of files for best
performance on your server. Specifying alower number leaves more
memory available for FileMaker Server. See appendix B,
“Performance and usage tips,” for more information about memory
optimization.

To set the maximum number of files FileMaker Server can host:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Files tab.

FileMaker Server Properties 21|

Netwoking | Logging | Dicctop Sewice |
Guests Files FieTypes | Administration

Hosted files

Specify the masimum number of files to host: | & _,3

Datahase cache

Reserve 4_I:ME of R&M for database cache

I Elush cache every [00: 15— hhimm]

Single User files

™ Allow Filetaker Server to host Single User files

Auto Update

I™ Allow FileMaker Fro guests to download updates automatically

0K | Cancel Apply

Files tab (Windows)
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2. Enter anumber close to the number of files you expect to host on
FileMaker Server.

The minimum setting is 1 file and the maximum is 125.
3. Set any other options, then click OK.

If you increase the number of files allowed, you must restart
FileMaker Server for the new setting to take effect.

Changing the amount of memory used by
FileMaker Server

The operating system sets aside acertain amount of memory for each
application. When you start FileMaker Server, it tells Windows or
the Mac OS how much memory it needs based on itsReserve n MB of
RAM for database cache setting. Increasing the RAM reserved for the
database cache can speed up overall performance, especially if your
server hosts large files or alarge number of guests or files.

Mac OS 8.6 to 9.1: The amount of application memory specified in
the FileMaker Server Info dialog box also affects the operation of
FileMaker Server. For more information, see “ Adjusting memory
(Mac 0S8.6109.1)" on page 6-6.

To change the amount of memory FileMaker Server uses:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click theFiles tab.

2. Enter theamount of RAM you want to alocatein theReserve n MB
of RAM for database cache box.

The minimum setting is2 MB and the maximum is 40 MB.

Important Do not specify more RAM thanisphysicaly availableonthe
server computer. Besureto leaveat least 16 to 32 MB (Windows) or 24
MB (Mac OS) of physical RAM available for the operating system.

3. Set any other options, then click OK.
You must restart FileMaker Server for the new setting to take effect.
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Adjusting memory (Mac 0S 8.6 t0 9.1)

Y our computer sets aside a certain amount of memory for each
application. When you start FileMaker Server, it tells the computer
how much memory it needs.

If you plan to host large database files or alarge number of files, you
can increase the amount of memory (RAM) set aside for
FileMaker Server.

Changing the amount of memory used

To change the amount of memory reserved for FileMaker Server,
keep these pointsin mind:

= FileMaker Server comes configured with 8 MB of memory
(RAM) dlocated to it. This configuration supports the default
number of guests (25) and files (50). Increasing memory can speed
up overall performance, especialy if you areworking with largefiles
or alarge number of guests or files.

= The amount of memory you give to other applications affects the
performance of FileMaker Server. FileMaker Server isdesigned to run
by itself on adedicated computer. By not running other applications, you
can assign all available memory to FileMaker Server.

= Avoid specifying less memory than the Suggested Size in the
FileMaker Server Info dialog box.

= |f you make changesto FileMaker Server preferences while
running FileMaker Server, FileMaker Server asksyouif you want to
automatically adjust the application memory setting in the
FileMaker Server Info dialog box to accommodate the new settings.
If you click OK in the confirmation dialog box, application memory
is adjusted for you. If you click Cancel in the confirmation dialog
box, you should use the following procedureto adjust the application
memory manually.

See appendix B, “Performance and usage tips’ for suggestions for
optimizing memory settings.

To change the amount of memory FileMaker Server uses:

1. If FileMaker Server isrunning, close the application by choosing
File menu > Quit.

2. Select the FileMaker Server application icon.

3. Choose File menu > Get Info > Memory.

[0 === fileMaker Server Info

@ |FiIeMaker Server
T —

Kind: application program

Memory Requirements

Suggested Size: 8192 K
HMinimum Size: [4036 | K
K

Preferred Size: -EIQZ
T

Note: Memory requirements will incraase by 351 K if
wirtual memory is turned off,

Change the amount
of memory
FileMaker Server
uses

[ Locked

4. Double-click the number labeled Preferred Size.

5. Type anumber to change the memory allocated for
FileMaker Server.

6. Click the close box.

The next time you start FileMaker Server, the amount of memory
you specified is used by the application.



FileMaker Server, virtual memory, and physical
memory requirements

FileMaker Server and the virtual memory option (available with
Mac OS 8.6 to 9.1) both use your hard disk to store temporary
information. Virtual memory provides file mapping, which can
improve the performance of FileMaker Server. If you chooseto turn
on virtual memory while FileMaker Server is running, ensure that
you have enough physical memory to satisfy the requirements of
both the Mac OSand FileMaker Server so that virtual memory won't
degrade the performance of FileMaker Server.

To determine how much physical memory you need to use
FileMaker Server with virtual memory turned on:

1. Click the desktop to switch to the Finder.

2. Choose & > About This Computer and note how much memory the
Mac OSisusing.

3. Add thisfigure to the preferred amount of memory to determine
how much physical memory you need for optimal performance of
FileMaker Server with virtual memory turned on. FileMaker Server
requires 8 MB for 25 guests and 50 files.

Setting how often the cache is flushed

FileMaker Server flushes (writes) information stored in the cache
(temporary storage) to disk whenever FileMaker Server isidle, but
you can set the cache to be flushed at specific intervals. If the cache
is flushed frequently, dataintegrity in hosted filesisimproved but
performance may decline.

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Files tab.

2. Select Flush cache every n hours or minutes.
3. Click the up or down arrow to select the time interval.
The minimum setting is 15 minutes and the maximum setting is 2 hours.

4. Set any other options, then click OK.
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Allowing single user files to be hosted

For your convenience, you can set FileMaker Server to host single
user files. This setting lets you host databases without first having to
manually change them to multi-user in FileMaker Pro.

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Files tab.

2. Select Allow FileMaker Server to host Single User files.

3. Set any other options, then click OK.

Allowing software updates to be
downloaded automatically

Y ou can store software updates on the server computer and allow
FileMaker Pro 5.5 gueststo downl oad thesefiles automatically when
they open database files hosted by FileMaker Server 5.5. Examples
of files you can download automatically are plug-in files or plug-in
license files, sometimes required by FileMaker Pro databases.

When aFileMaker Pro fileis hosted using FileMaker Server, any
plug-ins required by the file must exist on each guest computer used
to open the database. By allowing plug-in updates to be downloaded
automatically, you ensure that all guests have access to plug-ins
required by a database the first time they attempt to openit. In
addition, when plug-ins are changed by database devel opers, you can
store new versions on the server computer, so you don’'t have to
update plug-ins on many individual guest computers.

For automatic file downloading to work correctly, you must place
current plug-in files and text files containing plug-in version
information in the correct location on the server computer. In
addition, guests must activate the Auto Update plug-in in the
Application preferences in FileMaker Pro 5.5 before attempting to
open hosted files that require plug-ins.
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To set up FileMaker Server to automatically download software
updates to guest computers:

1. Obtain current plug-in and version control files from your
FileMaker Pro database devel opers.

2. Create afolder named AutoUpdate in the folder that contains the
database that uses plug-ins.

Tip If you host multiple databases that use the same plug-ins, store
updatesin the AutoUpdate folder in the FileMaker Server 5.5 folder,
rather than in individual AutoUpdate foldersin each database folder.
This alows you to store an update in one place on the server
computer, and makes it available for all databases that need it.

3. Placefiles for automatic download in the AutoUpdate folder.

Guest platform  File format

Windows fmx file type for plug-in files
.txt format plug-in version control files
Mac 0S fmxt file typein bin format (MacBinary) for plug-in files

.txt format plug-in version control files

Tip If some guest computers on your network run Windows and
some run the Mac OS, you can include both Windows and Mac OS
versions of the plug-in in the AutoUpdate folder.

4. Inthe FileMaker Server Properties (Windows) or Preferences
(Mac 0S) dialog box, click the Files tab.

5. Select Allow FileMaker Pro guests to download updates automatically.
6. Set any other options, then click OK.

7. Instruct users of guest computersto enable automatic download in
FileMaker Pro 5.5 asfollows: Start FileMaker Pro, choose Edit
menu > Preferences > Application (Windows and Mac OS 8.6 to 9.1)
or FileMaker Pro menu > Preferences > Application (Mac OS X).

8. Click the Plug-ins tab and select Auto Update.

Note FileMaker Pro 5.5 can check the version of plug-in files
required by a hosted database and update plug-insif the current
version is not located on the guest computer. However, FileMaker
Pro cannot verify the version of other downloadable files. If anon-
plug-infileislocated on both the server and guest computers, thefile
on the guest computer is backed up in the Saved System Folder
(Windows) or Saved FileMaker Extensions Folder (Mac OS) and
then the file from the server is placed in the System Folder
(Windows) or FileMaker Extensions Folder (Mac OS).

Opening runtime solutions automatically
(Windows and Mac OS X)

Y ou can have FileMaker Server automatically host runtime solution
files that have been bound using FileMaker Developer 5.x and have
a custom filename extension.

About FileMaker Developer

FileMaker Developer lets database devel opers create and distribute
complete single user database solutions with layouts that are not
modifiable by users.

Runtime solution files typically have unique filename extensions.
For example, rather than the standard .fp5 extension, aruntime
solution file might have the extension .cml. Registering these
runtime solution filename extensions in the FileMaker Server
Properties (Windows) or Preferences (Mac OS) dialog box enables
FileMaker Server to open these files automatically when they are
placed in the same folder as the FileMaker Server application (or
subfolders one level down).

To enable FileMaker Server to open runtime solution files
automatically:

1. In the Properties (Windows) or Preferences (Mac OS X) dialog
box, click the File Types tab.



FileMaker Server Properties 21x|

Metwarking | Lagging | Directory Service |
Gussts | Filss FieTypes | Adminisration

IV Allow FileMaker Server ta open registered runtime solutions

Fiegister the file tupe of each untime solution ——————————————

Mew file type: cmi| Add

Registered file types: Bemove

0k | Cancel Apply

File Types tab (Windows)

2. Select Allow FileMaker Server to open registered runtime solutions.

3. Toregister afilename extension for a runtime solution, type the
extension into the first box, then click Add.

Y ou can register amaximum of 16 filename extensions. Y ou can use
thefollowing wildcard characters when defining filename extensions.

Use this

character To indicate

* Zero or more characters. For example, c* registersall extensions
that begin with c.

? One character. For example, c?p registersall extensions that

begin with c and end with p, and c? registersall extensions that
begin with ¢ and are two charactersin length.

4. To remove afilename extension, select it, then click Remove.

5. Set any other options, then click OK.
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Opening runtime solutions automatically
(Mac 0S 8.6t09.1)

Y ou can have FileMaker Server automatically host runtime solution
files that have been bound using FileMaker Developer 5.x.

About FileMaker Developer

FileMaker Developer lets database devel opers create and distribute
complete single user database solutions with layouts that are not
modifiable by users. Users can purchase and use these databases
without having to obtain full FileMaker Pro licenses for the
computers running the databases.

If runtime solution files were bound using FileMaker Devel oper
running in Mac OS 8.6 to 9.1, they open automatically when
FileMaker Server startsif they are located in the FileMaker Server
5.5 folder (or subfolders one level down).

If runtime solutions files were bound using FileMaker Developer
running in Windows, you must open them using FileMaker Pro 5.x
running in Mac OS 8.6 to 9.1 and then close them before placing
them in the FileMaker Server 5.5 folder (or subfolders one level
down). Thereafter, these solution files open automatically when
FileMaker Server starts.

Enabling remote administration

Using FileMaker Pro 5.x, you can remotely control, or administer,
FileMaker Server from a different computer than the one on which
FileMaker Server isinstalled and hosting databases. After you
enable remote administration, you can use aremote computer to
view alist of hosted databases, and the guests using them, and
monitor performance statistics.
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If you have installed the Server Administration plug-in on your
remote computer, you can also send messages to guests, disconnect
guests, and open or closefilesremotely. For moreinformation about
remote administration tasks, see chapter 7, “Administering
FileMaker Server (Windows and Mac OS).” For more information
about installing the Server Administration plug-in, see

“ Automatically downloading the Server Administration plug-into a
remote computer” on page 7-6.

To enable remote administration of FileMaker Server:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Administration tab.

Preferences

m AdministratinnVNetwurkingVLugqianDirectnry Service\

— Remote inistration
() Disabled

@ Requires no password

() Requires password: ‘ ‘

— Host Name

) System name: “Database Serveri”

@ Custom name:

ITrﬂVEl DB Server I

[J Maximize performance (less CPUtime for other applications)

(]

Administration tab
(Mac 0S86t09.1)

This option, described on page 6-11, is available for
FileMaker Server running in Mac OS 8.6 to 9.1 only

2. Choose one of the following options for remote administration.

Choose To

Disabled Disable remote administration

Requires nopassword  Let any FileMaker Pro 5.x guest remotely view

statistics or control FileMaker Server

Choose To

Requires password Let FileMaker Pro 5.x guests remotely view
statistics or control FileMaker Server only after
entering the password you specify. Passwords are

limited to 31 characters.

If you select Disabled, the FileMaker Server name is dimmed (not
selectable) when FileMaker Pro guests view it in the Hosts dialog
box.

3. Set any other options, then click OK.

Important If you choose to require a password for security reasons,
also remember to restrict access to the server computer. Do not put
the computer in an insecure room.

Windows: Y ou can use Windows administrative tools to password-
protect acomputer. If you do, remember to always log off when
leaving the computer unattended.

To prevent guests from viewing or modifying the data, scripts, and

layoutsin FileMaker Pro, you must create a password in each of the
hosted filesin FileMaker Pro. See*” Protecting fileswith apassword”
on page 6-17 for more information.

Specifying a custom host name

Y ou can specify a host name for the computer running
FileMaker Server that's different from the name registered by the
operating system.When you define a custom name, guests see this
new name when they open the Hosts dialog box in FileMaker Pro
and when they administer FileMaker Server remotely.



Note Guestsconnecting to databases hosted by FileMaker Server might
seethe host name displayed in different ways. IPX/SPX displays names
using only numerals, uppercase characters, underscores (), and
periods (.), and replaces any other characters with underscores.

TCP/IP IPX/SPX (Windows)

Mktg's FileMaker Server  MKTG_S FILEMAKER SERVER

Choose custom and system names carefully to reduce confusion
between different protocals.
To specify the host name that is displayed in the Hosts dial og box:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Administration tab.

2. Choose one of the following options for Host name.

Choose To

System name Have FileMaker Server use the name of the computer in the
Network control panel (Windows), File Sharing control panel

(Mac OS 8.6 t0 9.1), or Sharing preferences (Mac OS X)

Custom name Have FileMaker Server use the custom name you specify

Names are limited to 31 characters.

3. Set any other options, then click OK.

You must restart FileMaker Server for the new setting to take effect.

Maximizing performance
(Mac 0S 8.6t09.1)

Y ou can specify that FileMaker Server uses more CPU (central
processing unit) cycles than any other application installed on your
server computer.
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Important Do not enable this feature unless your server computer is
dedicated to only FileMaker Server and unless FileMaker Server
always runsin the foreground. If you switch to the Finder on a
computer running FileMaker Server in maximum performance
mode, expect Finder response time to be slow.

To maximize performance of FileMaker Server:

1. Inthe Preferences dialog box, click the Administration tab.

2. Select Maximize performance (less CPU time for other applications).
3. Set any other options, then click OK.

4. Select FileMaker Server in the Application menu in the upper-right
corner of the desktop to ensure that it is running in the foreground.

Choosing network protocols

FileMaker Server can host databases using a variety of network
protocols, but TCP/IP is highly recommended.

Network protocol Windows Mac 0S 8.6 t0 9.1 Mac 0S X
TCP/IP Yes Yes Yes
IPX/SPX Yes No No
AppleTalk No Yes No

To choose the network protocols that FileMaker Server uses:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Networking tab.



6-12 FileMaker Server Administrator’s Guide

FileMaker Server Properties 21|

Guests | Fles | FileTypes |  Administation |
Networking |  Logsina | Diectoy Serice
Netwark protocals
« TCRAR
[t

" Baoth TCP /1P and IP% / 5P

IP &ddress

17.184.10.213 [Default] [

0K | Cancel Apply

Networking tab (Windows)

2. Choosethe network protocol (s) you want FileMaker Server to use
when communicating with FileMaker Pro guests.

3. Set any other options, then click OK.

You must restart FileMaker Server for the new setting to take effect.

Setting the preferred IP address

If you have multiple | P addresses, you can specify the one you want
FileMaker Server to use.

Windows and Mac OS X: Each network card in your server
computer hasits own IP address.

Mac OS 8.6 t0 9.1: Apple Open Transport determines the number of
IP addresses available for each network card in your computer.

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Networking tab.

2. Select an IP address from the menu.

3. Set any other options, then click OK.
Y ou must restart FileMaker Server for the new setting to take effect.

Recording usage statistics and
setting size limits

When you enable statistical logging for FileMaker Server, alog file
is created in your FileMaker Server 5.5 folder.

Platform Statistics log name View log in

Windows fmsvplog.txt Performance Monitor (Windows NT)

System Monitor (Windows 2000)

Mac0S86t09.1 Server StatisticsLog Usage Stati stics window

Mac OS X Statistics.log Mac OS X console application

Thelog fileis atab-delimited text file, so you can import it into, or
drag and drop it onto, FileMaker Pro (or any other application that
supports tab-delimited input). Y ou can then examine historical
statistical information about how FileMaker Server is performing.

Windows: Y ou can view information from thislog in the Usage
Stati stics window when you administer remotely, or you can display
it graphically in real-time on your server computer using the
Performance Monitor. For more information about viewing
statistics, see “Viewing usage statistics for FileMaker Server” on
page 7-7 and “Monitoring performance (Windows NT)” on

page 7-17.

Mac OS: Y ou can view information from thislog in the Usage
Statistics window when you administer either remotely or locally.
For more information, see “Viewing usage statistics for
FileMaker Server” on page 7-7 and “Viewing usage statistics
(Mac 0S 8.6t09.1)" on page 7-14.



Tips
= Renaming logs

Windowsand Mac OS 8.6t0 9.1: When FileMaker Server is stopped
and restarted, the existing log file is renamed fmsvplas.txt
(Windows) or Server Last StatisticsLog (Mac OS8.6t09.1). A new
log is created to record information for the current session. To save
statistics for more than two sessions, rename the backup copy of the
log before restarting FileMaker Server or it will be overwritten.

Mac OS X: When Statistics.log reaches its maximum size, it is
renamed Statistics-old.log and a new Statistics.log is created.

= Displaying statistics graphically

Mac OS 8.6 t0 9.1: To display statistical information graphically in
real-time, you can use Apple eventsto transfer information from the
Server Statistics Log to Microsoft Excel. Y ou can then use Microsoft
Excel to chart statistics. For more information about supported
Apple events, see the AppleScript Examples folder inside the
FileMaker Server 5.5 folder.

Windows: Y ou can chart real-time statistics for various aspects of
FileMaker Server performance. See*Monitoring server performance
(Windows)” on page 7-17.

To record usage statisticsin alog file:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Logging tab.
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Preferences

[ Guests Y Files | File Types T Administration T Networking Y Logging Y Directory Service \

— &4 Log Usage Statistics

Collect and update Usage Statistics every f? (mm:ss)

Maximum size of statistics log 1 f? MB
Server will write to the Statistics Log every 1:15:00 (hh:mm:ss)
Maximum size of event log: 1 f:j MB
Restore Settings Cancel F oK :§
Logging tab (Mac OSX)  This option, described on page 6-15, is available

for FileMaker Server running in the Mac OS only

2. Select Log Usage Statistics.

3. For Collect and update Usage Statistics every n option, select atime
interval. The minimum collection interval is 1 second and the
maximum is 5 minutes.

FileMaker Server collects statistical information at the interval you
selected, then writes thisinformation to the log file at the interval
displayed in Server will write to the Statistics Log every n (hh:mm:ss).

Click to change the collection
frequency for usage statistics

Collect and update Usage Statistics every 02:00 E {mm:ss)

[ Log Usage Statistics Statistics are
Maximum size of Statistics Log El Efme written to disk at
Server will write to the Statistics Log every 10:00:00 (hh:mm:ss) —this interval
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The difference between how often datais collected and how often it
iswritten to the log depends on the size of the FileMaker Server
cache. Holding statisticsin the cache rather than writing to thelog at
each collection optimizes performance while still providing useful
and timely statistical information.

4. For Maximum size of Statistics Log, select amaximum sizein
megabytes for the log file. The minimum setting is 1 MB and the
maximum is 40 MB.

5. Set any other options, then click OK.

For information on the types of statistics that are collected in the
Statistics Log, see “Viewing usage statistics for FileMaker Server”
on page 7-7.

Setting a size limit for the Application Log
(Windows NT)

Y ou can set amaximum size for the FileMaker Server Application
Log, which records with a timestamp situations that occur while
FileMaker Server isrunning. Typical eventsthat are logged include
FileMaker Server startup and shut down, database file opening and
closing, guests logging on and off, tasks that execute on schedules,
and changes to FileMaker Server properties.

To set the size of the FileMaker Server Application Log:

1. Click the Start button > Programs > Administrative Tools (Common) >
Event Viewer.

2. Choose Log menu > Log Settings.

3. For Maximum Log size n, select a maximum size in kilobytes for
the FileMaker Server Application Log.

4. Click OK.

Tip Y ou might want to overwrite data when the log is full so you
always have current eventsin the log. For more information, see
“Keeping event data current (Windows)” on page 7-20.

Setting a size limit for the Application Log
(Windows 2000)

Y ou can set amaximum size for the FileMaker Server Application
Log, which records with a timestamp situations that occur while
FileMaker Server isrunning. Typical eventsthat are logged include
FileMaker Server startup and shut down, database file opening and
closing, guests logging on and off, tasks that execute on schedules,
and changes to FileMaker Server properties.

To set the size of the FileMaker Server Application Log:
1. Click the Start button > Programs > FileMaker Server Console.
2. Select Event Viewer (Local) in the Console Tree.

3. Select the FileMaker Server icon in the Details Pane of the Event
Viewer console.

4. Right-click and select Properties.

5. For Maximum Log size n, sel ect amaximum sizein kilobytesfor the
FileMaker Server Application Log.

6. Click OK.

Tip You might want to overwrite data when the log is full so you
always have current eventsin the log. For more information, see
“Keeping event data current (Windows)” on page 7-20.



Setting a size limit for the event log
(Mac 0S)

Y ou can set a maximum size for the Server Event Log (Mac OS 8.6
to 9.1) or Events.log (Mac OS X), which records with atimestamp
situations that occur while FileMaker Server is running. Typical
eventsthat are logged include FileMaker Server startup and shut
down, database file opening and closing, guests logging on and off,
tasks that execute on schedules, and changes to FileMaker Server
preferences.

To set the size of the event log:

1. In the Preferences dialog box, click the Logging tab.

2. For Maximum size of Event Log, select amaximum sizein
megabytes.

The minimum size setting for thelog is 1 MB and the maximum is
40 MB.

3. Set any other options, then click OK.

Using FileMaker Server with a
directory service

If your organization uses a Lightweight Directory Access Protocol
(LDAP)-compliant directory service, such as Microsoft Active
Directory, Netscape Directory, or OpenLDAP, you can centrally
manage your hosted databases by registering FileMaker Server with
your directory service.

When FileMaker Server isregistered with an LDAP-compliant
directory service, its host name and | P address are published to the
directory service. The FileMaker Server administrator’s contact
information can also be published.
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Y our system administrator should be able to give you the
information you need to complete the required directory service
preference settings.

For information about setting up a directory service, see the
Directory Service folder on the FileMaker Server CD.

Registering FileMaker Server with a directory service

Note This feature requires TCP/IP to be the selected network
protocol.

To register FileMaker Server with a directory service:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Directory Service tab.

FileMaker Server Properties 2x

Guests | Files | FleTypes | Adminstation |
Metworking | Logging Directory Service

¥ Register FilsMaker Server with 5 diectory service

Ditectory server pame; | 192.168.0.1
Distinquished name: | cu=Filehlaker,do-myDomain, do-ales

User Authenticati

W Use Windows Authentication
€ Log on as curment user

% Specify

Agcount name; IW
Password: lﬁ—
e T —

Options... | Advanced..
0K | Cancel | spoy |

Directory Service tab (Windows)

2. Select Register FileMaker Server with a directory service.
3. Typethe directory service name (IP address) in the top box.

4. Type the distinguished name in the second box.
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The distinguished name specifiesthelocation of FileMaker Server in
the directory service. For example:
ou=FileMaker,dc=mydomain,dc=Sales

Spaces after commas are optional.

5. Set any other options, then click OK.

Specifying the authentication method (Windows)

To specify how to authenticate FileMaker Server to adirectory
server:

1. In the Properties dialog box, click the Directory Service tab.
2. Select Register FileMaker Server with a directory service.

3. Choose from the following options for user authentication.

Choose To

Use Windows
Authentication

Use the account name and password of a Windows
domain to access Microsoft Active Directory

Logonascurrentuser Log on using the current Windows account, if Use
Windows Authentication is selected

Log onanonymously  Log on without specifying an account name and
password. (This option is not available if Use Windows
Authentication is selected.)

Specify account
name and password

L og on using the account name and password you specify

4. Set any other options, then click OK.

Specifying the authentication method (Mac OS)

To specify how to authenticate FileMaker Server to adirectory
server:

1. In the Preferences dialog box, click the Directory Service tab.

2. Select Register FileMaker Server with a directory service.

3. Choose one of the following options for user authentication.

Choose To

Log onanonymously  Log on without specifying an account name and
password

Specify account
name and password

Log on using the account name and password you specify

4. Set any other options, then click OK.

Publishing your contact information to your
directory service

Asthe FileMaker Server administrator, you can publish your name,
location, phone number, and e-mail address to your directory
service. Thisisuseful if the directory service administrator needsto
contact you if, for example, hosted databases are unavailable for
guest access.

To publish contact information for the FileMaker Server
administrator:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Directory Service tab.

2. Select Register FileMaker Server with a directory service.
3. Click Options.

4. Inthe Options dialog box, enter the contact information you want
to publish.

For example:

If you are using Windows 2000 Active Directory, for the Owner
field:

CN=userl,CN=users,dc=mydomain,dc=filemaker,dc=com

If you are using another LDAPv3-compliant directory service, for
the Owner field:

Marie Durand

5. Click OK.



Changing the port number

The port number setting indicates the type of the port required by
your directory service. Some LDAP-compliant directory services
use a port number other than the default, 389.

To change the port number for your directory service connection:

1. Inthe Properties (Windows) or Preferences (Mac OS) dialog box,
click the Directory Service tab.

2. Select Register FileMaker Server with a directory service.
3. Click Advanced.
4. In the Advanced dialog box, type a number.

Click Default to restore the value to 389, the designated port number
for LDAP.

5. Click OK.

Restoring FileMaker Server
default settings
To restore all default settings:

Windows Mac 0S8.6t09.1 Mac 0S X

Uninstall FileMaker
Server and reinstall it.
See “Uninstalling
FileMaker Server
(Windows)” on

page 2-5.

Quit FileMaker Server, InthePreferencesdialog,
then delete thefiles click the Restore Settings
FileMaker Server5.5Prefs.  button, click OK, then
Thisfileisstoredinthe restart FileMaker Server
Preferencesfolder inside Config.

the System Folder.
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Protecting files with a password

It is especialy important to use the access privilegesin

FileMaker Pro when files are shared on a network. Using
FileMaker Pro, you can restrict what users see and do in a database
file by defining passwords and groups. Passwords limit what users
can do and groups limit the layouts and fields they can see.

Important Protect shared FileMaker Pro 5.x files by using
FileMaker Pro access privileges. Although the shared FileM aker Pro
filesreside on afile server, which may haveits own security scheme,
any files available to FileMaker Pro guests bypass network and file
server protection. For moreinformation about protecting fileswith a
password, see chapter 9 in the FileMaker Pro 5 User’s Guide. See
also FileMaker Pro 5.5 Help for information about using record-by-
record access privileges.

How FileMaker Server behaves during
system sleep (Windows 2000 and Mac OS)

Windows 2000 supports Power Conservation mode, which can cause
your server computer to sleep (hibernate or enter Standby mode),
suspending access to hosted databases.

Computers running the Mac OS can suspend operation when they
enter an energy-saving system sleep state.

FileMaker Inc. recommends that you disable sleep mode on
computers running FileMaker Server.

To prevent your system from sleeping:

= Windows 2000: Disable Hibernation and Standby Mode in the Power
options control panel on the computer running FileMaker Server.
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= Mac OS: Disable system sleep in the Energy Saver control panel
(Mac 0S 8.6 t0 9.1) or Energy Saver preferences (Mac OS X) by
setting the slider control to Never in the Put the system to sleep
whenever it is inactive area.

If sleep is enabled on the computer running FileMaker Server, it's
important to understand how FileMaker Server reacts, should the
computer enter sleep mode:

= |f there are no guests connected to hosted files when the operating
system notifies FileMaker Server that it is going to sleep,
FileMaker Server flushes the cache to disk and leaves hosted
databases open. Because the cache is saved to disk before the
computer sleeps, hosted databases experience no dataloss and are
open when the operating system wakes up.

Note Database backups or scripts scheduled in FileMaker Server do
not run while the operating system is sleeping.

= |f there are guests connected to FileMaker Server when the
operating system notifies FileMaker Server that it is going to sleep,
FileMaker Server responds to the operating system, instructing that
it should not sleep while FileMaker Server is running.

If the operating system shuts down unexpectedly while guests are
connected and before the cache can be written to disk (for example,
because the battery is critically low, the computer is overheating, or
auser turns off the server computer in an emergency),

FileMaker Server attempts to recover the state of hosted files when
it restarts. Asit opens the files located in the FileMaker Server 5.5
folder (or subfolders one level down), FileMaker Server performs a
consistency check on eachfile. If afileisfound to be corrupt,
FileMaker Server logs a corruption event in the Application Log
(Windows 2000) or Server Event Log (Mac OS 8.6 t0 9.1) or
Events.log (Mac OS X).

Important Files that were open but are not located in the
FileMaker Server folder (or subfolders one level down) are not
reopened or checked for consistency.

Whenever FileMaker Server restarts after sleep or aforced
shutdown, you should always check the Application Log (Windows
2000) or Server Event Log (Mac OS 8.6 t0 9.1) or Events.log

(Mac OS X) for database corruption notifications. For more
information about viewing the events, see“Viewing activitiesin the
Event Viewer (Windows 2000)” or “Viewing activitiesin the event
log (Mac OS)” on page 7-20.

Also, check your schedul ed tasksto ensure that important backups or
scripts were not scheduled to run while the operating system was
asleep or off. These tasks will not run until the next scheduled time
when FileMaker Server isrunning and the operating system is
awake.

To find out the last time a scheduled task ran:

1. Click the Start button > Programs > FileMaker Server Console
(Windows 2000) or bring FileMaker Server to the foreground
(Mac 0S).

2. Click Schedules in the FileM aker Server Console Tree (Windows
2000) or choose Window menu > Schedules Window (Mac OS).

3. Look at the time and date displayed in the Last Run column.



Chapter 7
Administering FileMaker Server (Windows and Mac OS)

This chapter provides information about starting and stopping
FileMaker Server and administering hosted files.

Note Forinformation about administering FileMaker Server running
in Red Hat Linux, see chapter 9, “Using FileMaker Server in Red
Hat Linux.”

Starting FileMaker Server (Windows NT)

To start the FileMaker Server service:

1. Placethe FileMaker Pro 5.x filesthat you want FileMaker Server
to open—or shortcuts to those files—in the same folder as
FileMaker Server (or in subfolders one level down).

Up to 125 FileMaker Pro 5.x database files can be automatically
opened when FileMaker Server starts up.

2. Click the Start button > Settings > Control Panel.
3. Double-click the Servicesicon.

S

Services

4. Select FileMaker Server in the list, then click Start.

FileMaker Server opens the FileMaker Pro files for access by
FileMaker Pro 5.x guests on the network.

Services [<]

Starts the FileMaker

st |H—Server service

o |H— Stops the FileMaker
e Server service

LCartinue
Filetaker Pro Server 4.0 Disabled
Filehdsker S erver Marial | .
FTP Publishing Service Stated  Avtomatic ¥ | M Sets FileMaker Server
Hw Profiles.. to start up

Startup Parameters: automatical |y or

[ __tk || manually

Services control panel (Windows NT)

Service Status Staitup

lerter Stated  Automatic =
ClipBook Server Manual
Computer Brawser Stated  Automatic
Content Index Stated  Automatic
DHEP Client Disabled
Directory Replisator Manual
EventLog Stated  Automatic

Note The Services control panel aso lets you change how
FileMaker Server starts. either manually or automatically. If you
want to start FileMaker Server manually when Windows restarts,
click the Startup button, then click Manual. If you want
FileMaker Server to start automatically when Windows restarts,
click the Startup button, then click Automatic.

For information about starting the FileM aker Server servicefromthe
command prompt, see “Using the command line to automate tasks
(Windows)” on page 8-8.

Starting FileMaker Server (Windowvs 2000)

To start the FileMaker Server service:

1. Place the FileMaker Pro 5.x filesthat you want FileMaker Server
to open—or shortcuts to those files—in the same folder as
FileMaker Server (or in subfolders one level down).

Up to 125 FileMaker Pro 5.x database files can be automatically
opened when FileMaker Server starts up.

2. Click the Start button > Programs > FileMaker Server Console.
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3. Select Services (Local) in the Console Tree.
4. Select FileMaker Server in the Details Pane.
5. Choose Action menu > Start.

FileMaker Server opens the FileMaker Pro files for access by
FileMaker Pro 5.x guests on the network.

For information about starting the FileM aker Server servicefromthe
command prompt, see “Using the command line to automate tasks
(Windows)” on page 8-8.

Stopping FileMaker Server (Windows NT)

Stopping the FileMaker Server service disconnects all
FileMaker Pro guests and closes all database files hosted by
FileMaker Server.

Important Stop the FileMaker Server service before shutting down
Windowsto give FileMaker Server adequate timeto aert guestsand
prepare to shut down.

To stop FileMaker Server:
1. Click the Start button > Settings > Control Panel.
2. Double-click the Servicesicon.

S

Services
3. Select FileMaker Server in thelist, then click Stop.

4. Click Yes in the confirmation dialog box if you’ re sure you want
to stop the service.

FileMaker Server gives guests five minutes to close files before
disconnecting them. Guests see a notification dialog box requesting
that they close the files hosted by FileMaker Server.

If guests don't close the files, the dialog box reappears one minute
before the files are closed.

Close File

Message gUeStS See ——t“HQ Database Server” is shutting down, and would like [~
When yOU StOp you to please close the listed files as soon as possible.

FileMaker Server

Files to close: Will attempt
Products automatic close
Line ltems [] in25seconds.)
Clients
Invoices

»

=] Close Now

Shut down natification dialog box on
Mac OS 8.6 t0 9.1 guest computer

After five minutes, FileMaker Server disconnects any remaining
guests and begins closing al open files.

The process of stopping the service and closing the files may take
several minutes.

Stopping FileMaker Server
(Windows 2000)

Stopping the FileMaker Server service disconnects all
FileMaker Pro guests and closes all database files hosted by
FileMaker Server.

To stop FileMaker Server:
1. Click the Start button > Programs > FileMaker Server Console.
2. Select Services (Local) in the Console Tree.

3. Select FileMaker Server in the Details pane, then choose Action
menu > Stop.



Starting FileMaker Server
(Mac 0S 8.6t09.1)

Start FileMaker Server by double-clicking itsicon in the
FileMaker Server 5.5 Folder, or by selecting the icon and choosing

File menu > Open.

FileMaker Server

Application icon

You can also make an diasto start FileMaker Server automatically
each time you start your computer. See the next section for more
information.

Making an alias

Previous versions of FileMaker Server automatically put an alias of
the application in the Startup Items folder of your System Folder.

Important Throw away any aias from a previous version of
FileMaker Server in your Startup Itemsfolder.

To make an dlias for FileMaker Server:

1. In the Finder, select the FileM aker Server iconin the
FileMaker Server 5.5 folder.

2. Choose File menu > Make Alias.
You see an dlias of FileMaker Server in the application folder.

7
Fiialidee Sarver ofidd

Application alias

3. Copy or drag the alias into the Startup Items folder in your
System Folder.
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Quitting FileMaker Server
(Mac 0S 8.6t09.1)

Quitting FileMaker Server disconnectsall FileMaker Pro guests and
closes all database files hosted by FileMaker Server.

To quit FileMaker Server:
1. Choose File menu > Quit.

2. Enter text for disconnection options in the dialog box, or accept
the default settings, and then click OK.

For this option Do this

Message to send Type text you want the guests to see.

Minutes until guests forced  Enter avalue (the default is 5 minutes or the
to disconnect last-entered value).

After you select Quit, you see adiamond next to the command in the
File menu. In the Local Administration dialog box, all databases or
guest names become italicized to show that FileMaker Server is
attempting to disconnect all guests, close al files, and quit.

FileMaker Server will give guests five minutes, or the amount of
timeyou specify inthedialog box, to closefiles before disconnecting
them. Guests see a notification dialog box requesting that they close
the files hosted by FileMaker Server. If guests don't close thefiles,
the dialog box reappears one minute before the files are closed by
FileMaker Server.

It might take FileMaker Server several minutesto complete the
quitting process.

Starting FileMaker Server (Mac OS X)

FileMaker Server running in OS X has two components: the
configuration application, called FileMaker Server Config, and the
server application. They are started (and stopped) separately.
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Y ou can also make an aliasto start FileMaker Server Config
automatically each time you start your computer. See the next
section for more information.

Making an alias for FileMaker Server Config

Note Youcanmakeanaliasfor FileMaker Server Config, but not for
the server itself.

To make an alias for FileMaker Server Config:

1. Inthe Finder, select the FileMaker Server Configiconin the
FileMaker Server 5.5 folder.

2. Choose File menu > Make Alias.

You see an dlias of FileMaker Server Config in the application

folder.
3

Application alias
3. Inthe Login Items pane of the Login preferences, click Add.
4. Navigate to the alias you just made and click Open.

5. Close the Login preferences window.

Starting the FileMaker Server application (Mac OS X)

1. Place the FileMaker Pro 5.x files that you want FileMaker Server
to open inthe samefolder as FileMaker Server (or in subfolders one
level down). Add an extension to afilenameif it does not have one.

Up to 125 FileMaker Pro 5.x database files can be automatically
opened when FileMaker Server starts up.

2. Inthe FileMaker Server window, click the Start Server button.

Quitting FileMaker Server (Mac OS X)

FileMaker Server running on OS X has two components: the
configuration application, called FileMaker Server Config, and the
server application. They are stopped (and started) separately.

Quitting the FileMaker Server Config application

To quit the FileMaker Server Config application, choose FMServer
Config menu > Quit FMServer Config.

Stopping the FileMaker Server application (Mac OS X)

Stopping the FileMaker Server application disconnects all
FileMaker Pro guests and closes all database files hosted by
FileMaker Server.

To stop FileMaker Server, click the Stop Server button in the
FileMaker Server window.

Guests see a notification dialog requesting that they close the files
hosted by FileMaker Server. If guestsdon't closethefiles, thedialog
reappears before the files are closed by FileMaker Server.

It might take FileMaker Server several minutes to complete the
quitting process.

Using remote administration

Y ou can use FileMaker Pro 5.x to view information about guests and
control database files hosted by one or more servers from adifferent
computer than the one running FileMaker Server. This processis
called remote administration.

Mac OS 8.6 t0 9.1: Y ou can a'so control the hosted files and guests
using the same computer that’s running FileMaker Server. This
process, using FileMaker Server 5.5, is called local administration.



The remote administration capability in FileMaker Server is
provided through three FileM aker Pro 5.x databases. These
databases are created in the server computer’ s temporary directory
when you enable remote administration:

= inthe Administration tab of the properties (Windows) or Preferences
(Mac OS) dialog box

= with the UseRemoteAdmin preference parameter (Red Hat Linux)

= when you start FileMaker Server (if remote administration is
already enabled)

The databases are created in a subdirectory named Remote
Administration, which appears as an active folder when you view the
Folders tab of the Remote Administration window. Likewise, the
remote admini stration databases appear when you view theFiles tabin
the Remote Administration window. However, the remote
administration databases do not appear in the Hosts dialog box when
you use FileMaker Pro 5.x to view hosted files on your server
computer.

The names of the remote administration databases contain the name
of the FileMaker Server computer. The computer name is truncated
if it exceeds 31 characterswhen combined with the name of aremote
administration database. This name defaults to the computer’s
system name, but you can change the name displayed in the Hosts
dialog box using the Administration tab of the Properties (Windows)
or Preferences (Mac OS) dialog box or in the CustomServerName
preference parameter (Red Hat Linux).

For example, if your FileMaker Server computer is named Database
Server, you see the following filenames:

= Database Server_Admin
= Database Server_Usage

= Database Server_Data
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If you disableremote administration in FileM aker Server or you stop
or quit FileMaker Server, the remote administration databases are
removed from the server computer. If remote administration is
enabled in the Administration tab of the Properties (Windows) or
Preferences (Mac OS) dialog box or in the UseRemoteAdmin
preference parameter (Red Hat Linux), when you restart

FileMaker Server, the remote administration files are recreated.

Important

Windows and Mac OS X: Do not use the remote administration
capability in FileMaker Pro 5.x on the server computer to administer
FileMaker Server.

Mac OS 8.6 t0 9.1: Y ou can administer FileMaker Server by using
the remote administration capability in FileM aker Pro 5.x or thelocal
administration capability in FileMaker Server.

When you administer FileMaker Server remotely, your
administration capabilities are limited depending on whether or not
the Server Administration plug-in for FileMaker Proisinstalled on
the remote computer.

If the Server Administration plug-in is not installed on the remote
computer, you can:

= view alist of foldersthat contain database files hosted by
FileMaker Server

= view alist of database files hosted by FileMaker Server and the
number of guests connected to each

= view alist of al guests and the database files that they are
connected to

= view usage statistics for FileMaker Server

If the Server Administration plug-inisinstalled on the remote
computer, you can aso:

= open FileMaker Pro files for access by FileMaker Pro guests
through FileMaker Server
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= close files hosted by FileMaker Server

= disconnect a selected FileMaker Pro guest from one or all hosted
files

= send messages to guests of hosted files

= display detailed information about hosted files and guests

Automatically downloading the Server Administration
plug-in to a remote computer

To automatically download the Server Administration plug-into a
remote computer:

1. Inthe FileMaker Server Properties (Windows) or Preferences
(Mac 0S) dialog box, click the Files tab and Select Allow FileMaker
Pro guests to download updates automatically.

Red Hat Linux: Enable the UseAutoUpdate preference parameter.
For more information, see “ Enabling Auto Update in FileMaker
Server” on page 9-8.

2. Inthe FileMaker Server Properties (Windows) or Preferences
(Mac 0S) dialog box, click the Administration tab and enable remote
administration.

Red Hat Linux: Enable the UseRemoteAdmin preference parameter.
For more information, see “ Enabling remote administration in
FileMaker Server” on page 9-10.

3. Instruct users of guest computersto enable automatic download in
FileMaker Pro 5.5 asfollows: Start FileMaker Pro, choose Edit
menu > Preferences > Application (Mac OS 8.6 t0 9.1)

or FileMaker Pro menu > Preferences > Application (Mac OS X).

4. Click the Plug-ins tab and select Auto Update.

When you open the Remote Administration window, the Server
Administration plug-in is downloaded to the remote computer and
automatically enabled in FileMaker Pro.

Note You caninstall the Server Administration plug-in manually, if
you want. See chapter 10, “Manually installing the Server
Administration plug-in on aremote computer.”

For moreinformation about automatically downloading plug-ins, see
“Allowing software updates to be downloaded automatically” on

page 6-7.

Opening the Remote Administration window

Note FileMaker Pro 5.x must be installed on the remote computer
before you can administer FileMaker Server remotely.

To administer FileMaker Server remotely:

1. Log on to a Windows client computer or a computer running the
Mac OS located on the same network as your FileMaker Server
computer.

2. Click the Start button > Programs > FileMaker Pro 5.x (Windows) or
double-click the FileMaker Pro 5.x application icon (Mac OS).

3. Choose File menu > Open, and then click Hosts.

4. Select the name of your FileMaker Server in thelist of hosted
databases, then click Open.

Tip Forinformation on changing the namethat appearsinthelist, see
“ Specifying a custom host name” on page 6-10.

5. Type the remote administration password, if you are prompted to
enter it.

Y ou see the FileMaker Server Remote Administration window.
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FiteMaker Server

For remote administration details, refer to thefollowing sections. For
information about getting onscreen Help for the Remote
Administration window, see “ Getting help while administering
FileMaker Server remotely” on page xii.

Listing hosted files and current guests

Remote administration gives you several waysto list information
about hosted databases and the guests accessing them.

Click a tab to display a different
view of databases or guests
| ]
Remote Administration
/7 Foldes N\ Files N/ Gusts N\

Guest Connecttime Idle time

Clients
Invoices
Line lems
Praducts
B Fatrick Murphy 336 0.00
¥ Sophis Tang A0z 402
Froducts
Toure

Foldars: 2 Files: 8 Guests: 3
[ Open File.. I Disconnect Guest... I Send Message... |

Get Datails.. Send Mesrage to All...
FileMaker Server
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Click thistab  Tosee

Folders A list of folders on the computer running FileMaker Server
that contain hosted databases and the number of databasesin
each folder. Click I- to display the databasefileslocated in a
folder.

Files A list of the database files hosted by FileMaker Server,
regardless of which folder they are located in. Also included
isthestatus (for example, Closing, Pausing, Paused, Disk Full, or
Exclusive) and the number of guests connected to each
database. For more information about Exclusive status, see
“Determining if you have exclusive access to
hosted databases’ on page 7-12.

Guests A list of FileMaker Pro guests logged onto the database files
hosted by FileMaker Server. Also included is the length of
time guests have been connected and their inactivetime. Click
k- next to guest namesto view alist of databasesthat they are
connected to.

Tips
= You can see asummary of al folders containing databases, the

number of al databases, and the number of all guestsjust below the
list no matter which tab is displayed.

= You can sort information in columns by clicking the column
heading. The triangle in the selected column heading indicates the
sort order: up for ascending (A—Z, 0—n, or shortest tolongest for time
durations) or down for descending (Z-A, n-0, or longest to shortest
for time durations).

= Mac 0S8.6109.1: To view database and guest information while
working on the server computer, see*Listing hosted files and guests
(Mac 0S8.61t09.1)" on page 7-13.

Viewing usage statistics for FileMaker Server

When you administer remotely, you can display usage statistics, such
as how FileMaker Server is performing and how many guests are
logged into FileMaker Server.
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To display usage statistics for FileMaker Server, click Usage in the
Remote Administration window.

Y ou see the Usage Statistics window.

Click to reverse the sort order

\
Type II Current I Average I Peak
Transactions 4 1] 11
Network KBisec
Guests
Files
Disk KB/sec
Cache Unsaved %
Cache Hit %

Slo|=|m|w|la

=]

Ju]
3
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Ju]
Ju]
ol

oo fo|m|w|s

=]

The following statistics are listed in the Usage Statistics window:

Statistic Description

Cache Unsaved % Percentage of cachethat iscurrently unsaved. Thisshould be
arelatively low number, such as 0 or 5, so you won't lose
dataif you experience a system crash. If the number is
consistently high, consider increasing the frequency with
which the cacheis flushed.

Cache Hit % Percentage of the times FileMaker Server retrieved data
from the cache (RAM) rather than the hard disk. Reading
datafrom RAM is much more efficient than reading it from
the hard disk, so this value should be ahigh number, like 90
or 95. If itisn't, you might need to allocate more memory to

the FileMaker Server database cache.

Statistic Description

Transactions/ Number of guest requests handled per second.

second

Network Amount of data being moved across the network or to and

(Kbytes/sec) from disk. Datais measured in KB unlessnetwork activity is
greater than 10 MB per second. In that case, the value
displayed represents MB per second.

Guests Number of connected guests. Use this information to help
configure the Allow up to n simultaneously connected guests
option (Windowsand Mac OS) or the MaxGuests preference
parameter (Red Hat Linux).

Files Number of open databases. Use thisinformation to

configure the Maximum number of files to host option
(Windows and Mac OS) or the MaxFiles preference
parameter (Red Hat Linux).

Disk (Kbytes/sec) Amount of data being written to disk. Datais measured in
KB unless data written to disk is greater than 10 MB per
second. In that case, the value displayed represents MB per
second.

By default, FileMaker Server updates the statisticsin the Usage
Statistics window every 15 seconds or less but no more than once a
second. Although this reduces the overhead required to cal culate the
statistics, it means the statistics are approximations of how
FileMaker Server is using resources.

Windows and Mac OS: For information about where usage statistics
are stored and how to display them in a chart, see“Recording usage
statistics and setting size limits’ on page 6-12.

Mac OS 8.6 t0 9.1: To view usage statistics while working on the
server computer, see “Viewing usage statistics (Mac OS 8.6t0 9.1)”
on page 7-14.

Tip In Mac OS 8.6 t0 9.1, you can also collect usage statistics
information by using Apple events. For more information about
Apple events, see the AppleScript Examples folder inside the
FileMaker Server 5.5 folder.

Hosting FileMaker Pro 5.x files

Important FileMaker Server 5.5 supports only FileMaker Pro 5.x
databases. Therefore, any databases you have from a previous
version of FileMaker Pro must be converted to FileMaker Pro 5.x
format before you can host them using FileMaker Server 5.5.



When FileMaker Server starts, it automatically opens or hosts all
multi-user filesinthe FileMaker Server 5.5 folder including thosein
subfolders onelevel down. It also openssingle user files, if you have
enabled the Allow FileMaker Server to host Single User files optionin the
Files tab of the Properties (Windows) or Preferences(Mac OS) dialog
box or the HostSingleUserFiles preference parameter (Red Hat
Linux). For more information, see “ Allowing single user filesto be
hosted” on page 6-7. Don't use personal file sharing to share
FileMaker Pro files.

Note To open database fileswhile administering remotely, you must
have the Server Administration plug-in for FileMaker Pro installed
on the remote computer. See “ Automatically downloading the
Server Administration plug-in to a remote computer” on page 7-6.

To open files remotely while FileMaker Server is running:

1. In FileMaker Pro, click Open File in the Remote Administration
window.

You see adialog box with alist of FileMaker Pro 5.x files available
for hosting, organized by folder.

2. Choose a database in the Select a database file or folder list, then
click OK.

FileMaker Server opens thefile, and the database name appearsin
thelist in the Remote Administration window (if you are viewing
database information in the list).

If you selected afolder, FileMaker Server opensall of thefilesin that
folder.

Tips
= Windows: Y ou can open afile by dragging a FileMaker Pro 5.x

fileicon and dropping it on the FileMaker Server application icon
(fmserver.exe), if the FileMaker Server service isaready running
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= Mac OS 8.6 t0 9.1: You can open afile by dragging a
FileMaker Pro 5.x file icon onto the FileMaker Server application
icon or onto the local administration window.

= Windows: Y ou can open afile by using the command prompt. See
“Using the command line to automate tasks (Windows)” on page 8-8
for more information.

= Mac OS: You can use Apple events to open files. To host files
while working on the server computer, see “Hosting FileMaker Pro
5.x files(Mac OS 8.6 t0 9.1)" on page 7-14. For more information
about Apple events, see the AppleScript Examples folder inside the
FileMaker Server 5.5 folder.

= |f you are hosting large numbers of files or guests, you might
improve Remote Administration performance by increasing the
FileMaker Pro cache size. For more information, see the
FileMaker Pro 5 User’s Guide.

= You can use the Multi-User (Hidden) command in

FileMaker Pro 5.x to prevent subordinate related files from
appearing in the Hosts dialog box. For more information, see the
FileMaker Pro 5 User’s Guide.

= Mac OS X: Add an extension to afilenameif it does not have one.

Closing hosted files
To close a database and disconnect any guests accessing it:

1. In the Remote Administration window, choose the Folders or Files
tab (if it's not already selected) to display alist of open databases.

2. Select afileor folder in thelist.
3. Click Close File.

Y ou see the Close File dialog box with the name of thefile or folder
to be closed in thetitle bar.
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Close file "Products"

Message to send!

Type your message here

Enter the number of minutes
until FileMaker Server will Minutes until guestts) forced to disconnect:

disconnect guests ——z [ cancel | [ ok

4. Enter text for the optionsin the dialog box, or accept the default
message and settings.

For this option Do this

Message to send Type text you want the guests to see in addition to the
standard FileMaker Pro message (asking gueststo close

the databasefile).

Minutes until guest
forced to disconnect

Enter avalue (the default is 5 minutes or the
|ast-entered value).

5. Click OK.

If the Files tab is displayed, the Status of the files being closed
changesto indicate that FileMaker Server has begun closing files.

Guests see a notification dialog box with your message requesting
they closetheir connection to afile. If guestsdon’t close thefile, the
message repeats approximately one minute beforethefileisset to be
closed by FileMaker Server.

When the set time elapses, FileMaker Server disconnects any
remaining guests and closes thefile or filesin the folder. Thefile or
folder name no longer appears in the Remote Administration
window.

Completing the process of closing afolder, alarge databasefile, or a
file with many connected guests may take several minutes.

Tips
= Mac OS: To close fileswhile working on the server computer, see
“Closing hosted files (Mac OS 8.6 t0 9.1)” on page 7-15.

= Mac OS: You can also close files using Apple events. For more
information about Apple Events, see the AppleScript Examples
folder in the FileMaker Server 5.5 folder.

= Windows: Y ou can also close files from the command line. See
“Using the command line to automate tasks (Windows)” on page 8-8
for more information.

Disconnecting guests
To disconnect a guest from a hosted database:

1. In the Remote Administration window, select the guest to
disconnect.

Click And select To

Guests The guest’ s name Disconnect the selected guest

from all databases

Guestsguestname  The database fileunder ~ Disconnect the guest from the
theguest’snameinthelist selected database

Files filename The guest’ s name under

the database in the list

Disconnect the selected guest
from aparticular database

2. Click Disconnect Guest.

Y ou see the Disconnect Guest dialog box with the name of the guest
to be disconnected in thetitle bar.

3. Enter text for the optionsin the dialog box, or accept the default
settings.

For this option Do this

Message to send Typetext you want the guest to seein addition to the

standard FileMaker Pro message (the default).

Minutes until guestforced Enter avalue (the default is 5 minutes or the last-
to disconnect entered value).




4. Click OK.

The selected guest sees a notification dialog box with your message
requesting that the guest disconnect from the server. If the guest
doesn’ t disconnect, the message repeats approximately one minute
before the guest is set to be disconnected.

When the set time elapses, FileMaker Server disconnects the guest
and the guest’ s name disappears from the Remote Administration
window.

Mac 0OS8.6t0 9.1: To disconnect guestswhileworking on the server
computer, see “Disconnecting guests (Mac OS 8.6 t0 9.1)” on
page 7-16.

Viewing detailed information about hosted files
and guests

If you havethe Server Administration plug-ininstalled on theremote
computer, you can use FileMaker Pro 5.x to view detailed
information about hosted files and the guests that are currently
connected to them. For each hosted database, you can display:

= the name of thefile

= the number of guests connected to it
= the number of recordsit contains

= the number of layoutsit has

= jtscurrent sizein bytes

= file status: Normal (active), Closing, Pausing, Paused, Nearly full,
Exclusive by username. For more information about the Exclusive
status, see “ Determining if you have exclusive access to

hosted databases’ on page 7-12.

For each guest, you can display:

= the name of the guest

= the network protocol that the guest is using
= the guest’s network address
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= the number of files the guest is currently connected to

= the length of time in days, hours, and minutes that the guest has
been connected

= thelength of time in days, hours, and minutes that the guest has
beenidle

= guest status: Normal or Closing

To display detailed information about hosted files and guests:
1. Select afile or guest in the Remote Administration window.
2. Click Get Details.

Y ou see the Get Details dialog box showing detailed information for
thefile or guest.

Get details for guest "Mary Smith"

MName: Mary Smith
Frotocal: TCRIP

. . . Address: 17.184.11.241
Detailed information —— [Fiies: ¢

about your selection Connectlime: 404

Idle time: 4:03
appears here

Status: Mormal

Refresh | [ cancel

Sending messages to guests
To send amessage to one or more guests:
1. In the Remote Administration window, make a selection.

Select To send a message to

A databasefile All guests of the database

A folder Guests of the databases in the folder
A guest One guest

2. Click Send Message.

Y ou see the Send Message dia og box with the name of the selected
recipient(s) in thetitle bar.
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Send message to guest "Sophie Tang"

Message to send

Type your
message here

cancel | | OK

3. For Message to send, type your message, and then click OK.
FileMaker Server sends the message to the selected recipient(s).

Windows and Mac OS X: Y ou can aso send a message to guests
whileworking on the server computer by scheduling a Send M essage
task. For more information, see chapter 8, “ Scheduling
administrative tasks (Windows and Mac OS).”

Mac OS 8.6 t0 9.1: To send a message to guests while working on
the server computer, see “ Sending messages to guests (Mac OS 8.6
t0 9.1)” on page 7-16.

Sending messages to all guests

To send amessage to all guests currently accessing any hosted
databases:

1. In the Remote Administration window, click Send Message to All.
Y ou see the Send Message to all guests dialog box.

2. For Message to send, type your message, then click OK.

Determining if you have exclusive access to
hosted databases

Although you can use FileMaker Pro to make some changesto the
structure and layout of databasesthat are hosted by FileMaker Server,
you can’'t change field definitions unless you have exclusive accessto a
database. When you have exclusive access, no other guestsare connected
to the database. Exclusive access enables you to change field definitions
without first having to close the database in FileMaker Server.

To find out if you have exclusive access to a hosted database:

1. In the Remote Administration window, click the Files tab to
display all hosted databases.

For more information, see “ Opening the Remote Administration
window” on page 7-6.

2. Select the database that you want exclusive access to, then click
Get Details.

If you have exclusive access, the Get details for filename dialog box
lists you as the only guest connected to the selected database.

If you don’t have exclusive access, FileMaker Pro providesaway for
you to notify other guests and gain exclusive access to the database
without using FileMaker Server messaging. For more information,
see FileMaker Pro Help.

Using local administration
(Mac 0S86t09.1)

If you're running FileMaker Server in Mac OS 8.6 t0 9.1, you can
perform most of the administrative activities described in the
previous sections in this chapter from the computer running the
server software. However, the steps you follow are different. In
addition, you can perform many administrative tasks using Apple
events both from thelocal computer or aremote computer. For more
information about Apple events, see the AppleScript Examples
folder inside the FileMaker Server 5.5 folder.

Opening the local administration window

(Mac 0S8.6109.1)

To open the FileMaker Server local administration window:
1. Start FileMaker Server.

2. Choose Window menu > Administration Window.

Y ou see the FileM aker Server administration window.
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Listing hosted files and guests (Mac OS 8.6 t0 9.1)

The local administration window lists hosted databases and the
guests who are using them. Y ou can choose to display information
by folder, files (databases), or guest.

Click a tab to display a different

Click a column heading to sort the list
view of databases or guests

by that column. Sort order is indicated
by the triangle above the scrollbar

0= laker Server “Travel DB Server” ——— BEIH
[ Folders \ /Files \ / Guests
CI kt Guest [ Protocol | aadress | connect time] 1z time H— ClICk to reverse the
—{= Sophis Tan TCPAP 1718418132 3:21 21 B
Ickto e sort order of the list
expand or rours based on the
collapse alist | e s s 3 selected column
Imvoices
Ling Items
b Patrick Murphy  TCRAP 17.184.11.81 255 254
Click thistab  Tosee
Folder A list of the database files hosted by FileMaker Server

grouped by the folder in which they reside. Also included is
the number of filesin each folder.

Files A list of the database files hosted by FileMaker Server. Also
included is the status (Open, Opening, Closing, Backing up,
Pausing, Paused, Disk Full, or Exclusive) and the number of
guests connected to each database.
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Click thistab  Tosee

Guests A list of FileMaker Pro guests accessing the database files
hosted by FileMaker Server. Also included is the network
protocol used by each guest, each guest’s network address,
length of time guests have been connected, and their inactive

time.

Sorting and resizing columns (Mac OS 8.6 t0 9.1)

You can sort information in alist by column or you can change the
width of acolumn to display more text.

To sort itemsin alist, click a column heading.

The column heading darkens and the triangle control above the
scrollbar indicates the current sort order of the selected column.

This symbol Indicates the selected column is sorted in

E Ascending order (A—Z, 0—n, or shortest to longest for time
durations)

E Descending order (Z-A, n-0, or longest to shortest for time
durations)

To reverse the sort order in the selected column, click the triangle
control.

The sort order in each tabbed screen is retained when you click
between Folders, Files, and Guests.

To unsort theligt, click the heading of the sorted column to desel ect
it.

To resize the width of a column, place the pointer over a column
heading border. When the pointer changesto 4+, dragit horizontally.



7-14 FileMaker Server Administrator’s Guide

Selecting information in scrolling lists (Mac 0S 8.6 t0 9.1)

The following table describes keyboard shortcuts for selecting
information in scrolling lists.

Use this shortcut To do this

Click an entry Select arow

Double-click an entry Switch to thetab for that entry and scroll to display the
selected entry in the new tabbed screen. For example,
if you double-click afilename in the Folders tab, the
display changesto the Files tab and scrollsto show the
file.

Shift-click another entry  Extend the current selection

88-click another entry Deselect theentry, if it was selected, or select theentry
without including entries between it and your original

selection

T Select the row above the current selection

3 Select the row below the current selection

Shift-1 or Shift-, Extend the current selection

8-Tord-| Select thefirst or last entry in alist

8-> Expand the details displayed under the current
selection

8-« Collapse the details displayed under the current
selection

Page Up key Scroll up

Page Down key Scroll down

Home key Scroll to the top of thelist

End key Scroll to the bottom of the list

Viewing usage statistics (Mac 0S 8.6109.1)

Use the Usage Statistics dialog box to view usage statistics, such as
how FileMaker Server is performing and how many guests are
connected to hosted databases.

To display usage statistics, in FileMaker Server choose
Window menu > Usage Statistics.

Y ou see the Usage Statistics window.

]

Usage Statistics ——H

Value Curren t  Average FPeak
Transactions fsecond o o 1
Metwork (Kbytes/sec] o o 1
Disk (Kbytes/z2c) 0 0 2
Cache Hit 7% 100 100 100
Cache Unsaved % o o o
Files ] ] ]
Guests E E E

For information about the statistics displayed, see “Viewing usage
statistics for FileMaker Server” on page 7-7. For information about
where usage statistics are stored and charting them, see “Recording
usage statistics and setting size limits’ on page 6-12.

Hosting FileMaker Pro 5.x files (Mac 0S 8.6t0 9.1)

When FileMaker Server starts, it automatically opens or hosts all
multi-user filesin the FileMaker Server folder (and subfolders one
level down).

Important

= FileMaker Server 5.5 supports only FileMaker Pro 5.x databases.
Therefore, any existing databases you have from a previous version
of FileMaker Pro must be converted to FileMaker Pro 5.x format
before you can host them using FileMaker Server 5.5.

= Don't use personal file sharing to share FileMaker Pro files.
To host database files using the local administration window:
1. In FileMaker Server, choose File menu > Open File.

Y ou see the Open dialog box.



Open =
(5] EveryWhere Travel E
Clients Today =
Invoices Today
Ling tems Today
Select one or Totay
more databases Totay
you want to open
Ce )
7

2. Select one or more database files you want to host, then click
Open.

The database files appear in the Folders tab of the administration
window.

BE

[0 === rileMaker Server “Travel DB Server”

Folders Files Guests

Humber of files
= EveryWhere Travel 1

T fm

Products
[» Remote Administration 3

2

-

5

»
S

ks AppleTalk; TCF/IF

Tips
= Alternatively, you can drag one or more database files onto the
FileMaker Server administration window to open them for guest access.

= FileMaker Server can open files set to Single User in FileM aker
Pro, if you have enabled the Allow FileMaker Server to host Single User
files option. For more information, see“Allowing single user filesto
be hosted” on page 6-7.

= You can use the Multi-User (Hidden) command in

FileMaker Pro 5.x to prevent subordinate related files from
appearing in the Hosts dialog box. For more information, see the
FileMaker Pro 5 User’s Guide.
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= Y ou can Shift-click additional filesin the Open dialog box to open
more than one file at atime.

Closing hosted files (Mac 0S 8.6t09.1)

To close a hosted database and disconnect any guests currently
accessing it:

1. InFileMaker Server, choose Window menu > Administration
Window to display thelist of currently hosted files.

2. Select adatabase filein the list that you want to close.

Tip You can Shift-click additional databasesin thelist to close more
than one at atime. If you are viewing databases by folder, you can
select onefolder to close all filesin it or Shift-click an assortment of
files and folders to close them.

3. Choose File menu > Close File.
Y ou see the Close selected files/folders dialog box.

Close selected files/folders

Message to send:

Type your
message here

Specify how long Minutes until guests forced to disconnect:

guestshaveto ——z |
(—

disconnect before
the file will be closed

4. Enter text for the optionsin the dialog box, or accept the default
message and settings.

For this option Do this

Type text you want the guests to see in addition to the
standard FileMaker Pro message (asking gueststo close
the database file).

Message to send

Enter avalue (the default is 5 minutes or the
|ast-entered value).

Minutes until guests
forced to disconnect
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5. Click OK.

Thefile or folder name in the list changes to italicized text to show
that FileMaker Server is closing thefile.

Guests see a notification dialog box with your message requesting
they close their connection to the file. If guests don’t close thefile,
the message repeats approximately one minute before thefileis
closed by FileMaker Server.

When the set time elapses, FileMaker Server disconnects any

remaining guests and closes thefile or filesin the folder. Thefile or
folder name no longer appears in the local administration window.

Completing the process of closing afolder, alarge databasefile, or a
file with many connected guests may take several minutes.

Disconnecting guests (Mac OS 8.6 t0 9.1)
To disconnect a guest of a hosted database:

1. In FileMaker Server, choose Window menu > Administration
Window.

2. Click the Guests tab to display alist of guests who are currently
connected to hosted databases.

3. Select aguest that you want to disconnect from hosted databases.

Tip You can Shift-click additional guestsin the list to disconnect
more than one at atime.

4. Choose File menu > Disconnect Guest.
Y ou see the Disconnect selected guests dial og box.

Disconnect selected guests

Message to send:

Type your
message here

Enter the number of minutes
until FileMaker Server—
disconnects guests

Minutes until guests forced to disconnect:

=

5. Enter text for the optionsin the dialog box, or accept the default
settings. For more information about disconnection options, see
“Disconnecting guests’ on page 7-10.

6. Click OK.

The guest namein the list changes to italics to show that
FileMaker Server is attempting to disconnect the guest.

7. The selected guest sees a notification dialog box with your
message requesting that the guest disconnect from the database. If
the guest doesn'’ t disconnect, the message repeats approximately one
minute before the guest is disconnected.

8. Whentheset time elapses, FileM aker Server disconnectsthe guest
and the guest’ s name disappears from the Guests tab in the
administration window.

Sending messages to guests (Mac 0S 8.6t09.1)
To send amessage to one or more guests:

1. In FileMaker Server, choose Window menu > Administration
Window.

2. Inthe Administration window, make a selection.

Select To send a message to

A databasefile All guests of the database

A folder Guests of the databases in the folder
A guest One guest
Nothing All guests

Tip You can Shift-click additional guests to send your message to a
group of specific guests.

3. Choose File menu > Send Message.
Y ou see the Send Message to selected guests dialog box.



Send Message to selected guests

Message to send:

Type your
message here

(Comer] 5]

4. In the Message to send box, type your message, then click OK.
FileMaker Server sends the message to the selected recipient(s).

Monitoring server performance (Windows)

Y ou can monitor usage statistics from the server computer using the
Performance Monitor (Windows NT) or System Monitor
(Windows 2000).

Monitoring performance (Windows NT)

Using the Windows Performance Monitor, you can chart real-time
statistics for various aspects of FileMaker Server performance.

To view FileMaker Server statisticsin the Performance Monitor:
1. Start the FileMaker Server service, if itis not already running.

2. Click the Start button > Programs > Administrative Tools (Common) >
Performance Monitor.

3. Choose Edit menu > Add To Chart.
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Name of the server Click to add a selected
you are monitoring counter to your chart
Add to Chart [ x]
Choose Lomputer. |\\DATAEASE75EHVEH _| Add |
FileMaker Server ——— ([m— =] nstence: Bone_|
Count = Expléin:>
Select | e Lo
5 D atah;
FileMaker Server acheee _t |
Guest:
b micat- B -
toyour chart  color w2 Scal: [Detaur =] it =l swe| — =]

Click to see your chart

4. For Object, choose FileMaker Server.

5. For Counter, choose the FileMaker Server statistics that you want
to track, then click Add after each selection.

Tip Transactions, Network KB/sec, Disk KB/sec. Cache Hit %, and Cache
Unsaved % give you the most information about how your system is
performing.

6. Click Done.

Real-time statistical information for FileMaker Server appearsinthe
Performance Monitor.

Statistics are o
chartedin— 2
real-time here

FileMaker Server
usage statistics —
counters

DA VR
\\DATABASE_SERVER
\\DATABASE_SERVER
\\DATABASE_SERVER
\\DATABASE_SERVER

[Dats Curert Aty

Performance Monitor (Windows NT)

For information about the statistics displayed, see “Viewing usage
statistics for FileMaker Server” on page 7-7.
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Tip Y ou can use the Performance Monitor on a Windows client
computer or the System Monitor on a Windows 2000 client
computer to view usage statistics for FileMaker Server remotely
when the server is aso a Windows computer.

Monitoring performance (Windows 2000)

Using the Windows System Monitor, you can chart real-time
statistics for various aspects of FileMaker Server performance.
To view FileMaker Server statisticsin the System Monitor:

1. Start the FileMaker Server service, if itis not aready running.
2. Click the Start button > Programs > FileMaker Server Console.
3. Select System Monitor in the Console Tree.

4, Click the + button on the toolbar.

5. You see the Add Counters dialog box.

" Use Incal computer countars L +—Clicktoadd a
Name of the SeIVer & .y couner fromcogsete ow | | Selected
youare monltorlng WDATABASE_SERVER - ter
! —— counter to
Peformance cbisct e ] your chart
Choose —FieMaker Server -

FileMaker Server 4 oo

Select & Select counters from list
FileMaker Server

C All nstances:

% Select jnstances from [ist

<MoInstancess

Cache Unsaved %
usage statistics —{| i *75e
counters to add Gussts

to your chart Transactions

6. Click Select counters from computer, then choose the computer
running FileMaker Server from thelist.

7. For Performance object, choose FileMaker Server.

8. Click All counters (to chart all FileMaker Server usage statistics) or
click Select counters from list and choose the statistics you want to
chart, clicking Add after each selection.

Tip Transactions, Network KB/sec, Disk KB/sec. Cache Hit %, and Cache
Unsaved % give you the most information about how your systemis
performing.

9. Click Close.

Real-time statistical information for FileMaker Server appearsinthe
System Monitor. For information about the statistics displayed, see
“Viewing usage statistics for FileMaker Server” on page 7-7.

' FileMaker Server Console for Windows 2000 E _(oix|
e || < = | E)[m| 2

System Honitor

ol ofs sl @lE +x|e mlelEw ofs@

charted in

Statistics are ©
real-time here ‘

Last [ 100,000 Average | 100.000 Minimum I 100.000

Maxinum 100,000 Dur 10

FrEiE
\\DSPY8108
\iDsPY8108
ver  {iDSPYsi08
er  \iDSPY810B

FileMaker Server
usage statistics |, - " v
counters \

System Monitor (Windows 2000)

Tip You can use the Performance Monitor on aWindows NT client
computer or the System Monitor on a Windows 2000 client
computer to view usage statistics for FileMaker Server remotely
when the server is aso a Windows computer.

Using reported events to track activities

FileMaker Server uses the Windows Event Viewer (Windows) or
creates a Server Event Log (Mac OS 8.6 to 9.1) or Events.log

(Mac OS X) to help you keep track of activities on the server. These
log files contain time-stamped information on:

= FileMaker Server starting and stopping
= size of the database cache
= database files opened and closed by FileMaker Server



= guests that connect to and disconnect from FileMaker Server, as
well asthefilesthey access

= guests that are disconnected by FileMaker Server
= new, completed, upcoming, and currently running schedules

= pre-defined errors and other unusua conditions that occur when
FileMaker Server isrunning

= current properties (Windows) or preferences (Mac OS) settings
when FileMaker Server startsup, aswell as settingsthat are changed
during a FileMaker Server session

Viewing activities in the Event Viewer (Windows NT)
To view information about FileMaker Server activities:

1. Click the Start button > Programs > Administrative Tools (Common) >
Event Viewer.

2. Choose Log menu > Application.

You see alist of FileMaker Server Eventsin the Event Viewer.

@ Event Viewes - Application Log on \ADATABASE_SERVER (Filtered)

Log Yien Options Help

Date [Time Source Category |[Event |User Computer

@512/38  10630FM Filehiaker Server  Mane 10 NiA DATABASE SERVER
@512/ 10630 PM Filehiaker Server  Nane 29 NiA DATABASE_SERVER
@512/ 10629 FM Filehaker Server  Nane 29 NiA DATABASE_SERVER

»

@12/99  10529PM  FileMaker Server  None 29 NiA DATABASE_SERVER Double-

@6112/99  125318PM  FilsMaker Ssrver  Hons 28 NiA DATABASE_SERVER clickan

@6/12/99  125317PM  FileMaker Server Hone 28 NIA DATABASE_SERVER

@6/12/99  125315PM  FilsMaker Ssrver  Hons 28 NjA DATABASE_SERVER event to

@6/12/35  125315FM  FiloMaker Server None 5 NjA DATABASE_SERVER h
128315PM  FileMaker Server  None 10 N/A DATABASE_SERVER dlsplay
125315 PM Nore ) NjA DATABASE SERVER: detail

None g o ErrsreEREsyEae—— detalls

i g8712/44 3 / VER
€5/12/99 1252:06 P None 8 MNJA DATABASE_SERVER

Event Viewer (Windows NT)

3. Double-click an event to display details about it.
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Event Detail [ ]
Date: 8/12/93 EventID: &
Time: 125208 PM Source:  FileMaker Server
Ussr  N/A Type:  Information

Computer DATABASE SERVER  Catsgony Mone
. Description

The event is ——] Dpened e " Tours” with asynchronous 170 support =]
described here

]

Datz: & Bytes € words

JE|

L o

Cose | Previous | Hes | Hep |

For more information about the error conditions reported in the
Event Log, see appendix C, “Event log messages and
troubleshooting.”

Tip Choose Log menu > Save As to save information displayed in the
Event Viewer asatab-delimited text file (. TXT) and then import the
information into a FileMaker Pro database for further analysis.

Viewing activities in the Event Viewer (Windows 2000)
To view information about FileMaker Server activities:

1. Click the Start button > Programs > FileMaker Server Console.
2. Select Event Viewer (Local) in the Console Tree.

3. Double-click the FileMaker Server icon in the Details Pane.
You seealist of FileMaker Server events.

4. Double-click an event to display details about it.

Tip Select Event Viewer (Local) and choose Action menu > Export List

to saveinformation displayed in the Event Viewer asatab-delimited
textfile (. TXT) and thenimport theinformation into aFileMaker Pro
database for further analysis.
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For moreinformation about the error conditionsreported in the event
log, see appendix C, “Event log messages and troubleshooting.”

Keeping event data current (Windows)

Y ou might want to configure the Event Viewer to overwrite event
information, because the default setting is to stop recording events
when the application log becomes full. If you have many databases
open with many users accessing them, and if you flush the cache
often, the log could fill up quickly and the information in the Event
Viewer could quickly become out of date.

To overwrite event information when the log is full:

1. Choose one of the following:

= Windows NT: In the Event Viewer, choose Log menu >

Log Settings.

= Windows 2000: In the Event Viewer, choose Action menu >
Properties.

2. For Event Log Wrapping, select Overwrite Events as Needed.

3. Click OK.

Tip Y ou might want to increase the Maximum Log Size setting from
the default 512 KB to 4096 KB or more, depending on how much
FileMaker Server activity you anticipate on your server computer.

Viewing activities in the event log (Mac OS)

The Server Event Log (Mac OS8.6109.1) or Events.log (Mac OS X)
fileiscreated in the FileMaker Server 5.5 folder. Y ou can use any
application capable of opening plain text files or the Mac OS X
console application to view or print it.

Mac OS 8.6 t0 9.1: Y ou can have the log file open when

FileMaker Server isrunning, but you won't see recent updatesin the
fileuntil you closethelog fileand reopenit. A new logfileiscreated
each time you start FileMaker Server. The log from the previous
sessionisbacked up inthe FileMaker Server 5.5 folder and renamed
Server Last Event Log. Therefore, you always have the current log
fileand the previous one availablefor review. To save a specificlog
file, use the Finder to rename it before it is overwritten by
FileMaker Server.

Mac OS X: You can have the log file open in the OS X console
application when FileMaker Server isrunning. Events are logged
continuously, with the most recent log entry at the bottom of the
console application window. Events.log is created when FileM aker
Server starts, only if thereis no existing Events.log. Activities are
added to Events.log until it reachesthe maximum size, at which point
it isrenamed Events-old.log, and anew Events.log is created.

Y ou can set amaximum sizefor thelog file to prevent it from taking
up too much space on your disk. For more information, see“ Setting
asizelimit for the event log (Mac OS)” on page 6-15.

For moreinformation about the error conditionsreported in the event
log, see appendix C, “Event log messages and troubleshooting.”

Recalculating the Today function

in hosted databases

The Today function in FileMaker Pro updates whenever a database
fileis opened. If a database file you' re hosting with

FileMaker Server contains fields that use the Today function, you
must close that file and reopen it each day for thisfunction to
recalculate correctly. See the FileMaker Pro 5 User’s Guide for
information about the Today function.



Tip You can avoid using the Today function by creating acal culation
field that uses the Status(CurrentDate) function in FileMaker Pro.

If you have the Server Administration plug-ininstalled on a client
computer, you can use the FileMaker Server remote administration
capability to recalculate the Today function as described below.

Mac 0S8.6t09.1: Y ou can aternatively open and close the database
using the local administration capability as described on page 7-14.

To recalculate the Today function:

1. Log on to a Windows client computer or a computer running the
Mac OS located on the same network as your FileMaker Server
computer.

2. Click the Start button > Programs > FileMaker Pro 5.x (Windows) or
double-click the FileMaker Pro 5.x application icon (Mac OS).

3. Click Open an existing file, then click OK.

4. Click Hosts and select the name of your FileMaker Server
computer.

5. In the Remote Administration window, select the database
containing the Today function in the Files or Folders tab, then click
Close File.

6. Click OpenFile, select the file that you just closed, then click OK.

Closing and reopening the database in FileMaker Server causes the
Today function to be recalculated by the next FileMaker Pro guest
who opens the hosted file.

7. Choose File menu > Close to close the Remote Administration
window.

8. In FileMaker Pro, choose File menu > Open, then click Hosts.

9. Double-click thefile containing the Today function to accessit as
aguest.
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A message appears stating that the Today function is being
calculated. This process may take some time depending on the
number of records and other database calculationsin thefile.

Tips

= Y ou can automate the process of opening and closing files by
setting up aschedule in FileMaker Server to run a.CMD script
(Windows) or asystem-level script (Mac OS). For moreinformation
about running scripts on a schedule, see chapter 8, “ Scheduling
administrative tasks (Windows and Mac OS).”

= Windows:. Y ou can use the Schedule service provided with
Windowsto perform these steps each day. Seethe samplefilesinthe
RCToday folder in the Examples folder, inside the

FileMaker Server 5.5 folder, and the Windows documentation for
more information about the Schedule service.

= Mac OS8.6109.1: You can automate how you recalculate the
Today function in hosted databases using the sample AppleScript
named Recalculate Today Function located in the AppleScript
Examples folder inside the FileMaker Server 5.5 folder.
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Chapter 8
Scheduling administrative tasks (Windows and Mac OS)

Y ou can create schedules to perform these tasks:
= back up hosted databases

= run command files (Windows)

= run scripts (Mac OS)

= send messages to guests

Y ou can define up to 50 schedulesin FileMaker Server. If you set up
schedules that overlap, FileMaker Server starts the first task and
holds the next task in queue. When the first task has completed, the
next task will begin.

Windows: In addition to defining scheduled tasksin

FileMaker Server, you can also automate administrative tasks by
using the command line interface. Y ou can use utilities that come
with Windows, such as Windows Backup and Schedule services, for
running automated tasks similar to those provided by

FileMaker Server.

Scheduling tasks to run automatically
(Windows)

Y ou can use the Task Scheduling assistant to define three unique
kinds of tasks and set the times that they execute. Y ou can:

= schedule database backups
= run command files

= send messages to guests of hosted databases

To create a scheduled task:
1. Click the Start button > Programs > FileMaker Server Console.

Y ou seethe FileMaker Server Console. FileMaker Server isselected
in the Console Tree and the Details Pane displays the configuration
assistants.

2. Click Task Scheduler in the Details Pane of the FileMaker Server
Console.

Task Scheduler
=V Create schedules to

back up hosted

databases,

Y ou see the Task Scheduling assistant.

3. Follow the directions provided by the assistant to defineatask and
set up a schedule to run the task automatically.

Scheduling tasks to run automatically
(Mac 0S8.6109.1)

1. Choose Schedules menu > New Schedule.
Y ou see the New Schedule dialog box.
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Type a name for the scheduled task

New Schedule|“untitled schedule”

Schedule Name: Iuntitled schedule

_ Perform this task Choose a
Task: Back Up Databases ) task type
Choosea Operate on: All Databases 5 Choose the files
. Back up to: Specify... (OI’ filesina
backup location
(If ap Iicable) No backup folder or script has been specified folder) that the
pp task should
Perform on these days Operate Onv or
[sun [l [ v [ e s | | CPooseNo
Databases
Setthe day Perform at these times
and time the ‘IzlI|2|3|4|5|6|7|8|9|ID|H|AM
schedule ‘IZll|Z|3|4|5|6|?|8|9|IU|H|PH
should run Start st EE minutes past the hour
I?Enﬂhlethis schedule
[ .
Enable or disable the
scheduled task

2. Inthe New Schedule dialog box, type a name for the task in the
Schedule Name text box.

3. Choose the type of task (Back Up Database, Run Script, or Send
Message) from the pop-up menu. See the sections following step 6
for more information.

4. Click one or more days you want the task to be performed.

5. Click one or more hours and the up arrow for Start at n minutes past
the hour to set the time you want the task to be performed.

To deselect aday or hour, click it again.

Note A new scheduled task is enabled by default, which means the
task will run at its scheduled time after you close the New Schedule
dialog box. For more information about enabling and disabling
scheduled tasks, see page 8-7.

6. Click OK.

Scheduling database backups (Mac OS 8.6t09.1)

= For Operate on, choose one of the following options:

Choose To

All Databases Back up all hosted databases that are currently open

A specific folder name  Back up hosted databases in the selected folder
in the pop-up menu

= For Back upto, click Specify and locate afolder that you want
FileMaker Server to store your backupsin, or create anew folder.

Tips

= Be sure to specify afolder that is not in the same folder as the
FileMaker Server application (or a subfolder one level down).
Otherwise, your backups could accidentally be opened after a server
restart because FileMaker Server automatically opens all databases
in thislocation on startup.

= |t'simportant that you have enough disk space on the backup
destination disk. For moreinformation, see“Making sure you don’t
run out of disk space during backups’ on page 8-10.

Running a script (Mac OS 8.6 t0 9.1)
= For Operate on, choose one of the following options:

Choose To

All Databases Have the script affect all hosted databases that are

currently open

Aspecificfoldername Run the script on all databases in the selected folder
in the pop-up menu

No Databases Run a non-database related script

Note For anexample using the No Databases option, seethe example
AppleScript named Run a Schedule in the AppleScript Examples
folder inside the FileMaker Server 5.5 folder.



= For Specify Script, click Specify and |ocate an AppleScript on your
system that you want to run.

Sending messages to guests of hosted databases
(Mac 0S8.6109.1)

= For Operate on, choose one of the following options:

Choose To

All Databases Send amessage to all userswho are currently

connected to hosted databases

Aspecificfoldernamein  Send a message to guests of all open databasesin the
the pop-up menu selected folder

= Type your message in the text box.

Scheduling tasks to run automatically
(Mac OS X)

1. Choose Window menu > Schedules Window.

Type a name for the Choose the files that the
scheduled task task should operate on
06 Schedules

Choose a Nam  schedule Name: | Untitled Schedule =

task type Task: | Back Up Database  ['% ]

Choose a Operate on: _All Databases ' ]*

ba_CkUp ————————Back up to: [ Specify..

Ioca.tlon (If No backup folder or script has been specified.
applicable)

Perform on lew

Set the day

and time the y ['sun | Mon | Tue [Wed | Thu [ Fri | sa | i /)
schedule
should run [12]1]2]3 4567 ]@] 9 10]11] am
[2]1]2]3 456 7[a]9]t0]11] pm

Enable or To @ Minutes after the hour
disable the
scheduled ———— W Enable this schedule Cancel } € 0K

task
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2. In the Schedules window, click New.
3. Type aname for the task in the Schedule Name text box.

4. Choose the type of task (Back Up Database, Run Script, or Send
Message) from the pop-up menu. See the sections following step 7
for more information.

5. Click one or more days you want the task to be performed.

6. Click one or more hours and the up arrow for Minutes after the hour
to set the time you want the task to be performed.

To deselect aday or hour, click it again.

Note A new scheduled task is enabled by default, which means the
task will run at its scheduled time after you close the Schedules
window. For more information about enabling and disabling
schedul ed tasks, see page 8-7.

7. Click OK.

Scheduling database backups (Mac OS X)

= For Operate on, choose one of the following options:

Choose To

All Databases Back up all hosted databases that are currently open

Specify Back up hosted databases in the selected folder

= For Back upto, click Specify and locate afolder that you want
FileMaker Server to store your backupsin, or create anew folder.

Tips

= Be sureto specify afolder that isnot in the samefolder asthe
FileMaker Server application (or asubfolder onelevel down). Otherwise,
your backups could accidentally be opened after a server restart because
FileMaker Server automatically opensall databasesin thislocation on
sartup.
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= |[t'simportant that you have enough disk space on the backup
destination disk. For more information, see “Making sure you don’t
run out of disk space during backups’ on page 8-10.

Running a script (Mac OS X)

= For Operate on, choose one of the following options:

Choose To

All Databases Have the script affect all hosted databases that are currently
open

No Databases Run a non-database related script

Specify Run ascript on &l databases in the selected folder

= For Specify Script, click Specify and locate a script on your system
that you want to run. Add an extension to a script filenameif it does
not have one.

Sending messages to guests of hosted databases
(Mac OS X)

= For Operate on, choose one of the following options:

Choose To

All Databases Send amessage to al users who are currently connected to
hosted databases

Specify Send amessageto guests of all open databasesin the selected
folder

= Type your message in the text box.

Viewing scheduled tasks in the Schedules
list (Windows)

After you create scheduled tasks, they appear in the Schedules list.
The list shows you a summary of each defined schedule, including
the last time the task ran and the next time it will run.

To display the Schedules list, select Schedules in the Console Tree.

Click buttons on the toolbar to Drag the borderto  Click a column heading

administer scheduled tasks  change the columnwidth  to sort by this column
it 1y 0 oy [=[ 573
Tree I Schedules
Console Root [Task Lest Run [NextRun
£ FileMaker server  SsturdayBackup  BackUpDatabases  9/17/01120019PM  8/25/011200:00F
V" Wednesday Backup  Back Up hases 9/15/011202268M  8/22/01 1202004
Disk Fix Run Command File 8/13/011:00204M  Disabled
Announce Backup  Send Message B812/01 40026 PM Disabled
£ FileMaker Server
o Sy
] Performance Logs and Alerts
. | 3
bone [ ]

T T
Console Tree Details Pane

Y ou can use this view of your scheduled tasks to change, duplicate,
enable, disable, and run tasks manualy.

Tip To change the way items are displayed in the scheduled task list,
choose View menu and then choose a display option.

Administering scheduled tasks with the toolbar
(Windows)
Use the toolbar to work with scheduled tasksin the list. First, select

one or more schedulesin the list, then click an active tool on the
toolbar.



Note The tools available on the toolbar change depending on your
selection in the FileMaker Server window. Therefore, not all tools
described below are always visible.

Use this
tool To perform this action
. Display the information that was previously displayed in the Details
Pane of the FileMaker Server Console. Information isdisplayed in
reverse historical order.
Display the information that was previously displayed in the Details
= Pane of the FileMaker Server Console. This button activates after
you have used the Back button (above) to display a previous pagein
the Details Pane and lets you go “forward” in historical order.
= Movethe selection up onelevel inthefolder hierarchy inthe Console
Tree.
Hide the Console Tree.
X Delete the current selection.
= Displ roperties for the current selection.
Spiay prop!
Update information displayed in the Details Pane of the
L FileMaker Server Console (such asthe last time a schedule ran).
@ Display procedural FileMaker Server Help.
Ij Open the New Schedule assistant to create a new schedule.
@ Run the selected scheduled tasks right now, regardless of the
= execution time defined by the schedule.
El Enable or disable the selected scheduled tasks. If the selected tasks

are enabled to run on their defined schedule, clicking this button
disables them, removing the checkmark from their list entries. If the
selected tasks are disabled and are prevented from running on their
defined schedule, clicking this button enables them, placing a
checkmark on the left of their list entries.
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Use this
tool To perform this action
Prevent all scheduled tasks from running, even if they are enabled
(checked) in the Schedules list. This option lets you turn off all
schedules at once and is convenient for performing administrative
tasks on the server computer. When you click this button,
checkmarks of enabled tasks are dimmed in the Schedules list.
Allow all scheduled and enabled tasks to run. Tasks that you have

individually disabled will not run.

Duplicate one or more selected scheduled tasks to use as atemplate
for creating a new scheduled task.

Display FileMaker on the Web information in the Details Pane of the
console, which gives you easy access to the official FileMaker, Inc.
web site. Click thistool again to return to the previously displayed
page in the Details Pane.

Tip You can place the pointer over atool to display adescription of it.

Updating Last Run and Next Run information (Windows)

Last Run and Next Run information gets updated in the Schedules list
every 15 seconds. Y ou can update it more often, if you want.

To update the information about when a scheduled task ran last and
whenit will run again, select one or more schedul ed tasks and choose
Action menu > Refresh.

Viewing scheduled tasks in the Schedules
window (Mac 0OS)

After you create a scheduled task, it appearsin the Schedules

window.

Todisplay the Schedul eswindow, choose Window menu > Schedules

Window.
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Click a column heading to sort the list by that column.
Sort order is indicated by the triangle above the scrollbar

Drag the border to Click to reverse the sort order of the
change the column width list based on the selected column
| |
| s:hedulesgg
[ Last Run_[ Mext R 2
Click a checkbox to —ff gv::;iann Backup Back up N:Sna = 9?25/”;1 1:00 &M (=]
disableorenable o s e oo
scﬁgdlﬂlcg\d”(tjausakl [ Check Specials Message Send message  Mone 9/21/01 500 PM
Schedules window (Mac 0S 8.6t09.1)
Click a column heading to sort the list by that column
Dragthe borderto | Ifaschedule is disabled, the Last Run
change the column width and Next Run columns become blank
8ee Schedules
|
. Name ‘Task Last Run__'Next Run
Click & —— [ Check specials Message  Send Message 05/09/01 09:00PM
checkbox to [ Ticket Pick-up Reminder Send Message

disable or ¥ Weekday Backup Back Up Database 05/11/01 10:00PM

enable an ¥ Weekend Backup Back Up Database 05/13/01 09:00PM
individual
scheduled
task

’_’ Delete \f Edit \f New \
A

Schedules window (Mac OS X)

The list shows you a summary of each defined schedule, including
thetask it performs, the last time it ran, and the next time it will run.

Y ou can use this view of your scheduled tasks to change, duplicate,
enable, disable, and run them manually asdescribed in the following
sections.

The following table describes keyboard shortcuts for selecting
information in scrolling lists.

Use this shortcut To do this

Click an entry Select arow

Shift-click another entry  Extend the current selection

38-click another entry Deselect theentry, if it was selected, or select theentry

without including entries between it and your original

selection
T Select the row above the current selection
J Select the row below the current selection

Shift-7 or Shift-, Extend the current selection

8-Tord-| Select thefirst or last entry inalist (Mac 0S8.6t09.1)
Page Up key Scroll up

Page Down key Scroll down

Home key Scroll to the top of thelist (Mac OS 8.6 t0 9.1)

End key Scroll to the bottom of thelist (Mac OS 8.6 t0 9.1)

For information on working with lists, see “ Sorting and resizing
columns (Mac OS 8.6 to 9.1)” on page 7-13.

Running scheduled tasks manually

1. Inthe Schedules list (Windows) or Scheduleswindow (Mac OS),
select a scheduled task that you want to run.

2. Choose Action menu > Run Now (Windows) or Schedules menu >
Run Schedule (Mac OS).

The Last Run column is updated with the current date and time.

Changing scheduled tasks

1. Inthe Schedules list (Windows) or Scheduleswindow (Mac OS),
select a scheduled task.



2. Choose Action menu > Properties (Windows) or Schedules menu >
Edit Schedule (Mac OS).

See page 8-2 (Mac 0S 8.6 t0 9.1) or page 8-3 (Mac OS X) for an
illustration of the optionsin the Edit Schedule dialog box.

3. Make changes to the scheduled task, then click OK.

Tips
= You can double-click a schedule in the list to open the schedule
Properties (Windows) or Edit Schedule dialog box (Mac OS).

= Tochangetheformat of datesor timesin the Scheduleslist, change
thedate or timeformat settingsin the Regional Settingscontrol panel
(Windows) or the Date & Time control panel (Mac OS).

Duplicating scheduled tasks

Sometimesit’ seasier to use an existing scheduled task asatemplate,
rather than defining a completely new schedule. To duplicate an
existing schedule and use it as a base for a new one:

1. Inthe Scheduleslist (Windows) or Scheduleswindow (Mac OS),
select one or more scheduled tasks.

2. Choose Action menu > Duplicate (Windows) or Schedules menu >
Duplicate Schedule (Mac OS).

The duplicate schedul e appearswith theword “ copy” appendedtoits
name. For moreinformation about editing the duplicate schedul e, see
the previous section.

Deleting scheduled tasks

1. Inthe Scheduleslist (Windows) or Schedules window (Mac OS),
select one or more scheduled tasks.

2. Choose Action menu > Delete (Windows) or Schedules menu >
Delete Schedule (Mac OS).
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Y ou see aconfirmation message asking you to confirm that you want
to delete the selected schedule.

Note You can’'t undo the deletion of a schedule.
3. Click OK.

Enabling and disabling scheduled tasks

Y ou can enabl e or disabl e specific schedules or disable all schedules
at once.

To perform

this action Do this

Enable a In the scheduled task’ s Properties dialog box (Windows) or

schedulewhen ~ New Schedule dialog box (Mac OS), be sure Enable this

creating it schedule is selected.
Windows: If you use the Task Scheduling assistant to create
a schedule, the scheduled task is enabled by defauilt.

Enable a Windows: Select one or more disabled schedulesin the

schedule that Schedules list and choose Action menu > Enabled. A

was disabled checkmark appears next to the Enabled command in the
Action menu to indicate the current selection is enabled.
Mac OS: In the Schedules window, click the empty
checkbox to the left of the schedule name. A checkmark
appears, indicating that the scheduled task is enabled.

Disablea Windows: Select one or more enabled schedulesin the

selected Schedules list and choose Action menu > Enabled. The

schedule checkmark next to the Enabled command in the Action menu

disappears to indicate the current selection is disabled.

Mac OS: Inthe Scheduleswindow, click the checkbox tothe
left of the schedule name. The checkmark disappears,
indicating that the scheduled task is disabled.
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To perform

this action Do this

Prevent all Windows: Choose Action menu > Allow schedules to run.

schedulesfrom  \ac Os;: Choose Schedules menu > Allow Schedules to Run.

runnin

9 The checkmark on thiscommand disappears, indicating that

this option is turned off.
This setting overrides any individual schedule settings you
have enabled and all checkmarksin the list are dimmed
indicating that al schedules are disabled. If you open the
Properties (Windows) or Edit Schedule dialog box
(Mac OS) for adisabled scheduled task, however, the
checkmark in the Enable this schedule option might still be
checked.

Allow enabled ~ Windows: Choose Action menu > Allow schedules to run.

schedulesto run 140 OS: Choose Schedules menu > Allow Schedules to Run.

A checkmark appears on this command, indicating that all
scheduled tasks that are individually checked in the
scheduled task list are enabled.

Scheduled tasks that were individually disabled are not re-
enabled until you enable them individually.

Windows: Y ou can also use tools on the toolbar in the Scheduleslist
to enable and disable scheduled tasks. For more information, see
“Viewing scheduled tasks in the Schedules list (Windows)” on

page 8-4.

Using the command line to automate tasks
(Windows)

Y ou can use the DOS command lineinterface to automate taskswith
FileMaker Server, such as backing up files using the Windows
Backup and Schedule services, or administering files from the
FileMaker Server computer.

Y ou can use the command line to:

= start or stop FileMaker Server

= host FileMaker Pro files

= close files hosted by FileMaker Server

= pause or resume afileor filesto periodically flush the cache

Below isalist of commands available with FileMaker Server. Text
enclosed in the [ ] charactersindicates that the item is optional.
[path] indicates one or more filenames (possibly including wildcard
characters) or folder names are optional parametersto the command.
#minutes indicates you need to type a numeric value for the number
of minutes before guests are disconnected after a stop or close
command.

Command syntax Description

fmserver start [-5] Start theFileMaker Server service. Includethe-soptionto
skip automaticaly opening filesin the FileMaker Server

5.5 folder (and subfolders onelevel down).

fmserver stop Stop the FileMaker Server service, send a custom
[-m “message text”] message to guests, and set the number of minutes
[-t #minutes] before the files close.

fmserver open [path]  Host specific FileMaker Pro files.

fmserver close [path]
[-m “message text”]
[-t #minutes]

Close specific FileMaker Pro files, send a custom
message to guests, and set the number of minutes
before the files close.

fmserver pause [path]  Pause activity on specific or all FileMaker Pro files.
Pause files before copying them to another folder, for
example, when backing them up. Useful with the NT
Backup and Schedule services. If you don’t specify a
path, all hosted files are paused.

Pause causes all changes for a particular fileto be
written from cache to disk and prevents guests from
making any changes to the file until thefileis
“resumed.” After afileissuccessfully paused, it'ssafe
to copy it using a script or back-up program.
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Use this command To

fmserver resume [path] Resume activity on specific or al paused
FileMaker Pro files after they have been copied or
backed up. Useful with the NT Backup and Schedule
services. If no path is specified, al paused files are
resumed.

To access the command line interface:

1. Open an MS-DOS window using the Command Prompt icon
(Windows NT) or click the Start button > Programs > Accessories >
Command Prompt (Windows 2000).

2. At the command prompt, switch to the FileMaker Server 5.5

folder. If youinstalled FileMaker Server in the default location, type:

cd c:\ProgramFi | es\ F | eMbker\ F | eMaker Server 5.5

3. Typef nser ver followed by a FileMaker Server command and
any optional parameters and switches.

The following table contains examples of FileMaker Server
commands you can use.

Use this command To

fmserver start Start the FileMaker Server service and open al
multi-user FileMaker Profilesin the
FileMaker Server 5.5 folder (and subfoldersone

level down).

Start the FileMaker Server service without
opening any FileMaker Profiles.

fmserver start -s

fmserver stop -m “All Send a custom message to guests and stop the
serverswill beshut downin FileMaker Server servicein 10 minutes. This
10 minutes’ -t 10 sequence closes al hosted database files.

fmserver open Open all multi-user FileMaker Pro filesin the
FileMaker Server 5.5 folder (and subfolders one

level down).

fmserver open
expenses.fp5 messages.fps

Open the Expenses and Messages files.

fmserver open
“names and addresses.fp5”

Open the Names and Addressesfile.

Note The filenamein this example includes
spaces and therefore must be enclosed in quotes.

Closeall hosted FileMaker Profilesinthedefault
close time (five minutes).

fmserver close

fmserver close
expenses.fp5 -m “I'll be
closing the Expensesfilein
10 minutes” -t 10

Send amessageto guests of the Expensesfileand
closeit in 10 minutes.

fmserver pause Pause all currently hosted FileMaker Pro files,

which restricts guest activity to all hosted files.

fmserver pause
expenses.fp5

Pause the Expenses file, which restricts guest
activity to that file.

fmserver resume Resume all paused files.

fmserver resume
expenses.fp5

Resume the paused Expensesfile.

For more examples, seethe FileMaker Server samplefiles (installed
inthe Examplesfolder inthe FileMaker Server 5.5 folder) or usethe
fnserver /? command at the command prompt to view alist of
available commands. For general information about using the
command prompt, see your Windows documentation.

Example: Backing up hosted databases on the command
line (Windows)

You can usethe fnserver pause and fnserver resune
commandsin the MS-DOS window, along with DOS commands, to
back up FileMaker Pro database files to another folder. To automate
this process, you can enter the commands described in atext file, and
then execute the commands using a Windows batch process.
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The process of backing up hosted databases using the command line
isto create a directory in which to temporarily store the backups,
pause hosted databasesto limit accessto them on your network, copy
the filesto the new directory, restore availability of the filesto
guests, and remove the temporary backup directory you created.
These steps are described in detail below.

1. Usethe DOS nkdi r command to create a new directory, for
example, Backups.

2. Usethe fnserver pause command, which pauses a specified
file or files hosted by FileMaker Server.

Guest activity on paused database filesis restricted, so it’s best to
limit overall pause time as much as possible.

3. Usethe DOS xcopy command to copy al files (including filesin
subdirectories) from the FileMaker Server 5.5 directory to the
Backups directory.

4, Usethe fnserver resume command to restore guest accessto
paused database files.

5. Movethe files from the Backups directory to a permanent backup
location and use the rndi r/ s/ g command to delete the Backups
directory and subdirectories.

Tips
= A sample command file named Backup.cmd containing this
sequence of commandsisin the Examples folder inside the

FileMaker Server 5.5 folder. Y ou can use thisfile as atemplate for
backing up your own hosted databases.

= To execute this set of commands on an automatic schedule, you
need to use the at command and Schedule service provided by
Windows. For moreinformation, see your Windows documentation.
If you haveatapedrive, you can usethebackup command provided
by Windows to copy files directly to tape.

Using a script to automate tasks (Mac OS)

Y ou can use a script to automate administrative tasks performed by
FileMaker Server. For more information about AppleScript
application programs that are provided with FileMaker Server and
about supported Apple events, see the AppleScript Examples folder
inside the FileMaker Server 5.5 folder.

Making sure you don’t run out of disk space

during backups

It'simportant that the destination disk where you plan to store your
hosted files and backups has plenty of free space. If the hard disk
runs out of space while afileisbeing modified or if a database file
reaches the 2GB size limit, FileMaker Server will automatically
begin compressing the hosted file to reduce the amount of disk space
it uses. During the compression, al guest activity to the server is
paused and guests see the coffee cup icon I“F or the network icon.
Compression may take some time to complete. To avoid automatic
compression, leave plenty of freedisk space onthe computer running
FileMaker Server.

If the hard disk runs out of space during a backup, the backup stops
and FileMaker Server logs an error in the application event log
(Windows) or Server Event Log (Mac OS). It'sagood ideato
periodically check the Schedules list for error conditions, which are
reported in the Last Run column. To avoid running out of disk space
when backing up files, choose tape or adifferent hard disk as your
backup destination.

For additional help troubleshooting command line problems, see
appendix C, “Event log messages and troubleshooting.”



Chapter 9
Using FileMaker Server in Red Hat Linux

This chapter providesinstructions for:
= administering FileMaker Server running in Red Hat Linux
= configuring FileMaker Server settings for maximum performance

Getting onscreen help with command and

preference syntax

The QuickRef.pdf fileinstalled in /usr/doc/fmserver5-5 lists syntax
and options for each administration command and preference
setting. In addition, preference settings are described and default
values are listed in comments in the configuration file (/etc/
fmserver.conf).

Administering FileMaker Server

Y ou can use the shell prompt in Red Hat Linux to administer
FileMaker Server manually.

Administrative tasks include:

= starting and stopping FileMaker Server
= hosting FileMaker Pro files

= closing files hosted by FileMaker Server

= pausing and resuming files (to periodically flush the cache or back
up databases)

= |isting hosted files

= reloading the configuration file to apply changes to runtime
preference settings. See “ Applying configuration changes’ on

page 9-4 for alist of al preference settings and how changes must be
applied.

Tip Y ou can aso usethe administrative commands described herein
scripts to automate administrative tasks. For information about
scripting, see your operating system documentation or consult a
third-party book on scripting.

The following table describes the administrative commandsin
FileMaker Server. Text enclosed inthe [ ] charactersindicates that
theitem is optional. path indicates a filename or directory.

Command syntax Description

fmserverd start [-9]
[-c path]

Start the FileMaker Server service, read the FileMaker
Server configuration file in /etc/fmserver.conf, and
open filesin the /var/fmserver directory (and
subdirectories one level down).

Use the -s option to skip automatically opening filesin
the /var/fmserver directory (and subdirectories one
level down).

Use the -c path option to have FileMaker Server read
the configuration file (fmserver.conf) in the aternate
path specified.

fmserverd stop
[-m “message text”]
[-t #minutes] [-f]

StoptheFileMaker Server service after notifying guests
that they must disconnect from hosted databases within
2 minutes.

Use the -m “message text” option to send a custom
message to guests.

Use the -t #minutes option to set a custom duration
before FileMaker Server stops.

Use the -f option to force the FileMaker Server service
to disconnect guestsimmediately, but close databases
safely so data integrity is maintained.
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Command syntax

Description

fmserverd open
[path]

Open (host) FileMaker Pro filesin the /var/fmserver
directory (and subdirectories one level down) or in the
specified path.

fmserverd close
[path]

[-m “message text”]
[-t #minutes]

Close FileMaker Pro files located in the /var/fmserver
directory (and subdirectories one level down) or in the
specified path.

Use the -m “message text” option to send a custom
message to guests.

Use the -t #minutes option to set a custom duration
before files are closed.

fmserverd pause
[path]

Pause activity on files located in the /var/fmserver
directory (and subdirectories one level down) or in the
specified path.

Usethiscommand to pausefiles before copying them to
ancther directory, for example, when backing up
databases.

Important Don’t copy filesthat are open.

fmserverd resume
[path]

Resume activity on all paused FileMaker Pro files or
filesin the specified path.

fmserverd files

List all files currently open (hosted) by FileMaker
Server. If ahosted fileisin the paused state, thisis
indicated in the list.

fmserverd reload
[-c path]

Reload the configuration filein /var/fmserver.conf and
apply changes to runtime preference settings. See
“Applying configuration changes’ on page 9-4 for alist
of preference settings that can be applied using the
reload command.

Use the -c path option to have FileMaker Server read
the configuration file (fmserver.conf) in the alternate
path specified.

fmserverd -h

Display alist of al FileMaker Server commands and
their usage.

Starting and stopping FileMaker Server

automatically

The FileMaker Server installer installs afile containing a script that
can automatically start and stop FileMaker Server when your
operating system boots and shuts down. This script islocated in /etc/
rc.d/init.d/fmserverd.

To have the FileMaker Server service automatically start when the
operating system boots and stop when the operating system shuts
down:

1. Switch to theroot user by entering the following command at the
shell prompt:

$ su -1 root
2. Enter the root password.

The prompt changes to #, indicating that you are now logged in as
root.

3. Enter the following command to enable FileMaker Server to
automatically start and stop when your operating system starts and
shuts down:

# chkconfig fmserverd on

4. Log out as the root user by entering:
# | ogout

To disable automatic start and stop for FileMaker Server:

1. Switch to the root user.

2. Enter the following command to disable automatic start and stop:
# chkconfig fmserverd of f

3. Log out asthe root user.



Configuring FileMaker Server

The FileMaker Server configuration file (fmserver.conf) contains
FileMaker Server preference settings, which you can view and
modify. Preference settings allow you to customize FileMaker
Server for optimal performance.

Preference settings include:

= set the maximum number of guests

= set idledisconnect time and customize the pre-disconnect message
= set the maximum number of open files

= allocate the amount of memory (RAM) that FileM aker Server uses
for the database cache

= set how often the database cache is flushed

= alow single user filesto be hosted and shared

= allow connected guests to receive plug-in updates automatically
= gpecify acustom account name and group for FileMaker Server

= enable remote administration and specify aremote administration
password

= gpecify acustom server name that appears in the FileMaker Pro
Hosts dialog box

= specify apreferred |P address
= open runtime solution files automatically

= save event information and usage statisticsin log files and set the
location and size limits on these logs

= register FileMaker Server in adirectory service

Editing the configuration file

Y ou can use atext editor, such as pico, to open the configuration file
in the terminal window or pseudo terminal (pts).
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Important Y ou must be logged in as the root user when making
changesto the FileMaker Server configuration file. Logging in as
root givesyou complete accessto all system resources. Be extremely
careful when working as the root user. Y ou could accidentally issue
acommand that could detrimentally affect your operating system
software.

1. Switch to theroot user by entering the following command at the
shell prompt:

$ su -1 root
2. Enter the root password.

The prompt changes to #, indicating that you are now logged in as
root.

3. Using your text editor, open the fmserver.conf file. For example:
# pico /etc/fmserver. conf

The following illustration shows the beginning of the configuration
file.

Important Thefirst 6 characters of the configuration file must be
FMS550. Otherwise, FileMaker Server will not load the configuration
file during start-up and will start with the default preference settings.

= .

File Sessions Settings Help

Uk PICOCtm) 4.0

F15550 # File Identification Version Mumber (Do rot removs.)

# fmserver.conf

# FileMaker Server 5.5 Configuration File

# Copyright {c} 1984-2001 by FileMaker. Inc, ALl rights reserved.
#

The Fussrver,conf file contains FileMaker Ssrver preferences, which wou
can wiew and modify. Comnent lines, uhich describe preferences settings.
bezin uith a pound sign (#), See the FileMaker Server Administrator's
Guide for further details on preferences.

Set MaxGuests equal to the maximum number of guests that can
sinultanecusly access databasss hosted by FilsMaker Ssrver,
Range: 1-250
Default; 25

I

L
Get. Help Wi itelut. Read File
Exit Justify i Hhere is

[ v, [P komoote o 1

FileMaker Server configuration file viewed in pico

Ri Cut Text
] UnCut. Text
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Inthe configuration file, each preference setting parameter and itsvalue
(either an ON or OFF or a specific integer or string value) must reside

Runtime preference settings that are applied when you
reload the configuration file or restart FileMaker Server

onaseparateline. The parameter and value must be separated by aspace
or tab character. Parameters and va ues are not case sensitive.

Comments in the file, which describe each configuration setting,
begin with a# character and are ignored by FileMaker Server. You
can add commentsto the configuration file by inserting a# character
at the beginning of each line of text you add.

Tip To preserve a preference setting before trying another value,
insert a# character at the beginning of the existing setting. Y ou can
easily revert to this setting by deleting the new line and removing the
# character in the old line.

Preference settings are described in detail in the remaining sections
of this chapter.

Applying configuration changes

FileMaker Server does not automatically reread the configuration

file when you close the file. Depending on the preference settings
you have changed, you must either reload the configuration file or
restart FileMaker Server.

Thefollowing listsgroup preference settings by whether they require
you to reload the configuration file or restart FileMaker Server.

Note Restarting FileMaker Server always applies all preference
settings, but restarting requiresthat all guests disconnect from hosted
databases. Therefore, simply reloading the configuration file is
recommended if you make changes to only runtime settings.

Runtime preference settings that are applied when you
reload the configuration file or restart FileMaker Server

= MaxGuests, if number of guestsis decreased
= DisconnectldleGuests

MaxldleTime
DisconnectWarning
UseCacheFlush
FlushTimelnterval
HostSingleUserFiles
UseAutoUpdate
UseRemoteAdmin
RequirePassword
Password
CustomExtensions
MaxEventLogSize
UseStatslL og
StatsTimelnterval
MaxStatsLogSize

Preference settings that require
you to restart FileMaker Server

MaxGuests, if number of guestsisincreased
MaxFiles, if number of guestsisincreased
CacheSize

UseCustomServerName

ServerRoot

FMServerUser

FM ServerGroup

CustomServerName

UsePref| PAddr

Prefl PAddr

UseCustomExtensions

EventL ogPath

Statsl ogPath

UseDirectoryService
DirectoryService.ServerName



Preference settings that require
you to restart FileMaker Server

= DirectoryService.L ogonRequired
= DirectoryService.AcctName

= DirectoryService.Password

= DirectoryService.L dapServerPort

= DirectoryService.DistinguishedName
= DirectoryService.Owner

= DirectoryService.Location

= DirectoryService.Phone

= DirectoryService.Email

Reloading the configuration file to apply runtime
preference changes

If you make changes to the runtime preference settings, you can
reload the configuration file without affecting guest accessto hosted
databases.

To reload the configuration file:

1. Switch to the root user by entering the following command at the
shell prompt:

$ su -1 root
2. Enter the root password.

The prompt changes to #, indicating that you are now logged in as
root.

3. Reload the configuration file by entering:
# frserverd rel oad
4. Log out as the root user by entering:

# | ogout
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Restarting FileMaker Server to apply
configuration changes

If you make changes to the non-runtime preference settings, you
must restart FileMaker Server to apply preference settings.

Torestart FileMaker Server and apply preference setting changes:
1. Switch to theroot user by entering the following command at the
shell prompt:

$ su -1 root
2. Enter the root password.

The prompt changes to #, indicating that you are now logged in as
root.

3. Stop the FileMaker Server service by entering:
# fmserverd stop

Any guests currently accessing hosted databases are asked to
disconnect within two minutes.

4. After FileMaker Server has stopped, restart the service by
entering:

# fmserverd start
5. Log out as the root user by entering:

# | ogout

Restoring preference defaults

Default settings for each parameter are documented in comment
lines in the configuration file (/etc/fmserver.conf). If you have
changed a preference parameter value and you want to restoreiit to
its default state, replace the changed value with the default value
located in the comment text that precedes the changed preference
parameter. Thenreload or restart the configuration file, depending on
the requirements of the setting you restored.
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To start FileMaker Server with preference settings in their default
state, stop FileMaker Server, rename or delete the FileMaker Server
configuration file (/etc/fmserver.conf), then restart FileMaker Server.

Toreinstall FileMaker Server, overwriting al installed files and
create a new default configuration file, stop FileMaker Server, and
enter the following command:

#rpm-Wh --replace --force -noscripts fnserver-5.5.1-i 386.rpm

Setting the number of guests

Y ou can specify the number of guests who are simultaneously
connected to FileMaker Server. Specifying alower number |eaves
more memory available for FileMaker Server to operate.

To set the number of FileMaker Pro guests:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the MaxGuests preference parameter and replace the current
value with awhole number between 1 and 250. For example:

MaxQuests 30
The default setting is 25.

4. If you're finished making changes to the configuration file, close
the text editor. If you increased the number of guests, restart
FileMaker Server. If you decreased the number of guests, you can
reload the configuration file. Then log out as the root user.

Disconnecting idle guests

FileMaker Server can disconnect idle guests from hosted databases
after a specified length of time. If you want to change this setting,
first turn on guest disconnection. Then use the default idle time
setting or specify your own duration. Y ou can use the default pre-
disconnection message or write a custom message.

Note InFileMaker Pro 5.5, you can use apassword privilegeto keep
aguest connected to FileMaker Server when the guest isidle. In
some instances, such aswhen aguest is also serving as aweb
publishing host, the guest should maintain aconnectionto FileM aker
Server, so that users connecting to the database through a browser
will be able to access the database. For more information, see
FileMaker Pro 5.5 Help.

To adlow FileMaker Server to disconnect idle guests:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the DisconnectldleGuests preference parameter and replace
the current value with ON

Di sconnect | dl eQuests ON

4. Find the MaxIdleTime preference parameter and replace the
current value with awhole number between 10 and 1440 minutes.
For example:

Max! dl eTi ne 60
The default setting is 720 minutes.

5. Find the default DisconnectWarning message setting and type a
new message between the quotes or leave the default message
(shown below) in place.

D sconnect Warning “It appears that you have been idle
for a while. Please switch to another record to remain
connect ed. ”

6. If you're finished making changes to the configuration file, close
the text editor, reload the configuration file, and log out as the root
user.



Setting the maximum number of files

Y ou can change the maximum number of files FileMaker Server can
have open simultaneously. Specifying alower number of filesleaves
more memory availablefor FileMaker Server to operate. If you know
the approximate number of files you consistently host, you can set
the maximum number of files close to this number to gain the best
performance from FileMaker Server.

When you increase the number of files allowed, you must restart
FileMaker Server for the new setting to take effect.

To set the maximum number of files FileMaker Server can host:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the MaxFiles preference parameter, type a space, and type a
value for the number of files you expect to host. The minimum
setting is 1 and the maximum is 125. For example:

MaxFi | es 60
The default setting is 50 files.

4. If you're finished making changes to the configuration file, close

the text editor, restart FileMaker Server, and log out as the root user.

Note If you decrease the maximum number of hosted files, you can
reload the configuration file instead of restarting FileMaker Server.

Changing the amount of memory used by
FileMaker Server

Y ou can change the amount of memory FileMaker Server uses for
the database cache. Do not specify more RAM than is physically
available on the server computer. Be sure to leave enough RAM for
the operating system.
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When you change the amount of memory set aside for FileMaker
Server, you must restart FileM aker Server for the new setting to take
effect.

To change the amount of memory FileMaker Server uses:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the CacheSize preference parameter and replace the current
value with awhole number between 2 and 40 megabytes (MB). For
example:

CacheSi ze 6
The default settingis4 MB.

4. If you're finished making changes to the configuration file, close
the text editor, restart FileMaker Server, and log out as the root user.

Setting how often the cache is flushed

FileMaker Server flushes (writes) information stored in the cache
(temporary storage) to disk wherever FileMaker Server isidle. If the
cacheisflushed frequently, dataintegrity in hosted filesisimproved
but FileMaker Server performance may decline.

If you want to changethis setting, first turn on the cache flush setting.
Then you can use the default time interval or specify your own
interval.

To flush the cache periodically:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseCacheFlush preference parameter and replace the
current value with O\

UseCacheFl ush ON
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4. Find the FlushTimelnterval preference parameter and replace the
current value with awhole number between 15 and 120 minutes. For
example:

Fl ushTi nel nterval 20
The default setting is 15 minutes.

5. If you’ refinished making changesto the configuration file, closethe
text editor, reload the configuration file, and log out as the root user.

Allowing single user files to be hosted

For your convenience, you can set FileMaker Server to open files set
to Single User in FileMaker Pro. This setting lets you host single-
user databases without first having to manually open themin
FileMaker Pro and change them to multi-user.

To open single user files automaticaly:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the HostSingleUserFiles preference parameter and replace
the current value with ON
Host Singl eUserFiles ON

4. If you' refinished making changesto the configurationfile, closethe
text editor, reload the configuration file, and log out as the root user.

Allowing software updates to be
downloaded automatically

Y ou can store software updates on the server computer and allow
FileMaker Pro 5.5 guests to download these files automatically when
they open database files hosted by FileMaker Server 5.5. Examples of
files you might want to download automatically are plug-in files or
plug-in licensefiles, sometimes required by FileMaker Pro databases.

When aFileMaker Pro fileis hosted using FileMaker Server, any
plug-ins required by the file must exist on each guest computer used
to open the database. By allowing plug-in updates to be downloaded
automatically, you ensure that all guests have access to plug-ins
required by the database the first time they attempt to open it. In
addition, when plug-ins are changed by database devel opers, you can
store new versions on the server computer so you don't have to
update plug-ins on many individual guest computers.

If you want to change this setting, first turn on the Auto Update
setting. Then place plug-in and plug-in version filesin the Auto
Update directory on the server computer and instruct database guests
to turn on the Auto Update plug-in in the Application preferencesin
FileMaker Pro 5.5.

Enabling Auto Update in FileMaker Server

To enable FileMaker Pro guests to automatically receive plug-in
updates from the server computer:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseAutoUpdate preference parameter and replace the
current value with O\

UseAut oUpdat e ON

4. If you' refinished making changesto the configurationfile, closethe
text editor, reload the configuration file, and log out as the root user.

Note FileMaker Pro 5.5 can check the version of plug-in files
required by the hosted database and update plug-insif the current
version is not located on the guest computer. However, FileMaker
Pro cannot verify the version of other downloadable files. If anon-
plug-infileislocated on both the server and guest computers, thefile
on the guest computer is backed up in the Saved System Folder
(Windows) or Saved FileMaker Extensionsfolder (Mac OS) and the
file on the server is placed in the System Folder (Windows) and
FileMaker Extensions folder (Mac OS).



Storing plug-in files on the server computer

For automatic file downloading to work correctly, you must place
current plug-in files and text files containing version information for
each plug-in in the correct location on the server computer. In
addition, guests must activate the Auto Update plug-in in the
Application preferencesin FileMaker Pro 5.5 before attempting to
open hosted files that require plug-ins.

To set up the server and guest computers for Auto Update:

1. Obtain updated plug-in and version control files from your
FileMaker Pro database developers.

2. Placefiles for automatic download in the /var/fmserver/
AutoUpdate directory or create adirectory named AutoUpdatein the
directory that contains the databases that require plug-ins.

Guest platform  File format

Windows fmx file type for plug-in files
.txt version plug-in version control files
Mac OS fmxt file type in bin format (MacBinary) for plug-in files

.txt format plug-in version control files

Tip If you host multiple databases that use the same plug-ins, store
updatesin the /var/fmserver/AutoUpdate directory, rather than in
individual AutoUpdate foldersin each database directory. This
allows you to store an update in one place on the server computer,
and makes it available for all databases that need it.

3. Instruct users of guest computersto enable automatic download in
FileMaker Pro 5.5 asfollows: Start FileMaker Pro, choose Edit
menu > Preferences > Application (Windows and Mac OS 8.6 to 9.1)
or FileMaker Pro menu > Preferences > Application (Mac OS X).

4, Click the Plug-ins tab and select Auto Update.
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Specifying the location of hosted files

When FileMaker Server starts, it looks for databases in the
Ivar/fmserver directory (and one level down) by default and opens
them automatically. Y ou can have FileMaker Server open filesina
different directory (and one level down) by specifying the directory
path in the configuration file.

Note The ServerRoot preference parameter isthe search path for the
close, pause, and resume commands as well. Therefore, when you
issueaclose, pause, or resume command, FileMaker Server looksfor
fileslocated in this path.

When you change the location of hosted files, you must restart
FileMaker Server for the new setting to take effect.

To specify the location of hosted files:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the ServerRoot preference parameter and replace the current
value with a new path. For example:
ServerRoot “/var/fmserver/aut oopen”

4. If you're finished making changes to the configuration file, close
the text editor, restart FileMaker Server, and log out as the root user.

Specifying a user account name and group
name for FileMaker Server

For security reasons, you can specify acustom user account namefor
FileMaker Server to use after installation, which makes FileM aker
Server run asanon-privileged user. Changing the account and group
name can protect your system from extensive damage if someone
were to misuse the fmserverd process.
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To specify acustomized user account name and group name:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Findthe FM ServerUser preference parameter and replacetheexisting
user name between the quotes with a custom user name. For example:

F\VBer ver User “f medaenon”
The default user account name is fmserver.

4. Find the FM ServerGroup preference parameter and replace the
existing group name between the quotes with a custom group name.
For example:

F\Ber ver G oup “MWKTG
The default group name is fmserver.
Note Both the user name and group name are case sensitive.

5. If you're finished making changes to the configuration file, close
the text editor.

6. Ensurethat all databases hosted by FileM aker Server are readable
and writable by the new user and group names by entering the
following commands:

# chown fnsdaenon database 1 database 2 ...
# chgrp MKTG database 1 database 2 ...
# chnod 664 database_1 database 2 ...

where database 1 database 2 ..isalist of all databasesto be
hosted, separated by single spaces.

Thechmod command above grants read/write permission to the new user
account name and group. When you list hosted files using the operating
system command Is-1, file permissions are now displayed asfollows:

STW WA - -

Important If permissions are not set correctly on database files,
FileMaker Server can't open them.

7. Restart FileMaker Server and log out as the root user.

Enabling remote administration in

FileMaker Server

Using FileMaker Pro 5.x, you can remotely control FileMaker Server
from adifferent computer than the one on which FileM aker Server is
installed and hosting databases. After you turn on remote
administration, you can use a remote computer to view alist of
hosted databases, the guests using them, and monitor performance
statistics. Y ou can control access to remote administration by
requiring a password that restricts access to the Remote
administration databases. For more information about using remote
administration on a guest computer, see chapter 7, “ Administering
FileMaker Server (Windows and Mac OS).”

If you want to administer FileMaker Server from aremote computer,
first enable it on the server computer. Then install the remote
administration plug-in on the client computers you plan to use for
remote administration. For more information about installing and
enabling the remote administration plug-in, see“ Automatically
downloading the Server Administration plug-in to aremote
computer” on page 7-6.

To administer FileMaker Server from aremote computer, first turn
on remote administration and then enable password protection, if
you want. Y ou use the fmspasswd utility installed with FileMaker
Server to encrypt the remote administration password.

To turn on remote administration and create aremote administration
password:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseRemoteAdmin preference parameter and replace the
current value with O\

UseRenot eAdmin ON



4. Find the RequirePassword preference parameter and replace the
current value with ON if you want to restrict access to remote
administration.

Requi rePassword ON

5. If you're finished making changes to the configuration file, close
the text editor.

6. Use the fmspasswad utility to encrypt a remote administration
password, as described in the next section. Then reload the
configuration file, and log out as the root user.

Using the fmspasswd utility to

encrypt passwords

Y ou can use the fmspasswd utility installed with FileMaker Server
to encrypt passwordsfor remote administration and directory service
access. Encrypted passwords are stored in the FileMaker Server
configuration file.

To encrypt a password:

1. If you're not already logged in as root, switch to the root user.

2. Enter the following command to start the fmspasswd utility:
# f mepasswd

3. Enter the path to the FileMaker Server configuration file when
prompted.

Tip Press Return if the configuration file isin the default location.

4. When prompted, enter Rif you' re encrypting a password for the
remote administration preference or enter L if you're encrypting a
password for the LDAP preference.

5. Enter your password.

Note For security reasons, your password doesn’t appear on the
screen.

6. Verify your password by entering it again.
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Specifying a custom host name

Y ou can specify a host name for the computer running FileMaker
Server that's different from the name registered by the operating
system. When you define a custom name for FileMaker Server,
guests see this name when they open the Hosts dialog box in
FileMaker Pro and when they administer FileMaker Server
remotely.

If you want to change this setting, first you turn on the custom host
name setting and then you specify the custom host name.

When you specify the custom host name, you must restart FileM aker
Server for the new setting to take effect.

To specify the custom host name:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseCustomServerName preference parameter and
replace the current value with CN

UseCust onBer ver Nane ON

4. Find the CustomServerName preference parameter and replace
the current val ue between the quotes with acustom server name. For
example:

Cust onBerver Nane “MKTG DB Server”
Custom host names are limited to 31 characters.

5. If you're finished making changes to the configuration file, close
the text editor, restart FileMaker Server, and log out as the root user.
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Specifying the preferred IP address

If you have more than one network card in the server computer, you
can specify apreferred |P address for FileMaker Server to use.
Otherwise, FileMaker Server will use the first configured non-
loopback device returned by the operating system.

If you want to dedicate a specific |P address for FileMaker Server,
first you turn on this setting and then you specify the IP address to
use. After you specify apreferred | P address, you must restart
FileMaker Server for the new setting to take effect.

To set the preferred |P address:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UsePreflPAddr preference parameter and replace the
current value with O\

UsePref | PAddr ON

4. Find the Prefl PAddr preference parameter and replace the current
value between the quotes with avalid |P address. For example:

Pref | PAddr “192.168. 0. 10"

Note If UsePreflPAddr is set to CFF, the PrefIPAddr setting is
ignored and the first system IP addressis used.

5. If you' re finished making changes to the configuration file, close

the text editor, restart FileMaker Server, and log out as the root user.

Opening runtime solutions automatically

Y ou can have FileMaker Server automatically open runtime solution
files that have been bound using FileMaker Developer 5.x.

About FileMaker Developer

FileMaker Developer lets database devel opers create and distribute
complete single user database solutions containing layouts that are
not modifiable by users.

Runtime solution files typically have unique filename extensions.
For example, rather than the standard .fp5 extension, aruntime
solution file might have the extension .cm1. Registering these
runtime solution filename extensionsin the fmserver.conf file
enables FileMaker Server to open these files automatically when
they are placed in the /var/fmserver directory (or subdirectories one
level down).

If you want FileMaker Server to open runtime solutions
automatically, first turn on custom extensions, then specify the
extensions to recognize.

To enable FileMaker Server to open runtime solution files
automatically:

1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseCustomExtensions preference parameter and replace
the current value with ON

UseCust onExt ensi ons ON

4. Find the CustomExtensions preference parameter and replace the
current value between the quotes with from 1 to 16 custom file
extensions. Separate each extension with a colon. For example:

QustonExtensions “.cntl: . fregv:.fvgx:.pfc”

Extensions can contain any characters except the double quote
character (*) and can be any length, aslong asthe database file name
and extension don't exceed 256 characters.

5. If you're finished making changes to the configuration file, close
the text editor, restart FileMaker Server, and log out as the root user.



Using reported events and statistics to

track activities

FileMaker Server creates event and statistics log filesto help you
keep track of activities on the server.

The event log (var/log/fmserver/events.log) contains time stamped
information on:

= FileMaker Server start and stop events

= the size of the database cache

= current preference settings from the configuration file
= database files opened and closed by FileMaker Server

= guests that connect to and disconnect from FileMaker Server and
the filesthey access

= guests that are disconnected by FileMaker Server

= pre-defined errors and other unusua conditions that occur when
FileMaker Server isrunning

|
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The statistics log (var/log/fmserver/stats.log) contains realtime
statistical information regarding FileM aker Server usage, such asthe
number of guests connected and the percentage of unsaved cache.

- o
File Sessions Seftings Help
U PICOttn} 9.0
85/15/2001 16:33:56
Date Time Files Users HMet KButes Disk KBytes Cache Hit % Cache Unsaved % Tr
05/15/2001 16:38:18
Date Time Files Users Net kKButes Dizk KButes Cache Hit % Cache Unzaved % Tr.
05/15/2001 16:38:18 Q Q Q Q 100 00 Q
05/15/2001 1638133 31 [} [} 1202 93 [} [}
05/15/2001 16:38:48 21 Q 4 ] 93 Q 24
05/15/2001 16:39:03 31 [} [} 15 100 [} [}
05/15/2001 16:39:18 21 Q Q 15 100 Q Q
05/15/2001 16339133 31 [} [} 15 100 [} [}
05/15/2001 16:39:48 21 Q Q 15 100 Q Q
05/15/2001 16340303 31 [} [} 15 100 [} [}
05/15/2001 16:40:18 21 Q Q 7 100 Q Q
05/15/2001 16340133 31 [} [} 2 100 [} [}
05/15/2001 16:40:43 21 Q Q i 2 100 o] Q
RE Get Help WriteOut Ny Fead File Cut Text
wit W Justify 2| Wheres iz UnCut. Text.

O NEWJ [P} konsole 1o 1

Statistics log

For more information about interpreting information in the statistics
log, see “Viewing usage statistics for FileMaker Server” on
page 7-7.

Setting a size limit and the location of the event log
To set asize limit and change the location for the event log:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the MaxEventL ogSi ze preference parameter and replace the
current val ue between the quotes with avalue between 1 and 40 MB.
For example:

MaxEvent LogSi ze 10

The default setting is 1 MB. If the log file grows to within 5 KB of
the size set in the configuration file, the log is backed up in afile
named events.log.old in the log directory and anew log fileis
created.
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4. Find the EventL ogPath preference parameter and replace the
current value between the quotes with the path where you want to
store the event log file. For example:

Event LogPath “/var /| og/ MKTG DB_Server/events. | og”
The default path is /var/log/fmserver/events.log.

5. If you're finished making changes to the configuration file, close
the text editor. If you changed only the size of the event log, reload
the configuration file. If you changed the location of the event log,
restart FileMaker Server. Then log out as the root user.

Creating a statistics log

You can create alog file to collect statistical information about
FileMaker Server and set the time interval (in seconds) when
statistical information is written to the log. Y ou can also set a
maximum size for the log file.

First you turn on the statisticslog so alog file is created and updated
asstatistical information is collected. Then set thelocation of thelog
file, the collection interval, and maximum size, if you want.

To save usage statistics for FileMaker Server in alog file:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseStatsl og preference parameter and replace the
current value with O\

UseStat sLog ON

4. Find the StatsL ogPath preference parameter and replace the
current value between the quotes with the path where you want to
store the statistics log file.

StatsLogPath “/usr/MKTG DB Server/stats.|og”
The default path is /var/log/fmserver/stats.log.

5. Find the StatsTimelnterval preference parameter and replace the
current value with a value between 15 and 300 seconds. For
example:

StatsTinelnterval 20
The default setting is 15 seconds.

6. Find the MaxStatsL ogSize preference parameter and replace the
current value with a value between 1 and 40 MB. For example:

MaxSt at sLogSi ze 20

The default setting is 1 MB. If the log file grows to within 5 KB of
the size set in the configuration file, the log is backed up in afile
named stats.log.old in the log directory and anew log file is created.

7. If you' re finished making changes to the configuration file, close
the text editor. If you changed the location of the event log, restart
FileMaker Server. Otherwise, reload the configuration file. Thenlog
out as the root user.

Using FileMaker Server with a
directory service

If your organization uses a Lightweight Directory Access Protocol
(LDAP)-compliant directory service, such as Microsoft Active
Directory, Netscape Directory, or OpenLDAP, you can centrally
manage your hosted databases by registering FileMaker Server with
your directory service.

When FileMaker Server isregistered with an LDAP-compliant
directory service, the host name and | P address are published to the
directory service. The FileMaker Server administrator's contact
information can also be published.

For information about setting up a directory service, see the
Directory Service directory on the FileMaker Server CD.



Enabling directory service registration

Toregister FileMaker Server with adirectory service, you need to set
the following preferences in the configuration file:

= gpecify the fully-qualified domain name or IP address of the
directory service

= specify an account name and password for directory service access

= verify and possibly change the port number used to access the
directory service

= register the distinguished name for FileMaker Server in the
directory service

In addition, you can optional ly publish your contact information with
the directory service. Thisway, the directory service administrator
can contact you if, for example, hosted databases are unavailable for
guest access.

Y our system administrator should be able to give you the
information you need to complete the required directory service
preference settings.

To enable FileMaker Server to register with adirectory service:
1. Switch to the root user and enter the root password.
2. Using your text editor, open the fmserver.conf file.

3. Find the UseDirectoryService preference parameter and replace
the current value with ON

UseDirectoryService ON

4. Find the DirectoryService.ServerName preference parameter and
replace the current val ue between the quotes with the domain name
of the directory service or IP address of the directory server. For
example:

Direct oryServi ce. Server Nane “17.184.8. 9"
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5. Find the DirectoryService.LogonRequired preference parameter
and replace the current value with ON

Di rect oryServi ce. LogonRequi red ON

6. Find the DirectoryService.AcctName preference parameter and
replace the current val ue between the quotes with your account
name. For example:

Di rect oryServi ce. Acct Nane “My_Conpany”

7. Find the DirectoryService.Password preference parameter and
replace the current value with CN

Direct oryServi ce. Password ON

8. Find the DirectoryService.LdapServerPort preference parameter
and replace the current value with the port number of your directory
service. For example:

Di rect oryServi ce. LdapServerPort 300

The default setting is 389. The port number setting indicatesthetype
of the port required by your directory service. For example, 389
indicates an LDAP server port, but some L DAP-compliant directory
services use a different port number.

9. Find the DirectoryService.DistinguishedName preference
parameter and replace the current val ue between the quotes with
your distinguished name. For example:

Direct oryServi ce. Di stingui shedNane” ou=fi | enaker,
dc=donai nnane, dc=coni

The distinguished name indicates where FileMaker Server is
registered or located in the directory service.

10. If you' refinished making changesto the configuration file, close
the text editor.

11. If you enabled the DirectoryService.Password preference
parameter, use the fmspasswd utility to encrypt aremote
administration password, as described in “Using the fmspasswd
utility to encrypt passwords’ on page 9-11. Then restart FileMaker
Server and log out as the root user.
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Publishing your contact information to your
directory service

Asthe FileMaker Server administrator, you can publish your name,
location, phone number, and e-mail address to your directory
service. Thisisuseful if the directory service administrator needs to
contact you.

To publish contact information for the FileMaker Server
administrator:

1. Using your text editor, open the fmserver.conf file.

2. Find the DirectoryService.Owner preference parameter and
replace the current val ue between the quotes with your
administrator’ s name. For example:

Direct oryServi ce. Oamer “Sophi e Tang”

3. Find the DirectoryService.L ocation preference parameter and
replace the current val ue between the quotes with the physical
location of the server computer. For example:

DirectoryService. Location “Conmputer roomin bldg 1

4. Find the DirectoryService.Phone preference parameter and
replace the current val ue between the quotes with your phone
number. For example:

D rectoryServi ce. Phone “408- 555-1234"

5. Find the DirectoryService.Email preference parameter and replace
the current value between the quotes with your e-mail address. For
example:

DirectoryService. Emai | “sophi et ang@ry_conpany. cont

6. If you're finished making changes to the configuration file, close
the text editor, restart FileMaker Server, and log out as the root user.



Chapter 10
Manually installing the Server Administration
plug-in on a remote computer

Note The Server Administration plug-ins are installed in the
AutoUpdate folder by default and can be automatically downloaded
to aremote computer. For more information, see “ Automatically
downloading the Server Administration plug-in to aremote
computer” on page 7-6.

About the Server Administration plug-in

To have full administrative capabilities when administering
FileMaker Server from aremote computer (a computer that is not
running the server software), you must install the Server
Administration plug-in on each remote computer you plan to usefor
remote administration.

In addition to viewing information about databases, guests, and
FileMaker Server activities, the plug-in also lets you use aremote
computer to:

= open FileMaker Pro 5.x files for access by FileMaker Pro guests
through FileMaker Server

= close files hosted by FileMaker Server
= disconnect a selected FileMaker Pro guest from one or al hosted
files

= send messages to guests of hosted files

Before you can use FileMaker Pro 5.x to administer files hosted by
FileMaker Server, you must use FileMaker Pro to enable the Server
Administration plug-in (see page 10-2 for Windows procedure or
page 10-3 for Mac OS procedure), and use FileMaker Server to
enable remote administration (see page 6-9).

For information about using remote administration, see chapter 7,
“Administering FileMaker Server (Windows and Mac OS).”

Manually installing the plug-inona
remote computer (Windows NT and
Windowvs 2000)

1. Exit all other applications and turn off virus protection utilities.

2. Install FileMaker Pro 5.x on the remote computer, if it’s not
aready installed.

3. Insert the FileMaker Server CD into your CD or DVD drive.
4. Double-click setup.exe.

Y ou see the FileMaker Server Setup Wizard.

5. Click Next.

6. Read the license agreement. |f you agree to these terms, select |
accept the terms in the License Agreement, then click Next.

7. Type your name and organization, and indicate who can access
FileMaker Server from this computer (only you or anyone who uses
the computer). Then click Next.

8. Select Custom, then click Next.
Y ou see the Custom Setup screen in the Setup Wizard.

9. Click the disk icon to the left of FileMaker Server and choose This
feature will not be available.

10. Click the disk icon to the | eft of FileMaker Server Examples and
choose This feature will not be available.
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11. Click the disk icon to the | eft of FileMaker Server Remote
Administration and choose This feature will be installed on local hard
drive, then click Next.

12. Click Install.
The Installer installs the plug-in (fmpsadm.fmx) on your hard disk.

The Installer checksif FileMaker Pro 5.x isinstalled on the remote
computer. If the Installer finds FileMaker Pro 5.x, it uses the
FileMaker Pro 5.x path as the default location for the Server
Administration plug-in. If FileMaker Pro 5.x is not found, the
Installer sets the default installation path to:

Program Files\FileM aker\FileMaker Pro 5.x\System

13. Click Finish to close the Setup Wizard.

Manually installing the plug-in onaremote
computer (Windows 95 or Windows 98)

1. Exit all other applications and turn off virus protection utilities.

2. Install FileMaker Pro 5.x on the remote compuiter, if it's not
already installed.

3. Insert the FileMaker Server CD into your CD or DVD drive.
4. Double-click setup.exe.

Y ou see the FileMaker Server Setup Wizard.

5. Click Next.

6. Read the license agreement. If you agree to these terms, select
| accept the terms in the License Agreement, then click Next.

7. Type your name and organization, then click Next.
Y ou see the Custom Setup screen in the Setup Wizard.

8. Click the disk icon to the |eft of FileMaker Server Remote
Administration and choose This feature will be installed on local hard
drive, then click Next.

9. Click Install.

The Installer installs the plug-in (fmpsadm.fmx) on your hard disk.

The Installer checksif FileMaker Pro 5.x isinstalled on the remote
computer. If the Installer finds FileMaker Pro 5.x, it uses the
FileMaker Pro 5.x path as the default location for the Server
Administration plug-in. If FileMaker Pro 5.x is not found, the
Installer sets the default installation path to:

Program Files\FileM aker\FileM aker Pro 5.x\System

10. Click Finish to close the Setup Wizard.

Enabling the Server Administration plug-in
using FileMaker Pro (Windows)

To enable the Server Administration plug-in:

1. Start FileMaker Pro 5.x.

2. Choose Edit menu > Preferences > Application.

3. Click the Plug-ins tab, select Server Administration, then click OK.

If you want to administer FileMaker Server now, see “Enabling
remote administration” on page 6-9 and “ Opening the Remote
Administration window” on page 7-6. Otherwise, choose

File menu > Exit to exit FileMaker Pro.

Manually installing the Server
Administration plug-in on a remote
computer (Mac 0S)

Note You must berunning Mac OS7.6.1t09.1 or Mac OS X onthe
remote computer to install the Server Administration plug-in.

Toinstall the Server Administration plug-in on a computer running
the Mac OS:

1. Quit all other applications, especialy virus protection software,
and disable file sharing.
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2. Install FileMaker Pro 5.x on the remote computer, if it’s not
aready installed.

3. Insert the FileMaker Server CD into your CD or DVD drive.

Y ou seethe CD window on your screen. If you see only thediscicon,
double-click the icon to open its window.

4, Double-click the Installer icon named Start Here Mac OS Classic or
Start Here Mac OS X.

Start Here Mac 05 Classic

5. Read the license agreement. If you agree to these terms, click
Accept.

Y ou see the FileMaker Server Installer dialog box.
6. Click Easy Install and select Custom Install.

e

| « Easy Install
Select Custom Install w

perr————— 1 1]
‘- FileMaker Server 5.5

Note The Easy Install/Custom Install menu does not appear if you are
running aversion of Mac OS prior to 8.6.

7. Select FileMaker Server Remote Administration.

Start Here Mac 05 Classic =—""c——"r——=FHIH
Custom Install B
O FileMaker Server 5.5 [=]
O FileMaker Server Examples
Select the & Filemaker server Remote Administration

plug-in

rvailable: 250,580k Approximate disk space needed: B0k

Install

et Server 55" will be created on the

Install Location: | Hard Disk i

The plug-in must be installed in the FileMaker Extensions folder in
the FileMaker Pro 5.x folder. If FileMaker Pro 5.x isinstalled, the
FileMaker Server Installer locates this folder on your hard disk and
installsthe Server Administration plug-inthere. If FileMaker Pro 5.x
isnot installed on your computer, the Installer creates the following
folder and installs the plug-in here:

hard_disk:FileMaker Pro 5.x folder:FileMaker Extensions
8. Click Install.
9. Click Quit to leave the Installer when the installation is finished.

10. If you turned off virus protection and file sharing before
installation, turn them back on now.

Enabling the Server Administration plug-in
using FileMaker Pro (Mac OS)

To enable the Server Administration plug-in:
1. Start FileMaker Pro 5.x.

2. Choose Edit menu > Preferences > Application (Mac OS 8.6 t0 9.1)
or FileMaker Pro menu > Preferences > Application (Mac OS X).

3. Click the Plug-ins tab, select Server Administration, then click OK.

If you want to administer FileMaker Server now, see “Enabling
remote administration” on page 6-9 and “ Opening the Remote
Administration window” on page 7-6. Otherwise, choose File
menu > Quit (Mac OS 8.6 to 9.1) or FileMaker Pro menu > Quit
FileMaker Pro (Mac OS X) to quit FileMaker Pro.
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Appendix A
Technical specifications and optimization

Limits for files and usage

Item Maximum setting

Number of fileshosted by 125 files, depending on the Maximum number of

FileMaker Server files to host (Windows and Mac OS) or MaxFiles
(Red Hat Linux) setting. (Other network
applications may limit this number.)

Number of files open at the 50 per FileMaker Pro 5.x guests
sametime

Number of network users 250 guests. (AppleTalk support islimited to 124
simultaneousguests.) Y ou can restrict the number
of simultaneously connected guests with the
Maximum number of simultaneously connected
guests (Windows and Mac OS) or MaxGuests
(Red Hat Linux) setting. Specifying arealistic
number of guests fewer than 250 can optimize
performance.

Filesize 2 GB (gigabytes) per file. The combined size of
all openfilesislimited only by disk space.

Length of host name 31 characters

Length of FileMaker Server 31 characters
password

Windows: 255 characters

Note To open thefilesin FileMaker Server, the
first 31 characters of the filename must be unique.

Mac OS: 31 characters
Red Hat Linux: 256 characters

Length of filename

Hardware and network considerations

Keep the following points in mind when you’ re setting up
FileMaker Server on your computer and configuring the network
whereit will run.

Use a dedicated computer

Use FileMaker Server by itself on acomputer on which no other
applications are normally running and that isn’t auser’s primary
workstation. When FileMaker Server is hosting many guests or a
large number of databasefiles, it usesahigh level of processor, disk,
and network capacity. Other processor-intensive applications or
heavy network traffic on the same computer causes

FileMaker Server to run more slowly, and the performance of
FileMaker Pro on guest computers to degrade.

Use as fast a computer as possible
The faster the computer, the better the performance of
FileMaker Server.

= Windows and Red Hat Linux: FileMaker Server requires at
minimum a Pentium processor.

= Mac OS: FileMaker Server requires at minimum a PowerPC
processor.
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Use afast hard disk

Because of the way FileMaker Pro stores information in files,
FileMaker Server benefits agreat deal from fast disk input/output.
Try to use ahard disk with software (or drivers) that supports
asynchronous disk 1/0. Thistechnology lets FileMaker Server
perform other operations after starting aread or write operation on a
file, rather than having to wait for the disk I/O to complete. If
FileMaker Server can take advantage of asynchronous 1/0 when
opening afile, it notesit in the corresponding log file entry. (See
“Using reported events to track activities’ on page 7-18 (Windows
and Mac OS) or “Using reported events and statistics to track
activities’ on page 9-13 (Red Hat Linux) for more information.) To
determine whether your hardware supports asynchronous /O, refer
to the documentation that came with your hardware.

Use a fast network

Mac OS: If possible, use a network faster than Local Talk, such as
Ethernet.

Software considerations

Consider the following issues when deciding which software to use
with FileMaker Server.

Only FileMaker Pro 5.x databases can be hosted

FileMaker Server 5.5 supports only FileMaker Pro 5.x databases.
Therefore, any existing databases you have from a previous version
of FileMaker Pro must be converted to FileMaker Pro 5.x format
before you can host them using FileMaker Server 5.5.

Coexistence with screen saver software

Avoid using screen saver softwarethat creates moving imageson the
monitor of the computer running FileMaker Server. This type of
software can use significant system resources, which hinders the
processing of FileMaker Server networking traffic. Instead, use a
screen saver that blacks out your monitor or dimsits brightness, or
manually dim the monitor.

Turn off file sharing

Make sure operating system file sharing is turned off on the server
computer.

Coexistence with AppleShare software (Mac OS 8.6t09.1)

Running AppleShare software (including AppleShare and
AppleShare Pro) and the FileMaker Server application on the same
computer is not recommended. If you must use that configuration,
keep the following information in mind:

= Limit connected AppleShare users.

Users connected to an AppleShare server through the AppleTak
protocol occupy a physical connection to the server known as an
AppleTalk socket. AppleTalk sockets are aso used by

FileMaker Server when guests access a hosted file using the
AppleTalk protocol. If many users are connected to the AppleShare
server and are occupying these AppleTak sockets, fewer socketsare
available to FileMaker Server running on the same computer. This
could cause FileMaker Pro guests using the AppleTalk protocol to
receive amessage indicating that they have exceeded host capacity,
which prevents them from accessing hosted databases on the server
even if server limit requirements on page A-1 haven’t been reached.

= Use athird-party server access monitoring utility to keep the
number of AppleShare connections to a minimum and to allow only
active connections.



Thislets FileMaker Server use the maximum number of sockets for
guests of FileMaker Pro files. For more information about
configuring AppleShare software, see your AppleShare
documentation.

Don't allow the server to sleep (Windows 2000 and Mac OS)

Windows 2000 supports Power Conservation Mode, which can
cause your computer to hibernate or enter Standby mode, affecting
the operation of FileMaker Server. Similarly, computersrunning the
Mac OS can suspend operations when they enter an energy-saving
system sleep state. Therefore, FileMaker, Inc. recommends that you
disable Power Conservation mode (Windows 2000) or system sleep
(Mac OS) on the computer running FileMaker Server. For more
information, see “How FileMaker Server behaves during system
deep (Windows 2000 and Mac OS)” on page 6-17.

Technical specifications and optimization

A-3
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Appendix B
Performance and usage tips

Performance tips

If you find that FileMaker Server is sluggish when performing
certain operations, try the following:

= Run FileMaker Server on a dedicated computer.
= Use asfast acomputer and network as possible.

= Always use remote administration to perform administrative tasks
on hosted files, such as sending messages to connected guests.

= Reduce the number of guests ableto access FileMaker Server. See
“ Setting the number of guests’ on page 6-3 (Windows and Mac OS)
or “ Setting the number of guests’ on page 9-6 (Red Hat Linux).

= Reduce the maximum number of files that can be hosted by
FileMaker Server. See “ Setting the maximum number of files’ on
page 6-5 (Windows and Mac OS) or “ Setting the maxi mum number
of files” on page 9-7 (Red Hat Linux).

= Monitor the cache hit percentagein usage statistics. Y ou can view red-
time usage gtatistics using the Performance Monitor (WindowsNT),
System Monitor (Windows 2000), or the Usage Statistics window

(Mac 0S 8.6t0 9.1 or remote administration).

The value for Cache Hits is the percentage of times FileMaker Pro
retrieves data from the cache (RAM) rather than the hard disk.
Reading datafrom RAM is much more efficient than reading it from
the hard disk, so thisvalue should be ahigh number, like 90 or 95. If
it isn’t, you might need to allocate more memory to

FileMaker Server.

FileMaker Server tracksthreevaluesfor Cache Hits: Current, Average,
and Peak. It’ s best to monitor the Current value periodically, as an
average value can be skewed by running even one data-intensive
report on a hosted database.

= Monitor the percentage of unsaved cache in usage statistics. This
valueindicates how much datacould potentially belost if your server
computer shut down unexpectedly before writing data stored in
cache to the hard disk.

The percentage reported isthe portion unsaved in the total cache. For
example, if the cacheis set to 2 MB and the Cache Unsaved % value
is 50, you would lose 1 MB of data should your computer fail
unexpectedly.

If the Cache Unsaved % value is consistently high, increase the

frequency with which the cache is flushed, or schedule backups that
occur more often. For more information about changing cache flush
frequency, see “ Setting how often the cacheis flushed” on page 6-7.

= Don't collect statistical information too frequently. FileM aker, Inc.
recommends setting the coll ection rate no lower than 15 seconds. For
more information, see “Recording usage statistics and

setting size limits’ on page 6-12 (Windows and Mac OS) or
“Creating a statisticslog” on page 9-14 (Red Hat Linux).

= Perform cal culation-intensive operations on a small found set.
Sorting, replacing data, viewing and printing summary report
layouts, and other cal culation-intensive operations performed on
many database records affect the overall performance of

FileMaker Server for connected guests. Try to perform thesetypes of
operations on a smaller found set of only the records you're
interested in. (See the FileMaker Pro 5 User’s Guide for more
information about using found sets.) In addition, it’ s best to schedule
these types of operations to be performed during low usage periods.
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= Avoid automatic file compression. If the hard disk runs out of
space while afileis being modified or if a database file reaches the
2 GB sizelimit, FileMaker Server will automatically begin
compressing the hosted file to reduce the amount of disk space it
uses. During the compression, all guest activity to that fileis paused.
To avoid automatic compression, leave plenty of free hard disk space
on the computer running FileMaker Server and monitor databasefile
sizes.

= Enable FileMaker Server to open files automatically. Put database
files you want FileMaker Server to host in the same folder as
FileMaker Server (and subfoldersonelevel down) to take advantage
of the application’s ability to open these files automatically on
startup and when remote administration is enabled.

= Avoid using FileMaker Server on the same computer that is
operating as afile server as performance will be significantly
decreased for both services.

= |ncreasethe cache sizein the Properties (Windows) or Preferences
(Mac OS) dialog box or CacheSize preference parameter (Red Hat
Linux). See “Changing the amount of memory used by

FileMaker Server” on page 6-5 (Windows and Mac OS) or
“Changing the amount of memory used by FileMaker Server” on
page 9-7 (Red Hat Linux) for details.

= Verify that no other processor-intensive programs or applications
that create ahigh level of network traffic are being used on the
computer running FileMaker Server. Examples of software that can
cause performance problems for FileMaker Server include screen
savers, Internet Information Server (Windows), or SQL Server
(Windows).

Windows: Consider using either the L ogon screen saver or the Blank
Screen screen saver that is available with Windows.

= Don't use personal filesharingto share FileMaker Profiles. Guests
should access hosted FileMaker Pro files using the Hosts button in
the Open dialog box in FileMaker Pro.

Usage tips

= FileMaker Server can host FileMaker Pro 5.x files created on
either the Windows or Mac OS platform, but the files should reside
in the FileMaker Server 5.5 folder (Windows and Mac OS) or /var/
fmserver (Red Hat Linux) and subfolders or subdirectory one level
down. With Windows, you can have the filesin other foldersif you
place shortcuts to the FileMaker Pro files (or to folders containing
FileMaker Profiles) intheFileMaker Server 5.5folder. Y ou canaso
drag database files on top of the fmserver.exe (Windows) or
FileMaker Server (Mac OS8.6t0 9.1) applicationicon to open them.

= Windows: If you modify the .fp5 extension of aFileMaker Profile,
FileMaker Server can't automatically open the file when started. To
open files with modified filename extensions:

= Register the non-standard file extension using the File Type
properties (see page 6-8) and placethefileinthe FileMaker Server
5.5 folder (and subfolders one level down) so it opens when the
FileMaker Server service starts.

= Manually drop thefilewith the non-standard extension on top of
the FM Server.exefile.

= Use the command line to open the file with the non-standard

extension. For more information about command line options, see

“Using the command line to automate tasks (Windows)” on

page 8-8.
= Red Hat Linux: If hosted databasefileshave custom file extensions
(something other than .fp5), FileMaker Server can’t open them
automatically when it starts unless you register thefile extensionsin
the FileMaker Server configuration file (fmserver.conf). For more
information, see “Opening runtime solutions automatically” on
page 9-12.

= |f you have duplicate filenamesin the FileMaker Server 5.5 folder
and subfolders one level down, FileMaker Server opensthe first
copy it finds.



= FileMaker Server administration allows several operations to be
performed simultaneously on all of thefilesin asingle subfolder. For
example, you can use Pause, Resume, Close, and Open from the
command line, or you can use Back up and Send Message from a
scheduled task (Windows and Mac OS). To take advantage of this
feature, place related databases into the same subfolder. When
FileMaker Server is started, these files are hosted as a group.

= Up to amaximum of 125 files can be made accessible to
FileMaker Pro 5.x guests on the network. Each FileMaker Pro guest
can open amaximum of 50 files. Since FileMaker Server can host up
to 125 files, it is possible to have multiple files available for access
by multiple workgroups.

= Remember that double-clicking aFileMaker Profile opensthat filein
FileMaker Pro 5.x, not FileMaker Server. See “Hosting

FileMaker Pro 5.x files” on page 7-8 (Windows and Mac OS) or
“Administering FileMaker Server” onpage 9-1 (Red Hat Linux) tolearn
about opening fileswith FileMaker Server.

= FileMaker Server displays amessage if it can’t open the selected
database file and writes a description of the problem to the
Application Log (Windows) or the server event log (Mac OS) or
Ivar/log/fmserver/events.log (Red Hat Linux). For more
information, see “Using reported events to track activities’ on
page 7-18 (Windows and Mac OS) or “Using reported events and
statistics to track activities’ on page 9-13 (Red Hat Linux).

= |f the database file you' re hosting uses the Today function to
calculate dates, you must close and reopenit using FileM aker Server
each day to update the dates correctly. See“ Recal culating the Today
function in hosted databases’” on page 7-20 for more information.

Performance and usage tips

B-3
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Appendix C

Event log messages and troubleshooting

FileMaker Server event log messages

Thefollowingisalist of some of thelog file messagesyou might see
and an explanation. Variables, such as the name of the user or file,

areinitalics.

Message

Explanation

AppleTalk network initialization failed; an unexpected error
occurred (error number)

FileMaker Server couldn’t initialize AppleTalk due to an unexpected operating system error. See your
operating system documentation for an explanation of the specified error. Check the AppleTalk configuration
and reconfigure or reinstall, if needed.

AppleTalk network initialization failed; not enough memory

There isinsufficient memory to use AppleTalk. See “What you need” on page 3-1 for RAM requirements.

AppleTalk network initialization failed; protocol not installed

Check the network installation and setup procedures in the operating system documentation and reinstall the
protocol, if necessary.

Closing file filename due to a serious error (error number)

The specified file is being closed by FileMaker Server due to an error condition. The file may need to be
recovered in the FileMaker Pro 5.x application. See “ Troubleshooting” in FileMaker Pro 5.5 Help for
information about recovering damaged files.

Could not pause file filename because of an outstanding
database lock from guest guestname

FileMaker Server istrying to get exclusive use of the file to pause it for an operation (for example, a backup
or cache flush), but can’t because aguest is changing the file. Y ou can try the backup later, or closethefileto
force the guest(s) to disconnect.

File could not be opened: database may be damaged; try
opening in FileMaker Pro

The file may be damaged and needs to be opened in FileMaker Pro 5.x. Start the FileMaker Pro application,
open the file, and follow any instructions on your screen. (See “ Troubleshooting” in FileMaker Pro 5.5 Help
for more information about recovering files.) Then try opening the file with FileMaker Server.

File could not be opened: must be set to Multi-User in
FileMaker Pro

FileMaker Server can’t open files set to single user by default. However, you can select Allow FileMaker Server
to host Single User files in the Files tab of the Properties dialog box (Windows) or the Preferences dialog box
(Mac OS) or enable the HostSingleUserFiles preference parameter (Red Hat Linux) to open the file without
changing it using FileMaker Pro. Alternatively, you can open thefilein the FileMaker Pro 5.x application and
choose File menu > Sharing > Multi-User before opening it with FileMaker Server.

File filename full, compression started

When a FileMaker Pro file approaches the 2 GB file size limit or there is no longer enough free space on the
hard disk, FileMaker Server attempts to compressit by reclaiming unused space in the file. This processis
automatic, and this message is written to the log file when the process begins.
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Message

Explanation

File filename compressed, freeing x blocks

The specified file has been successfully compressed, leaving FileMaker Server enough room to continue
working with the file safely. (One block equals 1,024 bytes.)

File filename compressed, but still nearly full. Only x block(s)
free

The specified file was compressed, but there isn’t enough room for FileMaker Server to continue safely
working with the file. The administrator should close the file, back it up, and take steps to reduce the size of
the file and create more room on the hard disk.

FileMaker Server is now awake. All schedules will be
resumed.

This message is sent to the log by FileMaker Server when the server computer wakes up from hibernation
(Windows 2000) or system sleep mode (Mac OS). Files that were hosted by FileMaker Server before
hibernation or sleep occurred are now available for guest access once again.

FileMaker Server is going to sleep. The entire cache will be
flushed. All schedules will be suspended.

If the server computer is configured to sleep during periods of inactivity, before doing so the operating system
prompts each open service or application to find out if the service or application can accommodate sleep mode.
If any guests are currently connected to a hosted database, FileM aker Server denies the sleep request and the
server computer does not sleep. If no guests are connected, FileMaker Server writes any unsaved changes to
disk (flushes the cache) and allows the server computer to sleep. During sleep, all scheduled tasks are
suspended and do not run again until the next scheduled time when the server computer is awake.

FileMaker Server quitting! (error number)

FileMaker Server detects a severe error during network use, due to a network failure or other causes. Check
network installation, settings, and the system error log (Windows).

FileMaker Server quitting! Network initialization failed; an
unexpected error occurred

FileMaker Server can't use any network protocol because of an unexpected error. Check network installation,
settings, and the system error log (Windows).

FileMaker Server quitting! Network initialization failed; not
enough memory

FileMaker Server can't use any network protocol due to insufficient memory. See “What you need” on
page 2-1 (Windows), page 3-1 (Mac OS 8.6 to 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for
RAM requirements.

FileMaker Server quitting! This disk is full

FileMaker Server detects that the disk volumeis full. Free some space on the disk and restart
FileMaker Server.

FileMaker Server quitting! Network initialization failed
(error number)

FileMaker Server is unable to start because of missing required software or hardware. See “What you need”
on page 2-1 (Windows), page 3-1 (Mac 0S8.6t09.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for
more information.

Quit forced; User username forced to close connection
(error number)

During a shutdown or disconnect operation, the named user didn’t close the file within the specified time. The
user’s connection was forcibly closed by FileMaker Server.

Registration with directory service failed. (error number)

Registration with the directory service failed because Microsoft Active Directory is not installed on this
computer.

Remote administration has been disabled because the
databases could not be opened (error number)

The system’ s storage area for temporary files might be full or set to read-only. Check the temporary storage
area on the server computer and try again.
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Explanation

Schedule schedulename aborted; destination could not be
found

The specified destination could not be found. If the destination isaremovable medium, make sureit isinserted
initsdrive. If the destination volume is an external or network drive, connect the drive or network. Try again
after the destination is correctly set up.

Schedule schedulename aborted; the destination
destination is not writable

The specified destination islocked or read-only. If the destination is aremovable medium, you might need to
remove it, make it writable, and reinsert it.

Schedule schedulename aborted; no open databases to
operate on

The schedule specifies adirectory in which FileMaker Server currently has no databases open. Therefore, the
schedul ed task can't proceed. Make surethat the schedul e specifiesthe correct directory to operate on, and that
all databases have been opened correctly.

Schedule schedulename was unable to back upfile filename;
can't replace item with that name on destination

When FileMaker Server backs up afile, it first checksif afile with the same name aready exists on the
destination volume and attemptsto renamethe existing file. In this case, the existing file could not be renamed,
and therefore it could not be replaced with the new backup. Move the existing file to another location or give
it aname that doesn’t conflict with the file being backed up.

Schedule schedulename was unable to back up file filename;
error writing to destination (error number)

An unexpected operating system error occurred when FileMaker Server attempted to copy filesto the
destination volume. Refer to the system error log or look up the specified error number in your operating
system documentation to determine the cause of the problem.

Schedule schedulename was unable to back upfile filename;
file on destination is locked

The named file already exists on the destination volume and islocked or read-only. For the backup to succeed,
you need to either move the locked/read-only fileto adifferent folder or change the schedul e definition to use
adifferent destination. The file could also be open by another application, in which case it must be closed
before it can be moved or renamed.

Schedule schedulename was unable to back upfile filename;
not enough free space on destination

The destination volume does not have enough free space to hold a copy of the specified file. Check the free
space on the destination or choose a different destination for the backup.

TCP/IP network initialization failed; an unexpected error
occurred (error number)

FileMaker Server couldn’tinitialize TCP/I P dueto an unexpected operating system error. Seethe system event
log (Windows) or your operating system documentation for an explanation of the specified error. Check the
TCP/IP configuration and reconfigure or reinstall, if needed.

TCP/IP network initialization failed; the TCP/IP address is
already in use or an address could not be obtained
(error number)

The IP address selected for use by FileMaker Server isalready in use or isn’t correctly configured.Verify the
IP address and TCP/IP configuration in the Networks control panel (Windows) or TCP/IP control panel (Mac
0S 8.6t09.1) or TCP/IP preferences (Mac OS X). If FileMaker Pro 5.x is already running on the same
computer and isset to use TCP/IP, FileMaker Server is prevented from using the same | P address. Y ou should
run FileMaker Server on a dedicated computer.

TCP/IP network initialization failed; not enough memory

Thereisinsufficient memory to use TCP/IP. See“What you need” on page 2-1 (Windows), page 3-1 (Mac OS
8.6 10 9.1), page 4-1 (Mac OS X), or page 5-1 (Red Hat Linux) for RAM requirements.

TCP/IP network initialization failed; protocol is not installed
(error number)

Windows: FileMaker Server can't initialize TCP/IP, because the TCP/IP protocol is not installed or not
configured correctly in the Networks control panel. Check the network installation and setup proceduresin the
Windows documentation and reinstall, if necessary.
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Message

Explanation

IPX/SPX network initialization failed; an unexpected error
occurred (error number)

Windows: FileMaker Server can't initialize IPX/SPX. Check network settings and system error log.

IPX/SPX network initialization failed; not enough memory

Windows: There isinsufficient memory to use IPX/SPX. See “What you need” on page 2-1 for RAM
reguirements.

IPX/SPX network initialization failed; protocol is not installed
(error number)

Windows: FileMaker Server can't initialize IPX/SPX, because the IPX/SPX protocol is not installed or not
configured correctly in the Networks control panel. Check the network installation and setup proceduresin the
Windows documentation and reinstall, if necessary.

User username no longer responding, connection closed

A connected guest’ s computer has stopped communicating with FileMaker Server dueto anetwork disruption
or asoftware error.

Using a database cache size of xK

Written at FileMaker Server startup to show how much of the application’smemory is usable for the database
cache (x isreplaced by a number). Y ou can adjust application memory by changing the Reserve n MB of RAM
for database cache in theFiles tab of the Properties (Windows) or Preferences (Mac OS) dialog box or enabling
the CacheSize preference parameter. The new cache size takes effect the next time you start FileMaker Server.

Mac OS 8.6 t0 9.1: Y ou might have to adjust the application memory size for FileMaker Server using the Get
Info dialog box inthe Finder. For moreinformation, see“ Adjusting memory (Mac OS8.6t09.1)” on page 6-6.
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The following table lists some problems you may encounter when

using FileMaker Server.

Tip When FileMaker Server behaves unexpectedly, check the log
file to diagnose the problem. See “Using reported events to track
activities’ on page 7-18 (Windows and Mac OS) or “Using reported
events and statistics to track activities’ on page 9-13 (Red Hat
Linux) and “FileMaker Server event log messages’ on page C-1 for

more information.

Problems installing or starting FileMaker Server

Symptom

Suggested solution or explanation

You'reunableto install FileMaker Server.

Check the hardware and software requirements listed in “What you need” on page 2-1 (Windows), page 3-1
(Mac 0S8.6109.1), page4-1 (Mac OS X), or page 5-1 (Red Hat Linux) to ensure your equipment and software
are compatible.

Windows, Mac OS X, and Red Hat Linux: Be sureto log in with administrative privileges when checking for
compatibility.

You're unable to start FileMaker Server.

Check the hardware and software requirements listed in “What you need” on page 2-1 (Windows), page 3-1
(Mac 0S 8.6t09.1), page 4-1 (Mac OS X), page 5-1 (Red Hat Linux) to ensure your equipment and software
are compatible. Also check the Windows Event Viewer, the Server Event Log (Mac OS8.6t09.1) or
events.log (Mac OS X and Red Hat Linux) for adescription of why FileMaker Server couldn’t start. For more
information about the Event Viewer, see “Using reported events to track activities” on page 7-18 (Windows
and Mac OS) or “Using reported events and statistics to track activities’ on page 9-13 (Red Hat Linux).

Network problems

Symptom

Suggested solution or explanation

A FileMaker Pro guest using IPX can't find
FileMaker Server databases on the network.

Windows: Verify that IPX networking softwareis properly installed. Verify that the host and guest are using
the same frame type. Verify that the IPX/SPX network protocol (or both TCP/IP and IPX/SPX) is selected in
the Networking tab of the Properties dialog box. Verify that the 250 simultaneous guest limit has not been
reached.
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Symptom

Suggested solution or explanation

A FileMaker Pro guest using TCP/IP can't find
FileMaker Server databases on the network.

Verify that TCP/IP networking software is properly installed on the host and guest computers. In the Hosts
dialog box, click the Specify Hosts button and enter the host | P address.

Windows and Red Hat Linux: Use the Pi ng command to contact the host address and verify the network is
working properly. Verify that the 250 simultaneous guest limit has not been reached.

Windows: Verify that the TCP/IP network protocol (or both TCP/IP and IPX/SPX) is selected in the
Networking tab of the Properties dialog box.

Mac OS: Verify that the TCP/IP network protocol (or both TCP/IP and AppleTalk [Mac OS 8.6 to 9.1]) is
selected in the Networking tab of the Preferences dialog box.

A FileMaker Pro guest using AppleTalk can’t find
FileMaker Server databases on the network.

Verify that the 124 simultaneous guest limit has not been reached. Also remember that AppleTalk is not
supported by FileMaker Server running in Windows or Mac OS X.

Problems on guest computers

Symptom

Suggested solution or explanation

The FileMaker Server name does not appear in the
FileMaker Pro Hosts dialog box.

Hold down the Ctrl key (Windows) or Option key (Mac OS) as you click Hosts in the Open dialog box.
Sometimes with high network traffic, FileMaker Pro might not find the server on the first attempt. Holding
down the Ctrl or Option key forces FileMaker Pro to check the network for alonger period of time.

Windows: Verify that the FileMaker Server serviceis started in the Windows Services control panel.

On a TCP/IP network, you may need to specify the host |P address or name. Click Specify Hosts in the
TCP/IP Hosts dialog box, then type in the I P address or the name of the computer running FileMaker Server.

Guests using the IPX/SPX protocol can't see
FileMaker Server databases.

Windows: Thisisgenerally caused by using anincorrect frame type on the server or guest machine. To change
the frame type on Windows, you must change the configuration of the IPX/SPX compatible protocol in the
Network control panel. See your Windows documentation for more details.

Guests receive Communication with the host was
interrupted and could not be re-established message on
guest computer.

The guest has been disconnected from a database by FileMaker Server because the guest didn’t comply with
areguest from FileMaker Server to close adatabase. Another reason communication between the host and
guest may have been disrupted is due to ahardware failure (lost network connection) or a software connection
time-out (no response from guest for a given period of time). The latter could be caused by a screen saver,
debugger, or processor-intensive operation.

Guests receive servername is no longer available or the

host capacity has been exceeded message on guest
computer.

FileMaker Server has shut down or you reached the maximum allowable connections or guests on
FileMaker Server. Verify that FileMaker Server is running or increase the number of guests allowed in the
Guests tab of the Properties dialog box (Windows) or the Preferences dialog box (Mac OS). See “ Setting the
number of guests’ on page 6-3.
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Suggested solution or explanation

Guests receive Host capacity exceeded message on guest
computer.

Y ou reached the maximum allowable connections or guests on FileMaker Server. Increase the number of
guests allowed in the Guests tab of the Properties dialog box (Windows) or the Preferences dialog box
(Mac OS) or MaxGuests preference parameter (Red Hat Linux). See “ Setting the number of guests’ on
page 6-3 (Windows and Mac OS) or “ Setting the number of guests’ on page 9-6 (Red Hat Linux).

Problems administering remotely

Symptom

Suggested solution or explanation

Y ou're unable to administer FileMaker Server remotely
using FileMaker Pro 5.x.

Check that remote administration is enabled in the Administration tab of the Properties dialog box (Windows)
or Preferences dialog box (Mac OS) or UseRemoteAdmin preference parameter (Red Hat Linux). See
“Enabling remote administration” on page 6-9 (Windows and Mac OS) or “ Enabling remote administrationin
FileMaker Server” on page 9-10 (Red Hat Linux).

If you want full administrative access to FileMaker Server, you must install and enable the Server
Administration plug-in on your remote computer. For more information, see “ Automatically downloading the
Server Administration plug-in to a remote computer” on page 7-6.

The Open, Close, Disconnect, and Get Details buttons are
dimmed in the Remote Administration window.

The Server Administration plug-inisn't installed and enabled on the remote computer. Install and enable the
plug-in and try again. For more information, see “ Automatically downloading the Server Administration plug-
in to aremote computer” on page 7-6.

Problems using command line options (Windows and Red Hat Linux)

Symptom

Suggested solution or explanation

The command you typed didn’t work.

When typing at the command prompt, specify the filename extension (.FP5) after the filename.

Make sure that you are using the correct short filenames, or enclose long filenames that contain spacesin
quotation marks. To see the short filenames, typedi r / x at the prompt.

Y ou can’'t remember command syntax or usage.

Typef mserver /? (Windows) or f nserverd - h (Red Hat Linux) at the prompt to view alist of available
commands.

Windows: Look at the messages in the Windows Event Viewer for tips.
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Appendix D
About the Techinfo database

The Techinfo database is a great resource for technical information
about FileMaker, Inc. products. This FileMaker Pro database serves
asafront-lineresourcefor the company’ s support technicians asthey
solve customer inquiries. It collects Q& As, tips, FAQs, bug reports,
update notes, press releases, templates, and other material valuable

for support professionals. Y ou can access the Techinfo database in

the support area of the official FileMaker, Inc. web site

(www filemaker.com).

Searching the Techinfo database

To locate all information about FileMaker Server in the Techinfo
database, specify FileMaker Server as the product name and start
your search. Y ou can look for more specific articles by adding
additional keywords before searching. For example, including the
word net wor k as akeyword before you search displaysalist of all
Techinfo articles that contain the words “FileMaker Server” and
“network.”

Keep the following search tipsin mind:
m Usethe singular form, for example, host instead of host s.

= Try roots of words. For example, summar instead of summari es
or sunmary.

= Use generic terms. For example, prot ocol instead of TCH | P.

Sample Techinfo article

The following Techinfo article gives you an idea of the kind of
information you will find in the Techinfo database.

@ FileMaker:Support ——— [HIH
e @t 2 =

Stop  Refresh  Home  ©  AutoFill  Print HMail

(@ hitp:r tidb filemaker com

lbr=1012858-token.0=101 28

search
Company
IHTERNATIONAL | JOBS | RESELLERS | LICENSING | SITE MAP

* New To Fiieldaker?

WY FileMaker:

Optimizing Network Performance for Shared
Database:

Article Number: 101295

Date Written: 2/9/1990

Date Last Modified: 4/22/1999

The performance of a FileMaker Pro shared database on a netwark is determined
by many factors. Besides networking hardware and software, structure and design
ofthe database system may effect performance. The best performance from
FileMaker Pro and FileMaker Pro Server can be achieved by implementing as
many ofthe fallowing recommendations as possible

Product Platform:
FileMaker Pro & Macintosh
FileMaker Server 5 Windows
FileMaker Pro 4.

FileMaker Pro 3.x

FileMaker Pro 2x

USE AFAST NETWORK CONNECTION FlleMaker Pro

Local area networks should be standard Ethemet or better. Siower netwarks, such  F1eMaker |l

as LocalTalk, are not fast enough to handle the communication between FileMaker

Pro guests and the host. Remote connections should be via an Ethemet based

connection, such as a T1 line, ADSL or cable modem. Dial-up connections using

modems are extremely slow

LSE TCR/IP PROTOCOL

TCPIIP is faster than IPX/SPX or AppleTalk netwarking protocals. You select TGRS
I in FileMaker Pro by going to Preferences cormand in the File menu. You also
need toinstall and configure TCPAIP drivers in the system software.

@ FileMaker in the Hews

K|

Information on the Web

Y ou can aso find more information, tips, and database ideas by
visiting FileMaker, Inc. on the Web:

Windows: In the FileMaker Server Console, choose View menu >
FileMaker on the Web or point your browser to www.filemaker.com.

Mac OS: In FileMaker Server, choose Help menu > FileMaker on the
Web or point your browser to www.filemaker.com.

Red Hat Linux: Point your browser to www.filemaker.com.
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A
Access privileges
FileMaker Pro (Windows and
Mac OS) 6-17
Linux 9-10
Windows 2-2

Account name, specifying custom for
FileMaker Server (Linux) 9-9
Activities, FileMaker Server
message descriptions C-1
viewing
Linux 9-13
Mac OS 7-20
Windows 2000 7-19
WindowsNT 7-19
Administering
closing files
locally (Linux) 9-2
localy (Mac 0S8.6t09.1) 7-15
remotely 7-9
using command line (Windows) 8-9
disconnecting guests
localy (Mac 0S8.6t09.1) 7-16
remotely 7-10
from different platforms (Windows and
Mac OS) 2-2
local administration (Mac OS 8.6 to 9.1),
described 7-4, 7-12
opening files
localy (Linux) 9-2
locally (Mac 0S8.6t09.1) 7-14
remotely 7-9

using the command line
(Windows) 8-9

Index

sending messages
locally (Mac 0S8.6t09.1) 7-16
remotely 7-11
setting passwords for remote access
Linux 9-10
Windows and Mac OS 6-9
using command line
Linux 9-1-9-2
Windows 8-8-8-10
viewing usage statistics
locally (Mac 0S8.6t09.1) 7-14
remotely 7-8
Administration tab (Windows and
Mac OS) 6-10
Administration window
(Mac 0S8.6109.1) 7-12
Alias, making
Mac0S86t09.1 7-3
MacOSX 7-4
Apple events
support described
Mac0S86t09.1 3-3
using to
closefiles(Mac OS) 7-10

collect statistics
(Mac 0S8.6109.1) 7-8

graph statistics
(Mac 0S8.6t09.1) 6-13
open databases (Mac OS) 7-9
AppleScript
examplefile location
Mac0S86t09.1 3-3

recalculating Today function
(Mac 0S8.6109.1) 7-21

AppleShare software
See also Networks; Performance

coexistence with FileMaker Server
(Mac 0S8.6t09.1) A-2

connections (Mac 0S8.6t09.1) A-2
AppleTak

See also Networks

hosting with (Mac 0S8.6t09.1) 3-1
Application log. See Log files
Assistants (Windows)

configuration 6-1

starting 6-1

task scheduling 8-1
Asynchronous disk I/0  A-2
Auto Update plug-in

Linux 9-8

Windows and Mac OS 6-7, 7-6
AutoUpdate directory, location of

Linux 5-3

Mac0S86t09.1 3-3

MacOSX 4-2

Windows 2-4

B

Backing up database files
running out of disk space 8-10
sample script
Linux 5-2
Windows 2-4
using command line (Windows) 8-9
using FileMaker Server (Windows and
Mac OS) 8-1
Bug reports, lookingup D-1
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C

Cache
flush setting
Linux 9-7
Windows and Mac OS 6-7
hit percentage 7-8
log filemessage C-2, C-4
monitoring B-1
percentage unsaved 7-8
sizeinlog file (Windows) 7-18
viewing percentages locally
(Mac0S8.6t09.1) 7-14
CacheSize preference parameter (Linux) 9-7
chgrp command (Linux) 9-10
chmod command (Linux) 9-10
chown command (Linux) 9-10
ckconfig command (Linux) 9-2
Close command
Linux 9-2
Windows 8-8
Closing files
See also Administering; Disconnecting
guests; Files; Quitting FileMaker Server
locally (Mac 0S8.6t09.1) 7-15
remotely 7-9
using command line (Windows) 8-8
Coffeecupicon 8-10
Columns, resizing and sorting

in local administration window
(Mac 0S8.6t09.1) 7-13

in Schedules list
Mac OS 8-5
Windows 8-4
Command file, running on a schedule
(Windows) 8-1
Command line (Windows)
examples 8-9
samplefiles 8-9

troubleshooting C-7
using 8-8-8-10
Compression, databasefile 8-10, B-2, C-1
Computer, dedicated. See Dedicated host
Configuration application, described
(Mac OSX) 7-3
Configuration assistants (Windows) 6-1
Configuration file (Linux)
applying changes 9-4
editing 9-3
location of 5-2
opening 9-3
reloading 9-2, 9-5
restarting to apply changes 9-5
restoring defaults 9-5
Configuring
applying changes (Linux) 9-4
choosing network protocols
Mac 0S86t09.1 6-11
Windows 6-11
customizing host name
Linux 9-11
Windows and Mac OS 6-10
directory service
Linux 9-14
Windows and Mac OS 6-15
disconnection message
Linux 9-6
Windows and Mac OS 6-4
downloading plug-ins automatically
Linux 9-8
Windows and Mac OS 6-7
flushing cache
Linux 9-7
Windows and Mac OS 6-7
hosting single user files
Linux 9-8
Windows and Mac OS 6-7

idle disconnect time
Linux 9-6
Windows and Mac OS 6-4
IP address
Linux 9-12
Windows and Mac OS 6-12
maximum number of files
Linux 9-7
Windows and Mac OS 6-5
memory considerations (Windows and
Mac OS) 6-1
multiple network cards
Linux 9-12
Windows and Mac OS  6-12
number of guests
Linux 9-6
Windows and Mac OS 6-3
opening configuration file (Linux) 9-3
opening preferences dialog
(MacOSX) 6-3
opening preferences dialog box
(Mac 0S8.6109.1) 6-2
opening properties dialog box
(Windows) 6-2
overview
Linux 9-3
Windows and Mac OS 6-1
remote administration password
Linux 9-10
Windows and Mac OS 6-9
requiring guest authentication
(Windows) 6-4
restoring defaults
Linux 9-5
Windows and Mac OS 6-17
Connections, AppleShare A-2
Console, FileMaker Server (Windows) 6-1

Contents, using in Help (Windows and
Mac OS) viii



Control panel, Services (Windows) 7-1, 7-2
Copying schedules (Windows and
Mac OS) 8-7
Corrupted database (Windows and
Mac OS) 6-17
CPU, maximizing for FileMaker Server
(Mac 0S8.6t09.1) 6-11
Crash, system (Windows and Mac OS) 6-18
Cross-platform issues
documentation notation vii
MacOSX 4-1
Windows and Mac OS 2-2, 3-1
Custom host name. See Host name
Customer support  1-1
CustomExtensions preference parameter
(Linux) 9-12
Customizing FileMaker Server. See
Configuring
CustomServerName preference parameter
(Linux) 9-11

D

Daemon filelocation (Linux) 5-2
Database files. See Files
Dates, incorrect calculation 7-20
Dedicated host
described 1-1, A-1
performance issues (Windows and
Mac OS) 6-11
Default configuration settings, restoring
Linux 9-6
Windows and Mac OS 6-17
Deleting
FileMaker Server (Windows) 2-5
scheduled tasks (Windows and
Mac QOS) 8-7
Dialog boxes, getting Help
Mac OS8.61t09.1 xi
Mac OS X xii

Windows xi

Dimmed icon, in Hosts dialog box (Windows
and Mac OS) 6-10

Directories, described (Linux) 5-2
Directory service
described
Linux 9-14
Windows and Mac OS 6-15
distinguished name, specifying
Linux 9-15
Windows and Mac OS 6-16
encrypting password (Linux) 9-11
port number, specifying
Linux 9-15
Windows and Mac OS 6-17
preference parameters (Linux) 9-15—9-16
publishing contact information
Linux 9-16
Windows and Mac OS 6-16
registering with
Linux 9-15
Windows and Mac OS 6-15

Directory Service tab (Windows and
Mac OS) 6-15
Disabling
remote administration
Linux 9-10
Windows and Mac OS 6-9
scheduled tasks (Windows and
Mac OS) 8-7
Disconnectl dleGuests preference parameter
(Linux) 9-6
Disconnecting guests
See also Administering; Guests
localy (Mac 0S8.6t09.1) 7-16
remotely 7-10
troubleshooting C-6

Index -3

Disconnection message
Linux 9-6
Windows and Mac OS 6-4
DisconnectWarning preference parameter
(Linux) 9-6
Disk
running out of room when backing up
files 8-10
writing guest data
Linux 9-7
Windows and Mac OS 6-7
writing statisticsto log file
Linux 9-14
Windows and Mac OS 6-13
Disk I/0, asynchronous A-2
Disk KB/sec statistics, described 7-8
Distinguished name, specifying for adirectory
service
Linux 9-15
Windows and Mac OS 6-16
Documentation, described vii

DOS command line (Windows) 8-8 —8-10,
C-7

E
Edit Schedule dialog box (Windows and
Mac OS) 8-6
Enabling
remote administration
Linux 9-10
Windows and Mac OS 6-9
scheduled tasks (Windows and
Mac OS) 8-7
Server Administration plug-in manually
Mac OS 10-3
Windows 10-2
Encrypting passwords (Linux) 9-11

Error messages. See Messages; Log files;
Troubleshooting
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Ethernet. See Networks
Event Viewer (Windows)
described 7-18
keeping data current 7-20
message descriptions C-1
EventL ogPath preference parameter
(Linux) 9-14
Events
Seealso Log files
checking for file corruption (Windows and
Mac OS) 6-18
recording
Linux 9-13
Mac OS 6-15
Windows 2000 6-14
WindowsNT 6-14
Exclusive access to hosted files 7-12
Exiting FileMaker Server
See also Quitting FileMaker Server
Windows 2000 7-2
WindowsNT 7-2
Extensions, registering filename
Linux 9-12
Windows and Mac OS X 6-8

F

FAQ for FileMaker Server D-1
Features, new and improved 1-3
File permissions, changing (Linux) 9-10
File sharing
cross-platform issues
MacOSX 4-1
Windows and Mac OS 2-2, 3-1
performance tip (Windows) B-2
File Typestab (Windowsand Mac OS X) 6-8
FileMaker Developer, described 6-8, 6-9,
9-12

FileMaker Pro
changing field definitions in hosted
files 7-12

downloading plug-ins from

Linux 9-8

Windows and Mac OS 6-7
enabling Server Administration plug-in

manually

Mac OS 10-3

Windows 10-2
FileMaker Server, comparison 1-2
filename extensions, registering

Linux 9-12

Mac OS8.6t09.1 6-9

Windows and Mac OS X 6-8
passwordson files 6-17
record-by-record access privileges 6-17
Remote Administration window 7-6
runtime solutions

Linux 9-12

Mac OS8.6t09.1 6-9

Windows and Mac OS X 6-8

FileMaker Server

See also Administering; Configuring
described 1-1-1-3
documentation, described vii
FileMaker Pro, comparison 1-2
files, described

Linux 5-2

Mac OS86t09.1 3-2

Mac OSX 4-2

Windows 2-3
hardware requirements

Linux 5-1

Mac 0OS86t09.1 3-1

Mac OSX 4-1

Windows 2-1

installing
Linux 5-1
Mac0S86t09.1 3-1
MacOSX 4-1
Windows 2-2
limits A-1
network requirements
Linux 5-1
Mac0S86t09.1 31
MacOSX 4-1
Windows 2-1
new features 1-3
optimizing B-1, C-1
performancetips B-1, C-1
registering software license 1-1
samplefiles
Linux 5-2
Mac0S86t09.1 3-2
MacOSX 4-2
Windows 2-4
starting
Linux 9-1,9-2
Mac0S86t09.1 7-3
MacOSX 7-4
using command line (Windows) 8-8
Windows 2000 7-1
WindowsNT 7-1
stopping
Linux 9-1
Mac0S86t09.1 7-3
MacOSX 7-4
using command line (Windows) 8-8
Windows 2000 7-2
Windows NT 7-2
system requirements
Linux 5-1
Mac0S86t09.1 3-1
MacOSX 4-1



Windows 2-1
technical specifications A-1
troubleshooting C-5
FileMaker Server 5.5 directory (Linux) 5-2
FileMaker Server 5.5 folder
Mac OS86t09.1 3-2
Mac OSX 4-2
Windows 2-3
FileMaker Server Help
Baloon Help (Mac 0OS8.6t09.1) xi
command syntax (Linux) 9-1, 9-2
Contents (Windows and Mac OS),
using Vviii
Find, using (Windows and Mac OS) x
for dialog boxes
Mac OS8.6t09.1 xi
Mac OS X xii
Windows xi
for remote administration  xii
for toolbar (Windows) xi
Help topic window (Windows and
Mac OS) viii
Index, using (Windows and
Mac 0S8.6t09.1) ix
navigating (Windows and Mac OS) viii
onscreen quick reference (Linux)  xii
searching for specific words
Mac OS X xi
Windows and Mac 0S8.6t09.1 x
FileMaker, Inc. web site D-1
Filename extensions for runtime solutions
Linux 9-12
Windows and Mac OS X 6-8
Files
backing up (Windows and Mac OS) 8-1
backup example using command line
(Windows) 8-9
closing
localy (Linux) 9-2

locally (Mac 0S8.6t09.1) 7-15
remotely 7-9
using the command line
(Windows) 8-8
compression 8-10, B-2, C-1
corrupted after restart (Windows and
Mac OS) 6-17
filenamelength A-1
hosting single user
Linux 9-8
Windows and Mac OS 6-7
limits A-1
location of related B-2
maximum
number A-1
size A-1
opening
locally (Linux) 9-2
localy (Mac 0S8.6t09.1) 7-14
remotely 7-9
using command line (Windows) 8-8
remote administration databases 7-5
resetting data 7-20
setting location of (Linux) 9-9
size A-1
unabletoopen C-1
viewing
details, remotely 7-11
hosted, locally
(Mac 0S8.6t09.1) 7-13
hosted, remotely 7-7
Filestab (Windows and Mac OS) 6-5
FlushTimelnterval preference parameter
(Linux) 9-8
fmpsadm.fmx (Windows) 10-2
fms _registration utility (Linux) 5-2
fmserver account name, changing (Linux) 9-9
fmserver.exe (Windows) 7-9

Index I-5

FM ServerUser preference parameter

(Linux) 9-10

fmspasswd utility (Linux), using 9-11
fmsvplas.txt file (Windows) 6-13
Folders, described

Linux 5-2

Mac OS8.6t09.1 3-2
Mac OSX 4-2
Windows 2-3

Found sets, optimizing performance B-1
Frame types, troubleshooting C-6

G

Get Details button  7-11, 7-12
Group name, specifying custom for FileMaker

Server (Linux) 9-9

Groups, for FileMaker Pro passwords

(Windows and Mac OS) 6-17

Guests

disconnecting
localy (Mac 0S8.6t09.1) 7-16
remotely 7-10
number of
Linux 9-6
Windows and Mac OS 6-3
sending messages
localy (Mac 0S8.6t09.1) 7-16
remotely 7-11
to all guests, remotely 7-12
using schedule (Windows and
Mac QOS) 8-1
troubleshooting C-6
viewing
details about guests, remotely  7-11
localy (Mac 0S8.6t09.1) 7-13
remotely 7-7

Guests tab (Windows and Mac OS) 6-3
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H

Hardware requirements

See also Memory; System requirements;
Troubleshooting

asynchronous disk /0 A-2
described
Linux 5-1
Mac0S86t09.1 3-1
MacOSX 4-1
Windows 2-1
networking
Linux 5-1
Mac0S86t09.1 3-1
MacOSX 4-1
Windows 2-1
performance A-1
Help. See FileMaker Server Help
Hibernation (Windows 2000) 6-17
Hit percentage, cache 7-8
Host name
maximum length A-1
Setting
Linux 9-11
Windows and Mac OS 6-10
unavailable C-6
Hosting files
See also Administering; Files, Guests;
Remote administration
automatically B-2
described 7-8
errors C-1
maximum number A-1
Linux 9-7
Windows and Mac OS 6-5
runtime solutions
Linux 9-12
Mac 0S8.61t09.1 6-9
Windows and Mac OSX 6-8

sending messages to guests
locally (Mac 0OS8.6t09.1) 7-16
remotely 7-11
troubleshooting C-1
using command line (Windows) 8-8
Hosts dialog box
described 6-10
dimmed icon (Windows and
Mac OS) 6-10
host name
setting (Linux) 9-11
setting (Windows and Mac OS) 6-10
troubleshooting C-6
opening 7-6
HostSingleUserFiles preference parameter
(Linux) 9-8

I, Jd
Idle disconnect time
Linux 9-6
Windows and Mac OS 6-4

Index, using in Help (Windows and
Mac 0S8.6t09.1) ix

Installing FileMaker Server
inLinux 5-1-5-2
inMac 0S86t09.1 3-1-3-2
inMacOSX 4-1-4-2
inWindows 2-2-2-3
recommendations 1-2
remote administration plug-in,
automatically 7-6
remote administration plug-in, manually
Mac OS 10-2
Windows 10-1
troubleshooting C-5
IP address
setting
Linux 9-12

Windows and Mac OS  6-12
specifying for adirectory service
Linux 9-15
Windows and Mac OS 6-15
troubleshooting C-6
IPX/SPX (Windows)
incorrect frametypes C-6
troubleshooting C-5

Italicized text, in local administration window
(Mac 0S8.6t09.1) 7-16

K
Keyboard shortcuts (Mac OS8.6t09.1) 7-14

L

LDAP
See Directory service
Limitsfor filesand usage A-1
Listing information (Mac OS8.6t09.1) 7-14
Listing open files
locally (Linux) 9-2
locally (Mac 0S8.6t09.1) 7-13
remotely 7-7
Local administration (Mac OS 8.6 t0 9.1)
described 7-4, 7-12
hosting files 7-14
viewing databases and guests 7-12
LocalTalk. See Networks
Log files
application log
Windows 2000 6-14
WindowsNT 6-14
event log, described
Linux 9-13
MacOS 7-20
Events.log (Mac OS X)
described 7-18



maximum size 6-15
keeping data current (Windows) 7-20
location of (Linux) 5-3
message descriptions C-1
statistics log
described (Linux) 9-14
described (Windows and Mac OS) 7-8
maximum size (Linux) 9-14
maximum size (Windows and
Mac OS) 6-13
writing to disk (Linux) 9-14
writing to disk (Windows and
Mac OS) 6-13
viewing events (Windows) 7-18
Logging tab (Windows and Mac OS) 6-13

M
MaxEventL ogSize preference parameter
(Linux) 9-13
MaxFiles preference parameter (Linux) 9-7
MaxGuests preference parameter (Linux) 9-6
MaxIdleTime preference parameter
(Linux) 9-6
Maximum number of files
described A-1
setting
Linux 9-7
Windows and Mac OS 6-5
Maximum number of guests
troubleshooting C-6
with AppleShare (Mac 0S8.6t09.1) A-2
MaxStatsL ogSize preference parameter
(Linux) 9-14
Memory
See also Cache; Hardware requirements;
Optimization; Performance; System
requirements
adjusting
Linux 9-7

Mac OS8.6t09.1 6-6
Windows and Mac OS 6-5
minimum
Linux 5-1
Mac 0S8.6t09.1 3-1,6-6
MacOSX 4-1
Windows 2-1
virtual memory (Mac 0S8.6t09.1) 6-7
Messages
FileMaker Server log file C-1
sending to guests
locally (Mac 0S8.6t09.1) 7-16
remotely 7-11
Microsoft Active Directory
Linux 9-14
Windows and Mac OS 6-15

Monitoring FileMaker Server. See
Administering

N

Netscape Directory
Linux 9-14
Windows and Mac OS  6-15
Network card requirements (Linux) 5-1
Network KB/sec statistics, described 7-8
Network operating system (Windows) 2-2
Networking tab (Windowsand Mac OS) 6-11
Networks
See also Optimization; Troubleshooting
choosing protocols
Mac0S8.6t09.1 6-11
Windows 6-11
error messages C-2
initialization failure C-2
mixed networks
Mac0S86t09.1 3-1,6-11
Mac OSX 4-1,6-11
Windows 2-2, 6-11

Index

performance considerations
(Mac 0S) A-2
regquirements
Linux 5-1
Mac 0S86t09.1 3-1
Mac OSX 4-1
Windows 2-1
setting |P address
Linux 9-12
Windows and Mac OS 6-12
sockets, AppleTak A-2
traffic and performance B-2
troubleshooting C-5
New Schedule dialog box
Mac 0OS86t09.1 81
Mac OSX 8-3
NOS (Windows) 2-2
Number of guests
maximum A-1
setting
Linux 9-6
Windows and Mac OS 6-3

@)

Onscreen Help. See FileMaker Server Help

Open command
Linux 9-2
Windows 8-8
Opening files
automatically B-2
locally
Linux 9-2
Mac OS8.6t09.1 7-14
remotely 7-6, 7-8
runtime solutions
Linux 9-12
Mac OS8.6t09.1 6-9
Windows and Mac OS X 6-8
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using command line (Windows) 8-8
OpenLDAP

Linux 9-14

Windows and Mac OS 6-15
Operating system requirements

Linux 5-1

Mac 0S861t09.1 3-1

MacOSX 4-1

Windows 2-1
Optimization B-1, C-1

Seealso Log files; Hardware requirements;

Memory; Networks; Performance

P

Passwords
encrypting for configuration file
(Linux) 9-11
in FileMaker Pro files 6-17
remote administration
maximum length A-1
setting 6-10
Pause command
Linux 9-2
Windows 8-8
Performance
coexistence with other software A-2
hardware A-1
maximize mode (Mac 0S8.6t09.1) 6-11
network (Mac OS) A-2
tips A-1,B-1
Performance Monitor (Windows NT),
using 7-17
Permissions, file (Linux) 9-10
Plug-in, remote administration
automatically downloading 7-6
described 7-5
installing manually
Mac OS 10-2

Windows 10-1
Plug-ins
downloading automatically
Linux 9-8
Windows and Mac OS 6-7
Port number, specifying for adirectory service
Linux 9-15
Windows and Mac OS 6-17

Power Conservation mode
(Windows 2000) 6-17

Preferences. See Configuring
PreflPAddr preference parameter
(Linux) 9-12
Product features, new and improved 1-3
Product registration 1-1
Properties. See Configuring
Protocols, network
Setting
Mac0S8.6t09.1 6-11
Windows 6-11
supported
Linux 5-1
Mac0S86t09.1 31
MacOSX 4-1
Windows 2-1

Q
Q&A for FileMaker Server D-1
Quick reference of commands (Linux) xii
Quitting FileMaker Server
Linux 9-1
Mac0S86t09.1 7-3
MacOSX 7-4
Windows 2000 7-2
WindowsNT 7-2

R

RAM. See Memory
Registering
filename extensions for runtime solutions
Linux 9-12
Windows and Mac OS X 6-8
software license 1-1
Registration utility, description (Linux) 5-2
Related database files, locating B-2
Reload command (Linux) 9-2, 9-5
Remote administration
described 1-1
enabling in FileMaker Server
Linux 9-10
Windows and Mac OS 6-9
encrypting password (Linux) 9-11
getting Help  xii
hosting files 7-9
installing plug-in manually
Mac OS 10-2
Windows 10-1
plug-in files
Linux 5-3
Mac 0OS86t09.1 3-3
Mac OSX 4-2
Windows 2-4
troubleshooting C-7
Remote Administration window
described 7-7
opening 7-6
sorting columns  7-7

Remote administration, downloading plug-in
automatically 7-6

Removing
FileMaker Server
Linux 5-3
Windows 2-5



scheduled tasks (Windows and
Mac OS) 8-7
Replacing data, performance issues B-1

Requirements. See Hardware reguirements;
Memory; Networks; System requirements

RequirePassword preference parameter
(Linux) 9-11
Resizing columns
in Schedules list
Mac OS 8-5
Windows 8-4
locally (Mac 0S8.6t09.1) 7-13
Restart command (Linux) 9-5
Resume command
Linux 9-2
Windows 8-9
Runtime solutions, hosting automatically
Linux 9-12
Mac OS86t09.1 6-9
Windows and Mac OS X 6-8

S

Samplefiles
command line (Windows) 8-9
Linux 5-2
Mac 0S8.6t09.1 3-2,3-3
MacOSX 4-2
Windows 2-4
Schedules
changing (Windows and Mac OS) 8-6
creating
Mac0S86t09.1 81
MacOSX 8-3
Windows 8-1
deleting (Windows and Mac OS) 8-7
described (Windows and Mac OS) 8-1
duplicating (Windows and Mac OS) 8-7

enabling and disabling (Windows and
Mac OS) 8-7
running manually (Windows and
Mac OS) 8-6
viewing (Windows) 8-4
Screen saver software, and FileMaker
Server A-2,B-2
Scripts
autostart and stop (Linux) 9-2
for administrative tasks (Linux) 9-1
running on a schedule
Mac0S86t09.1 82
MacOSX 8-4
using to automate tasks (Mac OS) 8-10
Search path for hosting files (Linux) 9-9
Searching
Help (Windows and Mac OS) x
Techinfo database D-1
Security
authenticating guests (Windows and Mac
0S) 6-4
recommendations (Windows and
Mac OS) 6-10
Selecting information in lists
(Mac 0S8.6109.1) 7-14
Sending messages to guests
See also Administering; Messages
al, remotely 7-12
locally (Mac OS8.6t09.1) 7-16
remotely 7-11
using a schedule (Windows and
Mac OS) 81
Server Administration plug-in
automatically downloading 7-6
described 7-5
enabling manually
MacOS 10-3
Windows 10-2

Index -9

installing manually
Mac OS 10-2
Windows 10-1
Server application, described
(MacOSX) 7-3
Server Event Log (Mac 0S8.61t09.1)
Seealso Log files
described 7-20
maximum size 6-15

Server Last Statistics Log file
(Mac 0S8.6t09.1) 6-13

Server name. See Host name
ServerRoot preference parameter (Linux) 9-9
Services control panel (Windows) 7-1, 7-2
Shutdown

and FileMaker Server

WindowsNT 7-2
checking for file corruption (Windows and
Mac OS) 6-18

Single user files, hosting

Linux 9-8

Windows and Mac OS 6-7
Sleep, by operating system (Windows and

Mac OS) 6-17

Sockets, network. See Connections,
AppleShare; Networks,; Optimization

Software requirements
Linux 5-1
Mac 0OS86t09.1 3-1
Mac OSX 4-1
Windows 2-1
Sorting
columns
localy (Mac 0S8.6t09.1) 7-13
remotely 7-7
performanceissues B-1
scheduled tasks
Mac OS 8-5
Windows 8-4
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usage statistics, remotely 7-8
Specify Hosts button C-6
Standby mode (Windows 2000) 6-17
Start command
Linux 9-1
Windows 8-8
Starting
FileMaker Server, automatically
Linux 5-2,9-2
Mac0S86t09.1 7-3
MacOSX 7-4
troubleshooting C-5
Windows 2000 2-2
Windows NT 2-2, 7-1
FileMaker Server, manually
Linux 9-1
Mac0S86t09.1 7-3
MacOSX 7-4
troubleshooting C-5
using command line (Windows) 8-8
Windows 2000 2-2, 7-1
Windows NT 2-2, 7-1
Statistics
collecting
Linux 9-13
Windows and Mac OS 6-12
viewing
locally (Linux) 9-13
locally (Mac 0S8.6t09.1) 7-14

Performance Monitor
(WindowsNT) 7-17

remotely 7-8

System Monitor (Windows 2000) 7-18

Statisticslog file. See Log files

Statsl ogPath preference parameter
(Linux) 9-14

StatsTimelnterval preference parameter
(Linux) 9-14

Status (Current Date) function 7-21
Stop command (Windows) 8-8
Stopping FileMaker Server

Linux 9-1

Mac OS86t09.1 7-3

Mac OSX 7-4

Windows 2000 7-2

Windows NT 7-2
Summary reports B-1
Support, technical 1-1

System crash, checking for file corruption
(Windows and Mac OS) 6-18

System Monitor (Windows 2000), using 7-18

System requirements

See also Hardware requirements; Memory;
Troubleshooting

Linux 5-1
Mac0S86t09.1 3-1
Mac OSX 4-1
Windows 2-1

T
Task Scheduling assistant (Windows) 8-1
Tasks, scheduling (Windows and Mac OS).
See Schedules
TCP/IP
See also Networks
host address C-6
troubleshooting C-6
Techinfo database D-1
Technical specifications A-1
See also FileMaker Server; Optimization;
Performance
Technical support
contacting 1-1
Techinfo database D-1

Tips. See Optimization; Performance;
Troubleshooting

Today function 7-20
Toolbar (Windows)

described 8-4

displaying descriptions for buttons xi
Transaction statistics, described 7-8
Troubleshooting C-5-C-7

Seealso Log files; Hardware requirements;

Networks; Optimization; Performance

system crash (Windows and
Mac OS) 6-18

U

Uninstalling FileMaker Server
Linux 5-3
Windows 2-5

Unsaved cache percentage 7-8

Unselectableicon, in Hosts dialog box
(Windows and Mac OS) 6-10

Unused cache percentage B-1
Usage statistics
logging
Linux 9-14
Windows and Mac OS 6-12
viewing
locally (Linux) 9-13
localy (Mac 0S8.6t09.1) 7-14
locally (Windows 2000) 7-18
locally (Windows NT) 7-17
remotely 7-8
Usage Statistics window (Mac OS 8.6 to
9.1) 6-12
UseAutoUpdate preference parameter
(Linux) 9-8
UseCacheFlush preference parameter
(Linux) 9-7
UseCustomExtensions preference parameter
(Linux) 9-12
UseCustomServerName preference parameter
(Linux) 9-11



UsePrefl PAddr preference parameter
(Linux) 9-12

UseRemoteAdmin preference parameter
(Linux) 9-10

Users. See Guests

UseStatsl og preference parameter
(Linux) 9-14

\Y

var/fmserverd, description (Linux) 5-2
var/log/fmserver, description (Linux) 5-3
Viewing
details about files and guests,
remotely 7-11
FileMaker Server events
Linux 9-13
Mac OS 7-20
Windows 2000 7-19
WindowsNT 7-19
scheduled tasks
Mac OS 8-5
Windows 8-4
usage statistics
locally (Linux) 9-13
localy (Mac 0S8.6t09.1) 7-14
locally (Windows 2000) 7-18
localy (Windows NT) 7-17
remotely 7-8
Virtual memory. See Memory; Performance

W, X,Y,Z
Web site
for registering software 1-1
Techinfo database D-1
technical support 1-1
Writing guest data to disk
Linux 9-7
Windows and Mac OS 6-7
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